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Preface

Preface

Thank you for purchasing this Topcon product. The materials
available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon
products, and are designed to assist owners with the use of the
receiver and its use is subject to these terms and conditions (the
“Terms and Conditions”).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user
should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local
government protection agency for both private use and commercial
job sites.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your receiver. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by TPS.
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Preface

TRADEMARKS Topcon, Topcon Link, TopSURYV, HiPer, GR-3, and
Topcon Positioning Systems are trademarks or registered trademarks
of TPS. Windows® and ActiveSync® are registered trademarks of
Microsoft Corporation. The Bluetooth® word mark and logos are
owned by Bluetooth SIG, Inc. and any use of such marks by Topcon
Positioning Systems, Inc. is used under license. Other product and
company names mentioned herein may be trademarks of their
respective owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT
BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE
FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL
OR THE RECEIVER. SUCH DISCLAIMED DAMAGES
INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS
OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION
TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR
COSTS INCURRED IN CONNECTION WITH OBTAINING
SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY
OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY
EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY
IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.

LICENSE AGREEMENT Use of any computer programs or software
supplied by TPS or downloaded from a TPS website (the “Software”)
in connection with the receiver constitutes acceptance of these Terms
and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive,
non-transferable license to use such Software under the terms stated
herein and in any case only with a single receiver or single computer.
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Terms and Conditions

You may not assign or transfer the Software or this license without
the express written consent of TPS. This license is effective until
terminated. You may terminate the license at any time by destroying
the Software and Manual. TPS may terminate the license if you fail to
comply with any of the Terms or Conditions. You agree to destroy the
Software and manual upon termination of your use of the receiver. All
ownership, copyright and other intellectual property rights in and to
the Software belong to TPS. If these license terms are not acceptable,
return any unused software and manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential
Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade
secrets. Nothing in this paragraph shall restrict you from disclosing
Confidential Information to your employees as may be necessary or
appropriate to operate or care for the receiver. Such employees must
also keep the Confidentiality Information confidential. In the event you
become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
TPS website (or any other website) or in any other advertisements or
TPS literature or made by an employee or independent contractor of
TPS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability).

SAFETY Improper use of the receiver can lead to injury to persons or
property and/or malfunction of the product. The receiver should only
be repaired by authorized TPS warranty service centers. Users should
review and heed the safety warnings in an Appendix.

MISCELLANEOUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in
accordance with, the laws of the State of California, without reference
to conflict of laws.
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Manual Conventions

This manual uses the following conventions:
Example Description

File » Exit Click the File menu and click Exit.
Connection Indicates the name of a dialog box or screen.

Frequency Indicates a field on a dialog box or screen, or a tab
within a dialog box or screen.
Enter Press or click the button or key labeled Enter.
g Further information to note about the configuration,
NOTE maintenance, or setup of a system.

Supplementary information that can help you
configure, maintain, or set up a system.

on system operation, system performance,
measurements, or personal safety.

Notification that an action has the potential to
adversely affect system operation, system
performance, data integrity, or personal health.

Notification that an action will result in system
damage, loss of data, loss of warranty, or personal
injury.

Under no circumstances should this action be
performed.

-
@ Supplementary information that can have an affect
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Chapter 1

Introduction

Welcome to Topcon Link, a full-featured data import/export and
conversion utility for Topcon instruments. Topcon Link contains
features and functions to perform the following activities:

 Import data files from all Topcon and Sokkia instruments.

* Convert all Topcon and Sokkia data files and many industry-
standard data files to corresponding file formats.

* Open and display data in easy to use tables and screens.
* Provide basic editing tools for some data types.

» Export coordinate files to a Topcon and Sokkia total station, and
export any data file to a Topcon and Sokkia controller.

Topcon Link supports all proprietary Topcon and Sokkia file formats
as well as a number of industry formats. Any format can be converted
to desired Topcon and Sokkia format for export to Topcon and Sokkia
instruments. Many files can be converted between third party and
proprietary formats.

P/N 7010-0522 1-1



Introduction

Installing Topcon Link

Topcon Link software comes either on a CD (as a standalone
application with TopSURYV software), and also available as free
download from the TPS website to install on a computer. The
InstallAware® Wizard will save the earlier versions of Topcon Link
already installed, and will install the latest version in the folder the
user selects.

<

The CD version of Topcon Link contains all projections,
datums and geoids. The version downloaded from the
Topcon web site comes without the projections, datums
and geoids. They will be downloaded from the Internet and
installed on our computer during the installation process.
Make sure that your computer has Internet access during
installation.

Table 1-1 lists the recommended system requirements needed to
install this software on a computer.

Table 1-1. Topcon Link System Requirements for Installation

¢ Microsoft® Windows XP/Vista/7(32 |¢ 512 MB of RAM (1000MB
bit and 64 bit) operating system recommended)

* Processor compatible with Intel® * 100 MB of available hard-disk space
Pentium® 1000 MHz or faster

Before connecting the receiver’s USB port to the computer’s USB
port, the TPS USB driver must be installed on the computer. The
driver is available on the TPS website:
(http://www.topconsupport.com/documents/view/1743).

1. Navigate to the Topcon Link executable file or insert the software
CD-ROM.

* If downloading the software from the TPS website, save the
downloaded compressed file to an accessible location and
extract the Topcon Link executable file.

¢ If downloading the software from a TPS software CD, insert
the CD into the computer’s CD-ROM drive.
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Installing Topcon Link

2. The InstallAware Wizard starts up:

InstallAware Wizard

|
[ | The InstallAware Wizard is verifying the contents
|vopuze | of this setup package. This may take a moment.

(RNRRRRRRRRARE )

3. Click Next to start the installation process.

Check the ‘I accept the terms of the license agreement’ box, to
continue the installation (Figure 1-1). Type User Name and
Company Name information, then click Next (Figure 1-1)

23 Topcon Link v.8 - Installbware Wizard

Licemne Agrrement

Plaass coraiilly read the folloeng konnos agrsament
23 Topcon Link v.8 - Installbware Wizard
Ploase read s soltlmere Merse sgreenert Coredly befire trassng th]  Customer Regitration
Having presond the “Agres” button you are ageeng 8 be Bound by the Plagse srter nformetion on yoursel
by 2o, COp, O Otherwise U Sroduct. I you 80 et spree 1|

Soaree, press the Tieagres” Stton and retur the Tapcon software o ¢
obtaned o Qet ) Loudh mth your

00N Setrbaton. ¥ you downiosded|

From vl sbe, Just delets £ from the computer. Juer Nava
Topoon Emgloy
1. Scltmare Lierss. Al cftwars ard docment st accomparny ot Noa Buhivee
o o y |
Softwars i 16cordad Dok the Tapcon karsors sean tik 5o { Togemn

2pcon Softmare i thes package and any copees that s License ¢
YOU B b are SUBHSCT 10 this Liceres Agresment. Mere 3 bekw und|
Scftware tarvs we mean of axecutive progyaes, docamerteton and & paf

[ ] gooest the terms of the kowrse sy eement

(e )

T e T

Figure 1-1. Review License Agreement and Enter User Information

5. Select a needed setup type. Depending on the user’s selection,
either all program features or only highlighted features will be
installed. If the user selects Typical type and presses Next, the
installation software will do the following:

* automatically select all available datums and projections (except
the following Table Projections:

— rdtrans 2004 and rdtrans for Netherlands
— LB72 for Belgium

— KK/ for Finland

— USTNO?2 for United Kingdom)
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» display the next installation dialog (Figure 1-2)

%3 Topcon Link v. 8 - Installbware Wizard -

Setup Type
Choous the sab.p type that & best for your meede.
23 Topcon Link v. 8 - Installbware Wizard
Destination § oldes
hhooyed X Select Fokder whare ostp will nat el fles. "
) Lywical Toetall Topcon Link v.0 b

Al progran festures vl be rataled, Bt wihoct red Crouan FlesiToptonTopoontrd -
dota W Gaouds o Tatie Proection. Thes set o feat e ke Sherge.
be the same &8 In previoss verson.

O Cugtom

Chocen whwch program foatures you wart retalled,
Recommended for sdvanced users.

Destration Fokder
Requred Ook Jpace: 8,95

<8ah Pt Remaring Duk Space: 0,245M8

[ csos [ mea> | [ coed |

A B
Figure 1-2. Typical Setup Type

If the user selects the Custom type and press Next, the Custom
Setup dialog displays (Figure 1-3).

3 Topcon Link v. 8 - Installiware Wizard

Setup Type
Chooms the sabup type that & best for your seeds.

Custom Setup
Piasse salact & sotip typs. Chooue the program Fasbares you woukd ik to netal

O Typsecad Chck an an icon 0 the bt below to change how & featire i netalled.
Al progran festures vl be rataled, bl Pastrs Desaption
data e Geosds or Tabie Progection. M| Gobal geoxd EGMDD00
be the same 8 In previoss verson.

Chocee which prog am features you warl
Recommended for sdvances users.

- Requred: 4,95 08
T . . ¥ Remarny QM43
[ ctoo J[met> ] [ coent |

Figure 1-3. Custom Setup Type

<

The typical installation does not allow one to install a geoid
on the computer. As against of the typical installation, the
custom installation allows one to install the highlighted
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Installing Topcon Link

geoid for the corresponding projection(s)/datum(s) of the
given region.

The user can highlight only those features (projection or
projection and geoid), which needed for the given job area. Such
regional selection allows one to economize the computer’s disk
size.

This dialog box contains the list of projections:

o e Eweps . | Feature Destription
° With regional geoids o gI Erance IGNED, IGH7E, RAFIE
=M o
or
Feature Description
. . . Projections: GERMANY-Berlin
 without regional geoids e, CERANY,
GERMANY-Gauss Krueger
Germany BKG Geoid Format
or
Festure Description
. . . = g‘ Ehe”::i Praction | Projection: RDTRANS 2004
* with table projection e

The Feature Description displays the list projection(s)/ formats/
geoid(s) which consist the highlighted item. To see what the
feature contains, select the desired feature:

= | F— | Festure Desciption
=-|EIE Projections: GERMANY-Berlin
Soldner, GERMARY,
GERMANY-Gauss Krusger
Germany BKG Geoid Format

| Feature Description
Origial bin geoid *.01

=) 3 » | Denmatk
N (=14 G=cid

If the selected projection contains a list of projection(s) and a
geoid file format, Topcon Link will be installed with the selected
projection(s) and format for adding the corresponding geoid to
the Topcon Link (but not a geoid file). In the given case:

P/N 7010-0522 1-5



Introduction

— the Setup tab of the Coordinate System item of the

Configuration dialog box will display the installed geoid file
format in the list of geoid:

Za Topcon Link v.8 - InstallAware Wizard

Custom Setup
Choose the program features you would like to instal,

Chick on an icon in the kst below to change how & feature & instaled.

Feature Description

.

Frojection CTCAROSIT0E = | Custom
projections for conversion: pan e S

E NETHERLANDS
RD

If the selected projection contains a list of projection(s) and the
geoid, Topcon Link will be installed with the selected
projection(s), format for adding the corresponding geoid and the

corresponding geoid(s) into the user’s computer. In the given
case:

— the Setup tab of the Coordinate System item of the

Configuration dialog box will display the geoid file format in
the list of geoid and installed geoid(s):

= =3~ | Denmark
|

Feature Description
Original bin geoid *.01

K Configuration

splay Setup | Conversion |
oordinate Systems Geoids List
ave

Path Minimum Longit. .. | Maximum Lom
ciiprogram files... 6°00°00,00000E  17°00°00.000
ciiprogram files..,  B°00'00.00000W  6°0C°'00.000
cilprogram files...  75°00100,00000%  10°0C'00.000 ——
B nkgosa criprogram files... 1°00°00,00000E  33°00°00.000

=
ompute Coordinates
5 Computations
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Installing Topcon Link

— the installed projection(s) will be displayed in the list of

Poiecion [LeTenmmonn =] cuom. |
projections for Conversion: - . EIrCUzZDBITUB‘tsimit\aI Local
-

To add/remove the desired regional projection or geoid to/from
the installing, click the desired feature and select the
corresponding command from the pop-up menu:

X Entire feature will be unavailable

The following rules is used for adding projection and geoid:

1. Itis not possible to highlight a geoid without highlighting
of the corresponding projection:

= K vI = QlelobaI
R Geoid or . Qvl GEni

2. Itis possible to highlight only the desired

projection: = g‘%, ecid

<

Without reference to the selected projection type, Topcon
Link installation will install all datums

If the user did not select any geoid file in the process of installation,
after finishing Topcon Link installation process it is possible to add
(using Configuration dialog box) only the following geoids (global
(*.glc), custom regional (*.rgm) and topcon geoid (*.jff and/or *.gff)
files):

Farmat name: ‘ Global Geoid [*.glc] j

T

am)
Topcon Geaid %, gff ;)

It the user selected some regional geoid file in the process of
installation, after finishing Topcon Link installion process it is
possible to add (using Configuration dialog box) only the following

P/N 7010-0522 1-7
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geoids (selected official geoid, global (*.glc), custom regional
(*.rgm) and topcon geoid (*.jff and/or *.gff) files):

Format name: | French RAFS8 Geoid [*mnt) j
ench (*.mnt)

Regional Geoid (*.rgm)
Topcon Geoid {*.gff;*.jfF)

<

Without reference to the selected projection/geoid type,
Topcon Link installation saves geoid(s), which were added
in the previous version to the geoid list

To add the desired geoid(s) or the desired projection(s) after
finishing Topcon Link installion process, the user needs to do the
steps is described in “How to add a feature after installation” on
page 1-10

To continue Topcon Link installation, click Next.

3. Either keep the default installation folder or click Browse to
select a different folder in which to install the Topcon Link. Click
Next to continue (Figure 1-2 on page 1-4, picture B)).

4. 1If desired, type in a new folder in which to add program icons.
For automatically creating Topcon Link shortcut check the
‘Create on Desktop’ box. Then click Next (Figure 1-4).

5. Click Next to start the installation process (Figure 1-4)
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6. Topcon Link is installed on the computer (Figure 1-4)

%32 Topcon Link v. 8 - Installware Wizard

ket Prograea febdes
Selact the location where you would e 2o coeste rew shortods.

tallbware Wizard

a0 wll 334 progy am shertn 24 bo the Progyae Pkder keted bel
2 reewe fekder reame, O B0CER U Suested name. ik Nest 6 Campleting the IrstilAware Wizard for
Topoon Link v

Erogy e Fokder

The lretallAmare Waand i nose raady to corfigure Topcon Lk

Tratall thes apphcation for v 8 o0 the computer

) dpoone whi wses thes computer (o wsars)
) Ondy or e (ourrenk wsar) « Chck Nt 23 begin configuration
Ok Back to change settngs
Ok Carcel to ext

%3 Topcon Link v. 8 - Installbware Wizard

]

Instaling Topcon Link v.8
The progrars features you selected we beng configured.

Flaate vk whils the Iratalmars Wizwd retalls Topcon Lk v.8. This
fegy Lbe severd wwutes.

. [ et [ met> | [ coen
Pin: MRPurser &, Drectory: CAprog a,
Soe! 165688

Figure 1-4. Select Program Folder and Installation Progress

7. Click Finish to exit the installation.

8. Before the user can use Topcon Link, we recommend restarting
your computer.

9. Create a shortcut on the computer’s desktop for easy access
(Figure 1-5).

A piLifik]

TeEEEm Lk

Figure 1-5. Topcon Link Desktop Shortcut

P/N 7010-0522 1-9



Introduction

How to add a feature after
installation

The user can add any features from Custom Setup window after
finishing Topcon Link installion process and restarting Windows. To
do it, make the following steps:

1. Click Settings » Control Panel » Add or Remove Programs

2. Select Topcon Link v.8 in the Add or Remove Programs and click
Change (Figure 1-7):

B Add or Remove Programs

—
E Currently instaliad programs: ] Show upgates Sort by: | Name

Change or

Romove See  6L2#D

Srograne e cr support rformation. Used frequently

Last UsedOn  8/2/2010

&
u® To changa this program or remove it from your computer, chck Changs or Remove.

Figure 1-6. Add and Remove Programs

3. Select Modify Available Options and click Next (Figure 1-8)

3 Topcon Link v. 8 - Installbware Wizard

Wekcome 1o the InstallAware Wizard for
. Topoon Link vt

Plasce chooem & mantenancs operstion b perfore:
) Moddy Avadabie Options
D Repar Applecation
£ ninstat

To contrue, dhk Nt

) Co= )

Figure 1-7. InstallAware Wizard
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4. Highlight the desired features (projection or projection and geoid)
in the Custom Setup window (Figure 1-9)

23 Topcon Link v.8 - Installbwace Wizerd

Custom Setup
Chooee tha program festures you woukd e to retal

Chch o an 1o i the st below to charge how & festire s netalled

= [
« | Gaosd
ﬁ'w\-‘.'l'f
SR 1 ™)
2|
O —

T 3 O trerefesture wil be retalied on ke hard dve

Progectione 3

& X Erevefasise wil be unavslstie
V] Ty
v | thadart

T Reamed | 145,801
¥ Remsning %124 M0

< >

Figure 1-8. Custom Setup Window

Installing Microsoft
ActiveSync for Use With
CE-based Devices

ActiveSync® is free software from Microsoft® that establishes a
connection between a computer (with operation system Windows XP)
and an external device. ActiveSync is used for file transfers and
software downloads between a computer and mobile device running
the Windows® CE operating system, such as a hand-held controller
or CE-based Total Station.

After installing ActiveSync, it will be associated with a port on the
computer. This means that the port will be considered “busy”, and
may need to be freed up for use with other devices.

ActiveSync will start automatically when connecting a CE-based
device (such as, Topcon’s FC-120/FC-200/FC-2000/FC2200/FC2500,
GMS-2/GMS-2Pro, or GTS-720/GTS-750/GPT-7000/GPT-7000i/
GPT-7500/GPT-9000)or Sokkia’s SHC 2500 or SRX/SET X).

1. Log on to the Microsoft website (www.microsoft.com) to
download ActiveSync. Install the program onto the computer.

P/N 7010-0522 1-11



Introduction

2. After installing ActiveSync, start the application and click
File » Connection Settings. Apply the following settings based
on the number of ports on the computer (Table 1-2).

Refer to the help topics in ActiveSync for more

details on connecting with devices.

Table 1-2. About ActiveSync Connection Settings

ActiveSync Settings for Computers
With One Port

ActiveSync Settings for Computers
With Two or More Ports

If using a port for multiple purposes,
select either “Work Network™ or “The
Internet”. In this case, ActiveSync will
free up the port for other uses after
disconnecting a device.

© Conmection Settings R_
Waitng I device to connect
t¥ Corract
W Show ahus oon # lask by
& Adow USB convectons

Adow Conrecion 1o one of he foloserg.

Thet COMODAR 0 COnrectad M

Sedomats; -

W Open AckvaSinc when ny device cormed)

(%

wiork Metwark k

The Internet

If multiple ports are available, the
default settings are sufficient. In this
case, ActiveSync will retain use of the
port after disconnecting a device.

If using a USB cable to connect the
device to the computer, select the option.

@ Conmection Settings m_

Waitng e device o connect
Conrect
V¥ Show wahut woon m lash by
& Adow USB convectiors
W Mlow conrectont 10 one of the foloerg
o -]
Thes Comper & Conrectsd ¥
Cdomtc v

W Open AckvaSnc when ny device connects

e | 3 I

Cancel

If the user's computer operates under Windows Vista,
ActiveSync is not needed. A connection between the
computer and an external device with Windows CE will be
automatically established after connecting your device to

your PC.
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Getting Acquainted

Getting Acquainted

The Topcon Link interface is designed for easy, integrated use with a
PC-compatible computer, a connected Topcon instrument, and
industry-standard data types. The following sections introduce the
various functions available in Topcon Link for transferring, viewing,
configuring/converting, and editing data files.

Main Screen

The main screen has the following components (Figure 1-9):

* Title bar — contains the program name and the name of the
currently active file.

* Menu bar — contains drop-down menus for all functions.
* Toolbar —contains shortcut buttons to frequently used functions.

* Work area — displays dialog boxes, job file information, and pop-
up menus.

* Status bar — displays informative messages about Topcon Link
and various files, as well as pop-up boxes for quickly changing
units and coordinate systems (inactive if no file is open).

:4 Topeon Link

A\

Toolbar Menu Bar Title Bar

Work Area

Status Bar

Ready / UFek | NS | Grond | Norm

Figure 1-9. Topcon Link Main Screen Components
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The menu bar (Figure 1-10) provides access to all available options.

File Edit

Wiew Add Process  Window  Help

Figure 1-10. Topcon Link Menu Bar

Table 1-3 briefly describes the functions in each drop-down menu.

Table 1-3. Topcon Link Menu Options

Menu Functions
File menu opens and saves a file
imports and exports data from a device
Open File... O
e e converts a file from one format to another
Inuport From Device. . Shift+F3 Compatible format®
Export ko Device... Shift+F4
ComertFle... s prints information from an active file
Print... Cr+P
Print Previzn displays configuration parameters
Page Setup..
Configraton... iz displays file properties
o Preparios. displays recently accessed files
1 PROJECT RTK tisy
B closes Topcon Link
Edit menu allows an undo or redo of the last operation
cuts, copies, or deletes selected data
adds a point
cut chrl+x . .
oy ChileC displays the properties for selected data
Delete Del
Properties... Ctrl+Enter
View menu displays or hides the CAD view and/or layers

v Toolbar

v Status Bar

v CAD View  Chrl+K
Layers Chrl+d

Zoom 3
Pan Mode

Options 3

view

displays or hides the Topcon Link toolbar and/
or status bar

sets the pan or zoom mode

sets view options for the tabular and CAD
views

Add menu

Add
Pairk... Ctrk,

adds a point

Process menu

ompute Coordinates F&

Process Properties...  Al+CErHP

computes coordinates
sets processing properties

1-14
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Table 1-3. Topcon Link Menu Options (Continued)

Menu

Functions

Window menu

Clase Chrl+F4

Close All

Cascade

Tile Vertically
Tile: Horizontally
Arrange Irons

1 CAD View
v 2 C:\My DatalPROJECT RTK.tsv <TopSURY PC Job

closes the current window or all open windows

arranges open windows in a cascade (stacked)
or tile (adjacent) order

arranges icons

shows all open windows, and selects a window
to be active

Help menu

Context Help
Feeback »

About Topeon Link...

accesses the Topcon Link context help
accesses customer feedback options for
sending bug reports and questions to TPS
support

access the Topcon GPS website on the Internet
access the Topcon University website on the
Internet

displays version, publisher, and build date
information for Topcon Link

a. Compatible formats - the formats containing the common data

Toolbar

The toolbar for Topcon Link (Figure 1-11) contains buttons for

frequently used functions.

EEHE 5% & 0

$ B o ajla a8 am] B8k

Figure 1-11. Topcon Link Toolbar

Upon startup, the toolbar displays beneath the menu bar. To display or
hide the toolbar, click View » Toolbar.

Table 1-4 describes the various buttons available on the toolbar.

Table 1-4. Topcon Link Toolbar Button Functions

Button

Description

=

3. Click Open.

Open File — Opens an existing file.
1. Click the button to display the Open dialog box.
2. Navigate to and select the desired file.

P/N 7010-0522

1-15




Introduction

Table 1-4. Topcon Link Toolbar Button Functions (Continued)

Button

Description

Save — Saves a file to the current directory.

&

Save As — Saves the current file with a new name and/or in a new
directory and/or to save in other compatible format.

Import File from Device — Imports files from Topcon and Sokkia GPS+

£y
& receivers, Topcon memory cards, Topcon and Sokkia controllers,
Topcon and Sokkia Total Stations (CE-based, robotic, conventional), or
Topcon and Sokkia digital levels
See Chapter 4 for details.
5 Export File to Device — Exports data to a Topcon and Sokkia controller
& or Total Station and Sokkia (CE-based, conventional, robotic).
See Chapter 8 for details.
o Convert files between formats — Converts data in a file from one format
EE to another compatible format.

See “Converting A File” on page 5-2 for details.

Print — Prints the current window or table.

Undo — Reverses the last action.

Redo — Returns the last action.

Cut — Removes the selected object(s).

Copy — Copies the selected object(s).

Add point —Adds a point to the current file.

1. Click the button to display the Add point dialog box.

2. Enter the point name, coordinates, and codes for the new point.
3. Click Ok.

See “Add a Point” on page 6-2 for details.

Zoom In — Changes the pointer to a magnifying wand for zooming in on
a clicked area of the CAD view. You can also click and drag a square
around the area to zoom in on.
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Table 1-4. Topcon Link Toolbar Button Functions (Continued)

Button Description
Zoom Out — Changes the pointer to a magnifying wand for zooming out
A on a clicked area of the CAD view. You can also click and drag a square
around the area to zoom out on.
Zoom back — Returns the CAD view to the previous zoom
& magnification.
Restore All — Fits all data in the active CAD view into the viewable
2 extents of the view.

Pan — Changes the pointer to a “hand” with which to “grab” and
dynamically move the CAD view.

CAD View — Available for TopSURV PC Jobs, displays design data
(points, linework, roads, and surface).

Compute coordinates of points — Calculates the point coordinates in the
current file.

See “Computing Point Coordinates for Raw Data and Field Software
Files” on page 7-1 for more details.

Context Help — Displays a pop-up tip with information about the
selected view, button, field, etc.

1. Click the button. The pointer changes to a question mark.

2. Click the object you want additional information on. A pop-up tip
gives further information.

3. Click outside the pop-up tip to close it.

Status Bar
The status bar (Figure 1-12 on page 1-18) displays:

 various informative messages about current Topcon Link
activities and opened file.

¢ the information boxes provide quick information about the
current linear/angular units and coordinate type/system used in
the file. These boxes also provide drop-down lists for quickly
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converting the linear or angular units used in the file, or the
coordinate type or system used in the file.

Graurn ¥

Dratum Lat, Lon, EILH

USFee »

Linear | Coordinate

WiE554 Lat, Lon, EILH
Daturn Lak, Lon, Elevation

\

Ready USFeet | DMS | Ground | PROJECT RTE.tsv Localization

/

[ PROJECT RTK Hsv Localiz: = |

Africa

Asia

Australia and Mew Zealand
Canada
Europe

Middle East
Coordinate Mane
PROJECT
South Ametica
UPs

Usa
UTMMorth
UTM3auth

Angular

F- - - F-F -

F-[- - [

Figure 1-12. Topcon Link Status Bar

Topcon and Sokkia Device
Directories in Windows Explorer

The Topcon Link installation process also installs device directories
on the computer’s hard drive (Figure 1-13). These directories are used

to easily access data on a connected device for import/export
activities.
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™ My Computer

Fle EM  Vew Fovortes Todk e &
J—
? P Fokomrs 3 o
1' My Computer ~ Go

Polders x Other A
= ¥ #

% Local ek - 4 L

4 S s (D1) Toow on Mobde Device  Toocon GNSS  Sokds GNSS

® ) A E:) Nowory Cordh £ ocervers Pacetvers

4 S Banovitie

2 Ramovabie “‘ Q ‘?} t;‘

A RBaovatie
Topon Dgted Topcon "ots  Schbia Total  Schbia Daprdd

2 Romov
" Levws Satiors Satiore Levek

o e e Y
£ ) ~

Figure 1-13. Topcon Device Folders in Windows Explorer

On computers with Windows XP, the “Mobile
Device” folder displays after installing Microsoft
ActiveSync.

On computer with Windows Vista, the “Windows
CE” folder automatically displays after connecting
a external device with Windows CE.

This device directory displays the contents of the
connected TPS controller or TPS CE-based total
station.

After connecting a device to the computer, open Windows Explorer
and navigate to the My Computer window. Click the device icon/
directory to transfer data files.

Because some devices require special settings or
setups to use this feature, see the appropriate
section in Chapter 2 for more details.
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Sending Feedback and Bug
Reports to Topcon Support

The Feedback option in the Help menu offers a way to provide
feedback and direct connection with the Topcon GPS website (http://
www.topconpositioning.com/) and Topcon University website (http://

S

www.topconuniversity.com/): Context Hele |

About Topeon Link... Cuestion To Support...
Topcon on Wb, ..

Send Bug Report.,., ‘

Topcon University...

These options require Internet access.

To send a bug report:

Click Help » Feedback » Send Bug Report. An email opens
with short descriptions of the current version of Topcon Link and
OS of the computer, and log files for Topcon Link are
automatically attached. Describe activities being performed when
the “bug” occurred and send the e-mail to TPS Support:

| B L U 3 1A_.

| dgend id 4 D a2l We 3! 8 v 5 Joges. X &
| O gdt Y feet Pgme ook  fctiors  Deb

| T e o s rd Dot . 3

fe, | =SMIPZaecont a0kl SO ENIRCIN. L0, SLICCINbah O SRECONBR00C0N.LoN2

Subjear £ s Loy e
Mtach.., | | " Mogsaneloo e 053 kK): B Messaont oo o cee (5148 |__Amacheers Ogters..
Inter y Ot ere

Link v.8 build dace 1s Friday, July 20, 2010

indows XP Professionsal Secrvice Pack 3 (Puild 2600

Figure 1-14. Example E-mail for the Send Bug Report Option

1-20 Topcon Link Reference Manual



Sending Feedback and Bug Reports to Topcon Support

To ask a question:

Click Help » Feedback » Question To Support. Enter any
questions, describing activities in detail, and send the email to

TPS Support:
£2 Question 1o Suppert - Nessage (Plain To
| JALB L BB ke
| send i 8 4 aag.ubofor.z,xmxy.

l&an—mwwmu

( ey =SMIEZaecootechnals, 000,000 DOk Lo
B s
| .

St Question b Sugget

Eater you comsmnt heare

Appinfo: Topcom Limk v.0 build data ta Friday, July 30, 2010
Lazguage: 0x409
OS: NMiczoaoft Vindowa XP Profeasatonal Service Pack 3 (Build 2600)

Figure 1-15. Example E-mail for the Question to Support Option
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Notes:
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Chapter 2

Setting up Topcon Link
for Transferring Data

Topcon Link provides two methods for transferring data between the
computer and a connected device: via the Topcon Link interface or
the installed directories in Windows® Explorer. See “Adding
Devices” on page 2-1for a quick look at what each device requires for
data transfers.

* For Topcon and Sokkia Total Stations and Topcon and Sokkia
Digital Levels, the instrument’ information and connection
parameters must be set up before it’s files can be viewed. The
instrument setup will only need to be done once per computer.

* For Topcon Memory Cards (flash cards used for data storage in a
Topcon receiver), the card must be formatted before data can be
recorded. The card will need to be formatted once.

Adding Devices

Depending on the device, an initial device setup may be required
before a successful data transfer can be completed. The following
table briefly describes the setups required for transferring data
between a computer and a connected device (Table 2-1 on page 2-2).
See the sections below for specific details.
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Setting up Topcon Link for Transferring Data

Table 2-1. Required for Connected Topcon and Sokkia Devices

Topcon GPS Receivers

No further setups are required.

Click the receiver icon to
search connected GNSS
receivers. After detecting the
receivers, select the
corresponding receiver to view
logged raw data files.

o 4 fle Edt Vew Favortes Tods Heb i
T?zpec.:oel?vGel:Jsss ook - T D senn [ roides
> GRIPUSE v B
Foiders X ¥ bha102%p.tos
S Topcon GNSS Recevars A |22 091 09140 2ps
v HPERSCOM]
- B

Sokkia GPS Receiver

No further setups are required.
Click the receiver icon to
search connected GNSS
receivers. After detecting the
receivers, select the
corresponding receiver to view
logged raw data files.

The Sokkia GNSS receiver
node contains three
independent COM ports.
Clicking on a port will display
all logged GNSS raw data
files. The user can
simultaneously import
different raw files from each
COM port to the computer

W GSR2700 ISXaCOM15

e

-— Me Lt Vew Favortes Tooks Mep >
Sokkia GNSS
Receivers ol‘lﬂ i ¥ |y ewch Folders
- GSR2N00 ISUPCOMIS v B

Folders X 40002260 POC ¥ 00X
o W Sobla GNSS Receivers A ﬂ CUOXRIOPOC 0

% e GIRZIO0 FOBCOMIS [ 000RST0POC o

& W GSR2700 1% [#ocoseoopoc Mo

3 % CSAZ00 1D v [#ooAreoc #ox

K3

Topc

on and Sokkia Controllers

Microsoft® ActiveSync needs
to be installed on the computer
with Windows XP. For details,
see “Installing Microsoft
ActiveSync for Use With CE-
based Devices” on page 1-11*.
Click the icon to connect with
Controller. After connecting to
the controller, navigate to the
TopSURV/SSF folder and
select the desired job.

B Fle E® Vew Favorles Tods Heb >
Qs - © - (T sewch [ raen [T
Mobile Device
5 L) \Shor age CardlTPS) Fep Sl ks v B
for Windows XP | " % ;i‘;“
@ ke Doves A Fsneirs
# ) Aopkeston Date wodan
OR # (2 My Doouments Free 5155
3 ) Metwerk
™ # () teofies v
. WindowsCE L 2

forVWindows Vista
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Adding Devices

Table 2-1. Required for Connected Topcon and Sokkia Devices

Topcon and Sokkia Total Stations

Parameters for the total station
must be set up using Windows
Explorer or the Topcon Link
Import from device function.
See “Adding a Topcon Total
Station Device” on page 2-4
for details.

& Topcon Total Stations

Fin  Ed  Vaw Favortes Tooks Hebp
Qs -
§ Topcon Toal Statiors
Foders % -
'4

3 SA

"

B Open

!
T

O sener

M es

% Sokkia Total Stations
Fle Edt Vew Favortes Took Mel

Qe - ¥ Osend

7 Schhia Totel Ratns

Topcon and Sokkia Digital Levels

Parameters for the digital level
must be set up using Windows
Explorer or the Topcon Link
Import from device function.
See “Adding a Topcon Digital
Level Device” on page 2-8 for
details.

™ Topcon Digitsl Leyels
Fle E Vew Forulles Tooh Hep

Qe - T s |
& Teoron Cioal Lewels
-

. s

Creats Dgral Level

fle CXk Vew TFovortes Tools

0““"_/

Help

¥ Oawa 30

Topcon Memory Cards

The receiver’s memory card
must be formatted as a
“Topcon Memory Card”.

After connecting to the
computer’s card reader, the
memory card icon displays as
red or gray.

* Ared icon indicates
compatible formatting.

* A gray icon indicates
formatting is required. See
“Formatting a Topcon
Memory Card” on page 2-
12 for details.

Flo EGt Vew Favotes Toos Heb i
Qe - @ T O sewch [ roiters
pacres: | B G v B
Folders x Y y oA
- C -
# B Topcon Memary Cards ~ = =J
o 2105 wctps en0tps
< > v

Formatte —+
Unformatte —*

=8

=] B Topcon Memo

Topcon Memary Cards
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Adding a Topcon Total Station Device

Before Topcon Link or Windows Explorer can read data on a Topcon
Total Station, the device must be added to the directory.
1. Navigate to the Topcon Total Station directory (Figure 2-1 on
page 2-4).
* From Topcon Link — Click File » Import from Device. In
the left pane, double-click the Topcon Total Station directory.

* From Windows Explorer — Open the My Computer window.
Double-click the Topcon Total Station directory.

The procedure will be the same whether using Topcon Link or

Windows Explorer.
2. Double-click Add New Station (Figure 2-1).

% Topcon Total Stations
Fle Edt Vew Favorkes To

08«& T o > ] /

£ Topcon Total SKatons

2 x =
Folders “

My Computer
:':" Import from Device Q'IE
Look » [797 !oo:aic:’;'yu:; 'E Q-}E]“» Lock {:11 'J - ’E]JD\
] = =14
N2 I
o3 -
- it

<
¥ Open Fllos sk Impont
Close

Figure 2-1. Add a New Topcon Total Station
3. On the General tab, enter and select the following information

(Figure 2-2 on page 2-5):
* Name — enter a unique name for the device

* Notes — enter any necessary notes
* Port — select the COM Port the device typically connects to

¢ Model — enter the model number

Topcon Link Reference Manual
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Adding Devices

4. On the Advanced tab, select the baud rate, parity, data bits, stop
bits, and protocol used for communication with the Total Station
(Figure 2-2). Refer to the Topcon Total Station operator’s manual
for details.

Gormedd | Advarced | |

Nawe e
Gormst  Advarced |
e Endve  E -
e | | & Py i )
Pat oM . ~
it Data bis is -
Madet |GPT 2000 - -
W0p b 1 :
Prodocct [hcx s =]
e
o [  Coecel |

Figure 2-2. Enter Topcon Total Station Device Information

5. Click OK to save device information to the computer.

When connecting to this device, you will select the created device
and then follow the instructions on the Total Station.

™ Topcon Total Stations
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Close ,

Figure 2-3. Created Topcon Total Station
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Adding a Sokkia Total Station Device

Before Topcon Link or Windows Explorer can read data on a Sokkia
Total Station, the device must be added to the directory.

1. Navigate to the Sokkia Total Station directory (Figure 2-1 on
page 2-4).
* From Topcon Link — Click File » Import from Device. In
the left pane, double-click the Sokkia Total Station directory.

* From Windows Explorer — Open the My Computer window.
Double-click the Sokkia Total Station directory.
The procedure will be the same whether using Topcon Link or
Windows Explorer.

2. Double-click Add New Station (Figure 2-1).

™ Sokkia Total Stations

Fle Edt View Favortes T

QM' J ﬂ"./

2 Sckida Total Stations

M x Pt
Folders ﬂ»
htop

My Documment
My Comnided
:;‘ Import from Device

Look, lekin [0 | «|@)| e
L] =1 o

-’ -l

=3 o

| Pt a1t

< >
W Open Fles sher Impont

Close

Figure 2-4. Add a New Sokkia Total Station
3. On the General tab, enter and select the following information
(Figure 2-2 on page 2-5):
* Name — enter a unique name for the device
* Notes — enter any necessary notes
* Port — select the COM Port the device typically connects to
* Model — enter the model number

SRD Format -select the corresponding format for your device
from the SDR 20 and SDR 33 formats:

2-6 Topcon Link Reference Manual



Adding Devices

4. On the Advanced tab, select the baud rate, parity, data bits, stop
bits, and set checksum (Ser or Not Set) and flow control (None or
Xon/Xoff) used for communication with the Sokkia Total Station
(Figure 2-2). Refer to the Sokkia Total Station’s documentation
for details.

spnate Siation &

Gerwed | Advarced | Gormst  Advarced |

Nowe: SETEXRN) Brayye [0 -]
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Noia i
Pty {Neore =l
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Modet T - e [T =

wAfms  [GaT 7 - b

[TI Corcel I | [TI Corcel !

Figure 2-5. Enter Sokkia Total Station Device Information
5. Click OK to save device information to the computer.

When connecting to this device, you will select the created device
and then follow the instructions on the Sokkia Total Station.

% Sokkia Total Stations
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Figure 2-6. Created Sokkia Total Station
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Adding a Topcon Digital Level Device

Before Topcon Link or Windows Explorer can read data on a Digital
Level, the device must be added to the directory. Topcon Link
supports the following Topcon Digital Level types: DL-101C, DL-
502, DL-503. Refer to the digital level operator’s manual for
connecting the computer and device.

1. Navigate to the Topcon Digital Level directory (Figure 2-7).

* From Topcon Link — Click File » Import from Device. In
the left pane, double-click the Topcon Digital Level directory.

* From Windows Explorer — Open the My Computer window.
Double-click the Topcon Digital Level directory.

The procedure will be the same whether using Topcon Link or
Windows Explorer.

2. Double-click Add New Digital Level (Figure 2-7).

& Topcon Digital Levels

Fie Ed Vew Favorkes T

D gack ~ 4
Q- Q- F|)
A B Topoon Dagdl Levels
Folders X *_‘
ptop
My Document | IRaaakicnl

My Compute | I

o Import from Device

Look n [\p Topcon DigtaiLevels v | 4w c3) Lock it [7—7/7'

Add Moww Dl Lavel

¥ Open Fles aber lmpast

Close

Figure 2-7. Add a New Topcon Digital Level

3. On the General tab, enter and select the following information
(Figure 2-2 on page 2-5):

* Name — enter a unique name for the device
* Model - select the desired Digital Level model
* Port — specify the COM Port the device typically connects to
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* Baud rate and Parity — select the baud rate and parity used for
communication with the Digital Level.

Create Digital Level

Topcon DLAOTC
Topeon DL-101C
Topcon DL-A02
Topcon DL-603

Geresd '

MNave

foL
pd
=

Pt ’ Taud e
[cos - £ -
Party

13
{Even -

o] o | |

Figure 2-8. Enter Topcon Digital Level Device Information
Click OK to save the device information to the computer.

When connecting to this device, you will select the created device
and then follow the instructions on the Topcon Digital Level.

Fls ER View FavorRes Tooks  Heg

Qe - (¥ O s

Addrass o Topoon Digtal Levels

Folders %
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Dgial Leved

My Computes

Lock @ Topoon Oigraiteves v | | () 0 | Look i o1 ] «|t
X Add Now Dl Lavel | (=} QN
H2 o=l
a3 -]
- i

<
¥ Open Flos sk lmpont
Close |

Figure 2-9. Created Topcon Digital Level
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Adding a Sokkia Digital Level Device

Before Topcon Link or Windows Explorer can read data on a Digital
Level, the device must be added to the directory.
1. Navigate to the Sokkia Digital Level directory (Figure 2-7).

* From Topcon Link — Click File » Import from Device. In
the left pane, double-click the Sokkia Digital Level directory.
* From Windows Explorer — Open the My Computer window.
Double-click the Sokkia Digital Level directory.
The procedure will be the same whether using Topcon Link or
Windows Explorer.

2. Double-click Add New Digital Level (Figure 2-7).

8% Sokkia Digital Levels

fle Ed Yew Favorites T

¢ . 2
Q Back 4 A 4
B Saidia Digital Levels
¥ x
olders @+
ftop

e
My Commpastee Digtal Level

I Import from Device

|7
.

lekin [ Sk DitaLeves +] 40 &3] ] ki[O -]
P Add New Ol Level e 1 -]
32 (-]

=L -

Q

-l

<

¥ Open Flles ater Ingost

Clote

Figure 2-10. Add a New Sokkia Digital Level

3. On the General tab, enter and select the following information
(Figure 2-2 on page 2-5):
* Name — enter a unique name for the device
* Note - enter any necessary notes
* Port — select the COM Port the device typically connects to
* Model - enter the model number

* SDR Format - select the corresponding data format for your
device from the SDR20 and SDR 33 formats
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4. On the Advanced tab, select the baud rate, parity, data bits, stop
bits, and set checksum (Ser or Not Set) and flow control (None or
Xon/Xoff) used for communication with the Sokkia Total Station

(Figure 2-2). Refer to the Sokkia Digital Level’s documentation
for details.

(e —)
Germed | Advarced | Gorwest  Advarced |
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Figure 2-11. Enter Sokkia Digital Level Device Information
5. Click OK to save the device information to the computer.

When connecting to this device, you will select the created device
and then follow the instructions on the Sokkia Digital Level.

W Solkia Digital Levels
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Figure 2-12. Created Sokkia Digital Level
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Formatting a Topcon Memory Card

Before Topcon receiver can record data to a Topcon Memory Card the
card must be formatted. Formatting a Topcon Memory Card prepares
it for data recording.

* A card removed from a Topcon receiver has already been
formatted. The device icon is red.

* A card from another device will need to be formatted before
being used with a Topcon receiver. The device icon is gray

e

Formatting an SD card will erase all data.

If a Topcon Memory Card is already installed in a Topcon receiver,
the device will have formatted the card. For some devices—such as
the GR-3 and NET-G3—the card can be manually inserted and
removed. While cards typically remain in the receiver once inserted, it
can be removed for accessing via a card reader connected to the
computer. The length of time required to format a card depends on the
size of the card and the device formatting the card. For example,
Topcon Link formats a card in a couple of minutes while the GR-3
can take around half an hour.

1. Navigate to the Memory Card device directory (Figure 2-13 on
page 2-13).
* From Topcon Link — Click File » Import from Device. In
the left pane, double-click the Topcon Memory Card
directory.

* From Windows Explorer — Open the My Computer window.
Double-click the Topcon Memory Card directory.
The procedure is the same whether using Topcon Link or
Windows Explorer.

2. Right-click the gray card icon and click Format to format the
flash card for access by Topcon programs (Figure 2-13 on page 2-
13).
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% Topcon Memory Cards
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Figure 2-13. Format Memory Card

When selecting a formatted memory card device, you will view its
data in the corresponding screen/pane.
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Figure 2-14. Formatted Memory Card Device
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Adding a Geoid

When working with data in Topcon Link, a geoid may be required to
ensure correct elevation of the GPS network points. A geoid
transforms the ellipsoidal heights measured by GPS to heights based
on a physical reference surface. When working with coordinate data,
you may want add a geoid, or you can create a regional geoid

<

Make sure:

- The geoid used to take point measurements is loaded into
Topcon Link before opening a file

- The geoid covers the area where file s points are located

- The geoid used to take point measurements is loaded into
Topcon Link before opening a file.

The orthometric heights will be equal to ellipsoidal heights if a
geoid file is not downloaded to Topcon Link and/or the geoid
does not cover the area where file's points are located and/or if
the geoid used to take point measurements is missing.

1. Click File » Configuration and click Coordinate Systems in the
menu tree.

2. Click Add.

%2 Configuration

Goids G . Add

| Nave Path Mo Longhude | Mrsus Ly
Asd |

15 Compursons

cos

Figure 2-15. Add Geoid
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3. Navigate to the location of the geoid and select the format of the

geoid.
4. Select the desired geoid and click Open.
Zdopen 215 [ 24 opn =
Lock i [ Geva_20m BRI | [ Gicba_2008 ~] «=|&cy
e o | Tike nave [EGME gd
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o (*. )
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Maacan 37 Gaosd (*. gee)
Norweguen Gaod (h* bin)
Regoradl Gaosd (* rgm)
Srvakdy Gaokd (DVEMN® £it)
Swieh Gaoud (Swen® rd)
S 2004 Gaod (* )
Topcon Gecod (* 1* #1)
L5 99,2000 and 2005 Gaokd (* bin)

Figure 2-16. Select Geoid Format and Geoid

<

To add a geoid to Topcon Link, select ONLY corresponding
formats in the Format name field

5. Repeat these steps for any other geoids. The geoids will be listed
in the right pane (Figure 2-17).
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6. Any Geoid from the list will be automatically used when Topcon
Link opens files.

7. Click OK to save the configuration and exit.

About Geoids

A geoid model is used to transform the ellipsoidal heights measured
by GPS (purely geometrical) to heights that are based on a physical
reference surface, such as mean sea level. Over small regions there is
little difference between the two reference surfaces, but for large
projects the differences may be unacceptable. Working with a geoid
model when surveying with GPS will ensure proper point
measurements.

Geoid models for the United States have been developed by the
National Geodetic Survey (NGS). The most recent model is called
Geoid 2003. To keep the file size smaller, the continental United
States is divided into a grid with eight zones; each zone has a geoid.
Use Figure 2-18 to help you determine the geoid file to use for your
project. For Geoid 2003, the files are numbered “g2003u01” to
“g2003u08” to correspond to grids 1 to 8. For other regions, or if you
have questions, contact your local representative or Topcon Support.

1 1 1 1 1 1 1 1 1

Grid #1 Grid #2 1 [eriaus 1 Joria#a
1 1
1

58-40N & 111-130 W 58-40N & 94 -113W 58-40N&77-96 W 58-40N&60-79W

Washington

1

North Dakota \ !
1

I

Montana

z
H
-4
&

50 - | -]

Wisconsin

1

1

ke

Oregon daho South Dakota [® vicrgan _:

lowa
sac ] Ohio Penr}

W.Va.

Wyorming

Nebraska

]

40 - Nevada

tah
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Kansas

Kentucky vilgini

California

North C

Tennesee
Oklahoma

Arfona New Mexico

Texas

30-F=ctaunma
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-}42-24N&111-130 W_ | _42-24 N & 94 -113 W
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Figure 2-18. Geoid Grid Example — Approximate Grid for US
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Using Topcon Link, you can create a Topcon geoid file for a specific
area from a supported geoid model, and then export the file into Field
Software Jobs. See “Geoid File Conversion Parameters” on page 5-20
for file conversion details.

Creating a Regional Geoid Model

If geoid heights (the differences between ellipsoidal and orthometric
heights) for the nodes of a regular grid are known, you can create a
Regional Geoid Model File (*.rgm). After creating the file, use
Topcon Link to convert the regional geoid model file to a Topcon
geoid file (*.gff).

To create a regional geoid model file, do the following steps:

1. Open an ASCII text editor (such as Notepad).

2. Enter geoid heights in the format shown in Table 2-2, where each
row in the table corresponds to a line in the file. See below for a
description of the fields in this format.

Table 2-2. Regional Geoid Model Format

Format Fields Example

LAT, LON, n_row, n_column, |40 30 10, -4 30 00, 3, 5,2 00, 2 00, NE, WGS84;
step_lat, step_lon,
geoid_direction, ellipsoid;

H1 H2 H3 H4 H5 1.1 6.6 11.11 16.16 2.2
H6 H7 H8 HY H10 7.7 1212 1717 3.3 8.8
H11 H12 H13 H14 H15 13.13 18.18 4.4 99 14.14

3. Save the file with an “.rgm” extension.

4. Open Topcon Link and convert the regional geoid model file to a
Topcon geoid file. See “Converting A File” on page 5-2 and
“Geoid File Conversion Parameters” on page 5-20 for details.

The fields in the regional geoid model format
correspond to the following information:

e LAT, LON - latitude (GG MM SS) and longitude (GG MM SS)
of the start point for the Regional Geoid Model

— Latitudes are positive for the Northern Hemisphere.
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— Longitudes are positive for the Eastern Hemisphere.

Enter latitudes and longitudes in this format: dd® mm' zz"

¢ n_row — the number of rows in the file

¢ n_column — the number of columns in the file

grid (Table 2-3)

step_lat — grid step along parallels (MM SS)
step_lon — grid step along meridians (MM SS)

geoid_direction — direction for entering geoid heights along the

Table 2-3. Direction For Entering Geoid Heights

NE

from north to east

EN
from east to north

H3

HE

H9 _|H12 [H15

H11 [H12 |H13 |H14 |H15

H2 HS |H& H11 [H14 HE H7 H8 HY H10
H1 H4 |[H7 H10 |H13 N H1 H2 H3 H4 H5 .
Start E Start E
Paint Paint
ws SW
from west to south from south to west
Start Start
"1" Point "1" Point
H5 H4 H3 H2 H1 H13] H10| H7 H4 H1
H1d H3 | HB HT HE H14] H11| HB HS H2
H18 H14 H13| H1Z H1 H18 H12] HI [ HE| H3
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* ellipsoid — the ellipsoid type that the given regional geoid is based
on

* H1,H2... — geoid height in the node (meter)
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Notes:
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Chapter 3

File Operations and
Data Views

Topcon Link works with individual data formats rather than importing
data into an application-based, project-style file. This feature allows
Topcon Link to provide robust import/export and conversion utilities
for multiple data types, as well as the ability to work with a data type
in its native format. To this end, Topcon Link uses standard file
opening/closing and saving operations. Most files can be opened,
saved, and closed. However, a few formats may need to be converted
before opening and working with the data, or converted to another
format before saving changes.

* See “File Operations” on page 3-2 for details on opening/closing
files, and for details on setting file properties and printing.

* See “Saving the File as Another Format” on page 3-12 for details
on saving proprietary or device-specific formats.

Topcon Link includes a standard configuration for viewing data, such
as distance precisions, applicable coordinate systems, and
computation parameters. To change any of these settings, see
“Applying Configuration Parameters” on

page 3-15.

The Tabular view initially contains default data columns and settings
for viewing and working with data. The CAD view can display
information for data points. These columns and settings can be
shown/hidden or re-arranged.

* See “Setting Tabular View Options” on page 3-19 for details on
setting up data columns for the different tabs.

* See “Setting CAD View Options” on page 3-26 for details on
viewing data information in the CAD view.
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File Operations

Topcon Link uses standard file opening/closing and saving operations
for all file types. A properties feature allows job and company
specific information to be saved with the file. The selected view can
be printed for further study.

Opening a File

Because Topcon Link is a utility program that works with various file
types, it does not have a type of file specifically associated with this
software. Some types of files can be directly opened in Topcon Link.
Table 3-1 lists the file types that Topcon Link can open.

Table 3-1. File Types that can be Opened

File Type Format Extensions
Code Library * las; *.dbf; *.tdd; *.xml
Coordinates *.sdr; *.pt3; *.mgn; *.txt; *.xml; *.cr5; *.csv; *.xyz;

* fcd; *.pnt; *.fc5; *.rwS; *.*

Digital Level Observations | *.sdr;*.dl;*.lev;*.txt

GPS+ Raw Data *.sdr; *.pdc; *.tps; *.jps; *.tpd; *.770; *.27D; *.77G;

*2N; B*.*¥; *1b2; *.mdb; *.m00; *.sbf; *dat

Field Software Jobs *1sj; *.tlsv

Total Station Observations | *.sdr;*.dat; *.raw; *.fc5; *.gts; *.gt6*, gts6; *.gts7;

*.gt7; *F; F.xml

Other file types must be converted first before Topcon Link can read
the data. See Chapter 5 for details.

1.

A

Open Topcon Link and click File » Open File.
Select the file format.

Navigate to and select the file to open.

If needed, select desired Advanced Options
Click Open.
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Figure 3-1. Select Format and File to Open

Creating a Custom Text File Format for a
Coordinate File

To open or save a file of arbitrary coordinate format, you can create
and save a custom format. A custom text format allows you to

customize the data included in the coordinate file. Text formats are
saved as an ASCII format (*.txt, *.csv, etc.).

To create an arbitrary text coordinate file, take the following steps:

1. Click File » Open File.

2. On the Open dialog box, navigate to and select a desired
coordinate file in the File name field.

3. On the Open dialog box, select the Custom text format from the
list of coordinate formats in the Format name field. Click Open.

4. On the Custom format properties dialog window select the
delimiter that separates data in a line and the coordinate system
used to create the data.

<

Do not use the “Space” delimiter if the file contains codes with
attributes.
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5. Select data types for the custom format:

* In the left column, select the data type(s) to include and click
the Move Right button.

* In the right column, use the Move Up/Move Down button to
arrange the data types into the same order used in the opened

file.
Always include “PointNum” in the right column and always have
it as the first data type.If including “FullCodes” in the right
column, always have it as the last data type.

6. Select the rule(s) to use for displaying data:
e Ignore first line — if the first line if informational only.

* FullCodes include Code, String and ControlCode — if these
codes are included as shown in Figure 3-2 on page 3-4.

¢ FullCodes include Code and Attribute — if these codes are
included as shown in Figure 3-2.

If the custom format has mixed FullCodes, select both options.

1
|Includes Code, String, Control | Code String cg:g:' Code
. — i
CT.663.873.241.411.1 80.604]20& a]np@corncr.3()&@..l
FullCodes
|Includes' Code and | Code Attribute

[ LI 1
]’I.660,343.25?.340.]80.903.|Basc station: Hiper H_Vert_1_58.TEXT="".

FullCodes

Figure 3-2. Examples of File Formats with FullCodes

7. Enter a name for the format and an extension type.

8. Click OK to store the format in the Formats folder (installed with
Topcon Link) and include it in the format name list. This format
is added to the list of coordinate formats for Open, Save As and
Convert File dialog boxes.
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Figure 3-3. Create Custom Text Coordinate Format (new picture with Code

Description)

Topcon Link applies the default file name, UnName*.*, if no file
name accompanies the new coordinate file format. In this case,
Topcon Link deletes the created file format when closed.

As arule any coordinate file format (and Custom file format too) does
not contain information about the coordinate system and linear units.
These files contain ONLY the values of coordinates. To open the
point coordinates in the corresponding coordinate system, the user
has to:

* know the coordinate system / projection, and linear unit,

* select this coordinate system / projection and corresponding
linear unit as current before importing using Advanced Option in
the Open dialog window:
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Figure 3-4. Using Advanced Option for Coordinates File

The coordinate custom text format allows one to insert different types
of coordinates (Latitude/Longitude/Height or/and Norhing/Easting/
Ortho Height or/and XYZ) into this format (see Figure 3-3 on page 3-
5). If the user selects several coordinate types for the created format,
the coordinate file will have the following form:
Base54.532100302,38.472078683,127.472,6085019.206,486466.725, 127 472,137.286
Name Latutude Longitude Height Northing Easting  OrroHe g

To correctly open this file in Topcon Link, the user has to select the
desired coordinate type and corresponding projection/datum.

If the user (before importing) selects the given Grid coordinate
system, the Points tab will display the Grid coordinates. But if the
user selects the given datum, the Points tab will display the Latitude/
Longitude/Height coordinates (Figure 3-5 on page 3-7).
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For Grid Coordinate System

M D:\Coor dinate Files\Coord_BLH_ENH <Datum_Grid - Coordinates> [= |[E1](X]

[ Grid Northing (m) | Grid Easting (m) Elevation (m) | Code | Note

6085019.206 486466.725 127.472

File name: |Coord_BELH_ENH

Format name: | e

~ Advanced options

Metic unit [Meters |
Coordinate type | Grid ~|
Pigjection: Zone_7 : 36E to 42E ~|  Custom.

Diatum: [ =l
Foint type: |Design |

For Datum Coordinate System

M D:\Coor dinate Files\Coord_BLH_ENH <Datum_Grid - Coordinates> [= |[B][%]

o

«° Points |

Icon | Name | Latitude | Longtude | EllHeight (m) [ Code | note
$ Base 54.532100302N 38.472078683E 137.286

< File name: [Coord_BLH_ERH

Fomat name: [ Datum_Gid - Coordinates (4] -

- Advanced options

Metic unit [Meters |
Coordinate type: Lt Lon, EILH -
Datum: SKk4z ElE
Foint type: |Design |

Figure 3-5. Examples of Opening Custom Text file with sets of coordinate system

Using the coordinate custom text format the customer can save the
Geoid Separation and Combined Scale Factor for the opened Field
Software Job. To do this, take the following steps:

1. Add the Geoid used in the Field Software Job to Topcon Link
2. Open the corresponding Field Software Job
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3. Click File » Save As, select Custom Text Format and click Save

- S;(!-IM ~TepSURY P Job»

o ponts | aPsompmons | 62 Fscts | & Cooes | )

L] have | Gourdnorthe... | Grordtatrg | Gevston (m) | Code [ Cortrad
e - 5
o 10 ave at rd
e ~| | &y
o 108 “ao —]—L-'
o 104 syen]l| B Coord_tay

® 18 || 3 coord st et

o 1% 4510

® 1 4553

© 1m amn

o 1n 5™

e 10 x| Fie rawe: [Geent_Sen_Seae_Facnd

o i 43641 fFomat nave | Custom Tt Foemat - Coosdnates [* ) _'_]
L M M|

° 13 i

® 1 5957 Sewe I Corwnd

A D

3 >

4. Select the Geoid Separation and Combined Scale Factor in the
Custom Format Properties window. After clicking OK Topcon
Link creates a text file that contains the corresponding values of
these parameters (Figure 3-6).

2 Base2,9.815,1.000019302671
e S Il Name  Geoid  Combingd Scale Factor
Eergﬁ'de > } Eoex::ned Sca‘Ie Factor | Move Up | Sepafatlon

Figure 3-6. Examples of creating a text file with Geoid Separation and Combined

Scale Factor

Topcon Link creates a file with Geoid Separation and Combined
Scale Factor, but does not display them in the opened file. To view
and edit these parameters use any text editor.
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About Opening TS Raw Data Files

While a TS raw data file does not record information about the
vertical angle mode (Figure 3-7 on page 3-9), you can select the mode
under Advanced options when opening the file in Topcon Link.

* Zenith — vertical angles are from zenith
» Horizontal Level — vertical angles are from horizontal level

* Auto — no information available on the vertical angle mode. In
this case, angles from 0 to 45° are considered “horizontal” and
angles more than 45° are considered “zenith.”

oo

If vertical angles measured in a TS raw data file exceed 45°,
select the same mode used for these measurements when
opening the file. If a different mode or “Auto” is selected, the
TS Obs tab will display measurements in the wrong column:
-the Vertical Angle column will display values read from zenith
- the Zenith Angle column will display values read from

horizontal level
s prom
190’ B 0

7 r— Vertcal

270° 180

Figure 3-7. Vertical Angle from Horizontal Level (A) and Zenith (B)
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Creating a Custom Text File Format
for TS Observation file

To open or save a file of arbitrary TS observation format, you can
create and save a custom format. A custom text format allows you to
customize the data included in the TS observation file. Text formats
are saved as an ASCII format (*.txt, *.csv, etc.).

To create an arbitrary text TS observation file, take the following
steps:

1.
2.

Click File » Open File.

On the Open dialog box, navigate to and select a desired TS
observation file in the File name field.

On the Open dialog box, select the Custom text format from the
list of TS observation formats in the Format name field. Click
Open.

On the Custom format properties dialog window select the
delimiter that separates data in a line

On the Custom format properties dialog window select data types
for the custom format:

In the left column, select the data type(s) to include and click the
Move Right button.

In the right column, use the Move Up/Move Down button to
arrange the data types into the same order used in the opened file.

Enter a name for the format and an extension type.

Click OK to store the format in the Formats folder (installed with
Topcon Link) and include it in the format name list. This format
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are added (will be added) to the list of TS observation formats for
Open, Save As and Convert File dialog boxes.

Q@ O

Poet Foom
Iabumert Heht

Mave Up

Move Down

[ AT™

F o naee Contom Tt Fomme Otw [
Foenat name MY TS 08% TEXT <4+

Figure 3-8. Create Custom Text TS Obs Format

Saving a File

Topcon Link opens and imports many files types, but only saves
certain file types in a native Topcon format.

When saving a file that has been edited, Topcon Link automatically
saves the original version of the file as “*.*.initial” in the current
folder. Then the edited file is saved.

Use one of the following methods to save a file:
* Click the Save button on the Toolbar.
* Click File » Save File.
* Press Ctrl+S on the keyboard.

An error message displays if the format is not supported for a save
operation.
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Saving the File as Another Format

Topcon Link allows one to save the current file with a new name and/
or in a new directory and/or to save in other format. Saving a file in
another format uses the same process as a file conversion. Topcon
Link allows the user to save files only to compatible formats (the
formats with the common data).

For details on converting files, see Chapter 5.

\,

Use the Save As function to keep versions of the same file to show
progress. Simply add the date or other indicator to the file name.

With the desired file open and active, click File b Save As.
Navigate to the location in which to save the file.

Type in a name for the file.

Ll e

Select the format to save to.

<

Topcon Link will display only compatible formats in the File
format field of the Save As dialog box.

5. If selecting a different format from the current format, select
applicable Advanced Options.

For details on the advanced options, see the applicable section in
“Converting A File” on page 5-2.
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6. Click Save.

= All files (*.*)
+] CodefLayer Library (*.dbf ;*,xml)
+ Cootd L5k, .man;
Saver D et +] Design (*,xml;™*, dwg;* . df;*. %)
Biorw 5 . +] Field Software Jobs (*.tsj;* tsv)
] J CDONEs Cev o W ot O
2;1; datal cxv ' + 615 (*.she)
¥ vt ...‘A o Topcan XML (*,xml)
1‘. '7: " + TS Obs (*,sht;* sdr;* mos;* . raw;* dat;* . ghs;* ghse; *.gte; * . ghe
1 Coors L3V
Fle roee [Port_Faom IS
=l
Foamad raew Nawe M E 2 Code - Coondntes " ol I -
* Advarced
1
Sove | Cancel

Figure 3-9. Save File As...

Closing a File

To close a file without closing Topcon Link, click the system close
button on the Tabular View.

Close File using
System Button on 1

M D:\GR3 SPC2.tlsv <TopSURV PC Job> 9 (=13
+° Points

@2 6PsOcoupations | g s 0bs | & Codes |

m) | Elevation (m) | Code [Cotra A
@ 241454 Nooe
@ 1 48528.871 558536.139 241541 NAL Neoe
e 12 43495,337 558504.973 240.897 OAK Nooe
@ 103 43471,950 555478.170 240765 NAIL Nooe
@ 104 43449596 555462.055 241,202 NAL Neoe
@ 105 48477.858 558456.,783 241,856 NAL tcoe

Figure 3-10. Close File

While several files can be open at the same time, it may take longer
for Topcon Link to read or compute data if the files have a lot of data.
Closing a file before opening another may speed up computations.
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Viewing and Entering File Properties

The Properties dialog box is used for viewing and entering file-
specific information. This dialog box also includes the location of the
file, file type, and date the file was last saved.

1. Click File » File Properties.

2. View the path and format of the file.

3. For some file types, you can type in a name for the job, the name
of the surveyor or company, and any associated notes.

4. Click OK to save and exit.

Field Software Job File

B Properties : Field Software Jobn D, EE!

Fia Naew |6 Fioad Long Sec ity
. . Foma [TooSURV 7 30
Digital Level File Do T BT LT "]

B Properties : DL Obs C:\topcon\Top... @@ b Aoed Lorg Sec}

General ‘
Fie Name |C:\opcon\TopconLink\DigkaL evel\37w

Surveyor Mot U Putac

{Foe Demorum ston

Format |Topeon DL Obs

ok [y Cancel ] | o I Carcel Asch

Figure 3-11. File Properties — Examples

Printing the Selected View

The Tabular and CAD views in Topcon Link can be printed for
viewing offline.

&

Some views print best with a landscape orientation.

Use the File » Page Setup option to apply page and margin
settings.

Use the File » Print Preview option to view the potential result of

the selected view.

To print the Tabular view, select the tab and click File » Print.
To print the CAD view, select the CAD view and click File » Print.
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Applying Configuration
Parameters

Configuration parameters apply basic settings for such items as how
to display angles and the decimal for digits, the coordinate systems
available and adding a geoid, and the settings to use for adjustments.
These parameters will be saved with Topcon Link and used when
opening a file. The default configuration is usually appropriate for
most operations.

1.
2.

Open Topcon Link and click File » Configuration.

In the Display pane, select the following parameters for
displaying information (Figure 3-12 on page 3-16). Click Ok to
save and exit.

In the Precisions tab, select the number of digits to display after
the decimal for measurements.

In the Time tab, select the GPS time zone offset and automatic
fixing clock for daylight saving changes

In the Roads tab, select the term to use for displaying information
on the centerline; either Chainage or Station.

In the Angles tab, select the form for displaying angles and
latitudes/ longitudes.
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GPS Time Zone Offset Time : Dublin, Edinburg
™ Daylight Saving Tims LG

Display CL Pos = [Chainage | |

Station

Precisions | Tme | Reads Angles |

ngles [ dmm'ss.s"

Lo |

Lat Lon [ defrmmss. s

Procalens | Tre
Dits sher docensd
Cvitywces
Cocedrates NE.XY2)
Hages

Angles jrecond|
Arghes f3ec. dagwes]

Latlon frecond) 5
Lathon ke degees| ||
Asea 2
T e (saconds} [

bosts

===

| o Corcel |

Figure 3-12. Select Display Parameters

3. The Coordinate System item displays the Setup and Conversion
tabs in the right pane. In the Sefup pane the user can view, add, or
remove available geoid file (Figure 3-13). Click Ok to save and

exit.
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12 Configuration

T E Dsplay Sotup | Corverson |
Geosh Ler

.| Name | Path | Mrerem Longt... | Masawum L

1= Compute Coordn ® oo ookt 3R0PO000.000 $I00000. Add I
T5 Compratons

OF ‘

Figure 3-13. Select Geoid
To add a new Geoid to the list, see “Adding a Geoid” on page 2-14.

The Conversion tab allows one to select the way of transformation
between NAD27 and NAD 83 datums. The user can apply:

parameters of the NAD27 from Topcon Link database

or

the Federal standard for NAD 27 to NAD 83 datum
transformations — NADCON program

2 Configuration

3] Display

= Setup  Conversion I
3] Coordinate Systems

Convert to/fiom NAD27 using [NAD27 Datum jl

NADCON
(5] Compute Coordinates

Figure 3-14. Job Configuration, Coordinate systems — Conversion Tab

4. In the Save pane, select the interval in minutes for saving a
backup copy of the current file (Figure 3-15). Click Ok to save
and exit. Topcon Link uses the following rules for saving/deleting
backup copies:

* The file will be saved at the selected interval.

* If the file has been edited, a backup copy is automatically
saved.
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 After saving the file (either click Ctrl+S, click on the Save
button, or click File » Save/Save As), the backup copy is
deleted. A new backup copy is saved when at the end of the
next time interval.

* Type “0” into the field to turn off the backup save feature.

e If Topcon Link (or the system) shuts down unintentionally,
the backup copy of the current files opens and is marked
“reserved”.

2 Configuration

Bachip Irderval vl [\g 1

Caccel

Figure 3-15. Select File Backup Properties

5. Inthe Process Compute Coordinates pane (Figure 3-16), type in
distance and angle measurement errors to take them into account
when computing the coordinates of station using directions
observed from the station to points of known positions (resection
method). Click OK to save and exit.

6. In the Process TS Computations pane, select the refraction
coefficient to be applied to total station observations during
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calculation of the coordinate (Figure 3-16). Click Ok to save and
exit.

22 Configuration

Figure 3-16. Set Processing Properties

Setting Tabular View Options

Topcon Link displays data in two views, a tab view and a CAD view.
The Tabular view groups data based on type and displays the
information in a series of tables on different tabs (Figure 3-17).

DGR SPC 2 thy < TapSURY PC Job»

o pomts | P Frocoowons |2 @5cts | B codes |

(£ pvave | ot Werthu () | Groned Eastrg )| Sevwon (m) | Code | Contnd | Layer | Coker | oet Synted |
LR SOS0N T2 TRATLIEA 241454 Veore PO0CCID)  OMATER M DMAYER e |
o 10 A8 ET1 L RE ] 21541 WA here g ) SCOcE BN ECote o |
o e oA 0T TRI0A 97 MOMT O Norw orcoce N oYCOCE
® 103 46471, 950 SSTEAN MOT5 N Nore HCOCE N 6YCXE o ‘
o 104 40445 D T2 L2 WAL Nore orcoce I oYCoce -
o 108 4647 B 50456 T3 ML KA e BCO0E I BYCO0E o ‘
o 106 10,467 DN AT M0 KA Ko orcoce NN oYCoce . [
e 17 46532 973 S59410.945 2235 M hore SCO0E I BYCO0E o
o 1w om0 TR 0 M M Yore ovcoce BN oYCoce e
® 1% 46579.004 550401 220 241966 WAL hare BCO0C I BYCOCE o
o 1o e 04 IO MLTZ ML e srcoce N oYCXE
o m ABALIH 511 459 M163% WAL Nore BCO0E I BYCOCE o
L IRTH 0479 704 ] M7 WL e grcoce(t)  gvcoce MEEEN  BYCoce .
CRTE] 0RT.CT S04 51 135 WA hore PYCOOEI0)  VCOCE I YCOCE .

|® e AONST. 377 s 77 M2 N Nere pYcoce)  avooce BN YCOCE .

| ™ B2 0460557 S04 447 M2 Yore 0 AR B AR e

|

J

Figure 3-17. Tabular View

The tabs that display depend on the type of data in the current file.
Data columns for each tab can be shown/hidden and re-arranged
based on available data and the user’s preference.
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Displaying Table Columns
1. To edit the order and visibility of a tab’s column, click View »
Options » Tabular View.

2. For most of the tabs, select the desired field and use the following
buttons to set up the data columns. Figure 3-18 on page 3-21 uses
the Lines Tab options as an example.

* Moveright ( » |)toinclude the field in the table and
move left (<« |) remove the field from the table.

* Moveup ( weete |) and move down ( we=zen |) to arrange the
order of the selected field.

For the Road Graphic Views and Images tab options, select the
desired fields to display on a graphic tab. See page 3-23 and
page 3-24 for examples.

3. Click OK to save and apply the settings.
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oges | Moot s Posd Bewerts | Vertedl Fosd Beverts }
fosd XSectins | Foad Graphe Views. | XoSection Tewgistes
Ports  Umms | S Ocopetirs | @SOts | 1SCts | tucts | Tapects | . R
Include Field in Tab
Show cohmrn ghe . M
RrshpEE Arrange Field in Tab
X Powt
Detarce bom et
Detarce hom peev
Ery azmush
Ext o
«
0o Blowerts
Ports  Liems | @5 Ocapaters | @S ots | TScbs | o0 Tage Cbs
Show cokmra bt I | | | 5 | Tape
Avalable oo  clected cokare Show cokan st
;;; Avadable cchamns $uinciod cokmes
» Ly Yoon
Lire Coke = Osder
Lre She
L::':lo Detarce bom dat
Laws Con Detarce hom peev
Leea Pl e &_‘ it
£8 Tnigamncy
<@ I Port Type
Powt Cokox
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Avadable cohrme S elected cokamre

Save Changes

ey o | Carcel

Figure 3-18. Lines Tab Options — Editing Data Columns
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Table 3-2 shows an example of, and the default settings for, each of
the Tabular View options tabs. See Figure 3-18 on page 3-21 for an

example of the Lines options tab.

Table 3-2. Tabular View Options Tabs

Points tab Options

-

GPS Occupations tab Options

-] -

-] -

GPS Observations tab Options

TS Observations tab Options

- Ty " L— - O et S U—"
o m T Sl 0w —— B e ) mTave Swnl o e — 1T e
e | e | toneeew S 0Me | mone | om | e om et | e | woneeen | e TR0 o | e om
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S Ty [ ety | Vemv.s an e . v o iy 3
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Sodurve Meen Sl e Sawee
P P [ e o
" et Cove Ree bt |
< o D | oot A | D
” | Ceym Conbes —_— | —————
— | ) - - -l
e g. - S ——
el
e (- -
[ ‘
.
e o Ly l
e ——t E
r-‘r.+
s v (o |
i Ly | |
e
| b |
| !
)
| - | -

3-22

Topcon Link Reference Manual



Table 3-2. Tabular View Options Tabs (Continued)

Setting Tabular View Options

Digital Level Observations tab Options

Tape Observations tab Options
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Table 3-2. Tabular View Options Tabs (Continued)

X-Section Templates tab Options

Images tab Options
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Arranging Table Columns

The columns in the Tabular views can be sorted and arranged
(Table 3-3) to best display the file’s data. The arrangement is used the

next time you open a file.

To reset the table’s columns to default settings, right-click the

column’s header and click Reset Columns

Jurins

Sart by selection

Table 3-3. Arranging Table Columns

Column Arranging Options

Examples

Sort columns
Data in a column can be sorted in

Decreasing Order

Increasing Order

to the desired location.

After —

Ground Karthing (USF) | [ Ground Easting (USFt) |
decreasing/increasing order. 4335.759 12654.110
4858.723 10745.594
4858.723 10694.174
Click the column’s header, or right- 923.512 10693274
. . 4999956 10685742
click and click Sort. 000,024 10597.129
5000.024 10594,929
Swap columns Before
+° points |17 Lines | g G5 Occupations | o Gesobs |, Tsobs
Columns can be moved from one L] Hame | Ground Northing (LSFt) | Ground Easting (USF) |
location to another in the table. & a1z 607,03 1050752
& 29411A 5691.762 10zsz.462
$ 29411 5691763 10282466
& 269424 5111.627 10323.941
Click the column’s header and drag it | During
»" Points I Lines | g% ps Occupations | o GPsobs | < Tsobs

& 20412

&4 29411

& 204118

& zeg4zn

L. nisme Ground Morthing {55} Eastingtéiie Easting (USFE)

10253.732
10262 462
10262 466
10323,941

5697.936
5691,762
5691,763
5111627

Points

|1 Lines | 68 @Ps occupations | gf? Grsobs | ¢, T 0bs

| Mame |

Ground Easting (LSft) | Ground Northing (USFE) |

& 20412
& zmn
4 29411
& ze94zn

5697.536
5691.762
5591,763
5111,627

10259.732
10282.462
10282.466
10323.941
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Table 3-3. Arranging Table Columns

Column Arranging Options Examples
Size columns . Ports B, DL Obs |
Columns can be sized to display/hide Icon | # _l_l_mm [to [1*
data. Before HO1 B0l 5

Click the column’s right edge and
drag left to decrease, right to increase % Ponts H, DL Obs ]
the width of the column.

Icon | #‘+|_Fr0m | To | LevelRun | *

After M, 1 B0l 5 TOPCON

Setting CAD View Options

Topcon Link displays data in two views: a tab view and a computer
aided drawing view. The CAD view is a two-dimensional, graphical
representation of linework road and surface data, with associated
points. To view the CAD graphic, click View » CAD View.
Depending on the file’s data and the filters used, the following
information displays:

* Points with associated symbols. If the point does not have a
symbol, the dot symbol ( « ) is used.

* Lines using the associated code/layer color, style, and width.

* Control codes (/AS, /AE, /C) display as an arc or closed polyline,
respectively.

* Codes with a polygon entity display as closed and filled (if a fill
color has been set).
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* Surfaces and road display in the color applied to the
corresponding layer(s)

I |

In 1 inch - 0.041 mile:

Pz m (P4

o 0.041
—

J ﬁi
5250

5000 — e

.

4750 5000 5250 5500

Figure 3-19. CAD View

View options for CAD View include displaying a coordinate grid,
applying a background map, and selecting labels to display for points.

1. Right-click on an empty portion of the CAD View and click
Options on the pop-up menu. The Options dialog box displays
2. On the Windows tab, check mark the desired settings (Figure 3-20
on page 3-28). Click Apply to apply the changes, then click OK
to save the settings and make further changes.
* Show grid — makes a coordinate grid visible on the CAD
View
* Background color - allows one to set the background color
for the CAD View.

* Show scale bar - displays the bar with the current scale value
for the CAD View

3. On the Labels tab, enable the desired settings (Figure 3-20 on
page 3-28). Click Apply to apply the changes, then click OK to
save the settings and make further changes.

* Name — enable to display the point’s name on selected map,
cursor, and status bar positions

* Code — enable to display the point’s code on selected map,
cursor, and status bar positions
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* Height — enable to display the point’s height on selected map,
cursor, and status bar positions.

window  Labels | Selection
v Show scake ba Powety
SHwon e window | Labels  Selection
¥ Neve ¥ Show dstance
~ Code ¥ Show sz
Hegt Show devenzore
Show on OB  Show wes e
¥ Nws
¥ Code
Haght
Shaw on st b
v Nave

- - T ¥ Code
o I Carced ¥ Heght
o I Carcel Asc]

o I Carcel Azl

Figure 3-20. CAD View Options

4. On the Selection tab enable the desired settings (Figure 3-20).
Click Apply to apply the changes, then click OK to save the
settings and make further changes.

» Show distance — enable to display a distance between corners
of the rectangle in the Status Bar, when the user drags the
rectangle on the CAD View:

* Show azimuth — enable to display an azimuth (from the start
point to the end point of the rectangle) in the Status Bar, when
the user drags the rectangle on the CAD View (Figure 3-21).

Figure 3-21. Show Distance and Azimuth

* Show dimension — enable to display a dimension (length and
height) of the rectangle in the Status Bar, when the user drags
the rectangle on the CAD View.
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» Show area size — enable to display an area of the rectangle in
the Status Bar, when the user drags the rectangle on the CAD
View (Figure 3-22)

Denanions: 246,135 o x 196205 w Area: 40012 59

Figure 3-22. Show Area and Dimension

5. Click OK to save the settings and close the dialog box.

P/N 7010-0522 3-29



File Operations and Data Views

Notes:
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Chapter 4

Importing Data Files
From a Topcon Device

Topcon Link provides a simple interface for importing data files
directly from a Topcon device (instrument). The imported file is saved
to the selected directory, and is immediately available for opening and
viewing in Topcon Link.

A unique feature of the software includes the ability to import data
from a connected device to the computer using Windows® Explorer,
without having to open Topcon Link. Then use Topcon Link to open
the files for viewing, editing, converting, or uploading.

Before importing data from some devices, the device must first be
set up. See “Adding Devices” on page 2-1 for details

This chapter first discusses the steps to view device properties, or file
properties on a device’s memory card. The remaining sections in this
chapter detail the steps required to import data files from a connected
device or an inserted memory card.

* See “Importing Files from a Topcon GNSS Receiver” on page 4-
2.

* See “Importing Files from a Sokkia GNSS Receiver” on page 4-6
» See “Importing Files from a Mobile Device” on page 4-8.
* See “Importing Files from Total Station” on page 4-10.

* See “Importing Files from a Digital Level” on page 4-13.
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Importing Data Files From a Topcon Device

* See “Importing Files from a Memory Card” on page 4-15.

* See “Using Windows Explorer to Import Files from a Device” on
page 4-17.

Importing Files from a Topcon
GNSS Receiver

GPS receivers of Topcon family have an internal data storage device
to record data in *.tps format. This family of products includes the
following receivers.

Odyssey-E, Odyssey-RS, NET-G3, HiPer+, HiPer Pro
NET-G3A,HiPer, HiPer GD, HiPer L1,  HiPer Lite, HiPer Lite+
HiPer GGD, HiPer XT, HiPer XR GR-3

Map-HP, Map-RT

Refer to the receiver operator’s manual for details on setup, operation,
and connection with other devices.

When importing files from a Topcon GPS receiver, Topcon Link
automatically detects the receiver for importing data, and no further
setups are required.

Before connecting the receiver’s USB port to the computer’s USB
port, the Topcon USB driver must be installed on the computer. The
driver is available on the Topcon website: (http://
www.topconsupport.com/documents/view/1743)

g

This section describes data import using the Topcon Link
interface. To import data using Windows® Explorer, see “Using
Windows Explorer to Import Files from a Device” on page 4-17

1. Connect your receiver and computer according to the receiver
operator’s manual.
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Importing Files from a Topcon GNSS Receiver

2=
NOTE
-

Bluetooth® connection requires both devices to have Bluetooth
wireless technology capabilities.

With Topcon Link open, click File » Import from Device.

3. In the left panel, double-click Topcon GNSS Receivers. Topcon
Link will search for connected devices.

Click Stop to quit the search and to display detected devices.

::.i Import from Device 3
PR e ——T L ~ T {

Leck i | My Compures | el Leck in EX =]+
8 Yoocon Totd Rabsorn 3 Schiie Torel Statiors a1 s
B9 Topcon Memory Cards e sokbdy GIESS Racaivers = |2 -
199 Sl il Lovels — s S
W Topcon Digeal Levels G Mobde Device i | = 22
T 5y

¥ Open Files #ter lergort
Close

Figure 4-1. Selection Topcon GNSS Receiver

4. Double-click the desired receiver Topcon Receivers to access the
receiver’s data storage module and view the collected raw files.

5. In the right pane, navigate to the folder on the computer in which
to save data files.
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6. In the left pane, select the desired *.tps file(s) and click the Move
Right button. The file import progress displays.

=
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Figure 4-2. Import File from Topcon GNSS Receiver

7. If Open File After Import was selected, the import function closes
and the *. tps file opens in Topcon Link:
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Figure 4-3. Display data of the *.tps file
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Importing Files from a Topcon GNSS Receiver

How to see information about the
receiver and files

Topcon Link allows one to modify the left panel of the Import from
Device window to obtain extended information about connected
receiver(s) and collected raw data file(s). To get this information
right-click on the empty place of the left panel and select Details from
the pop up menu:

Refrash
Large Icons
Smal Icons
List

® Detals

After setting this mode for the receiver page, the left panel will
display the serial number, model and port of the computer, which is
used for connection with the receiver:

a kmpest frome Device
Lock In [[< Teocon GHSS Pacervens o o@D
Yoare | Seril ey | Mt | Pont
» VPP OML PRI R oMl
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|
Refresh
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(3
.
)

After setting this mode for the file page, the left panel will display the
size and the end time of file logging:
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Importing Files from a Sokkia
GNSS Receiver

GPS receivers of Sokkia family have an internal data storage device
to record data in *.pdc and *.sdr format.

When importing files from a Sokkia GNSS receiver, Topcon Link
automatically detects the receiver for importing data, and no further
setups are required.

Before connecting the receiver’s USB port to the computer’s USB
port, the Sokkia USB driver must be installed on the computer. The
driver is available on the Sokkia website: (http://www.sokkiagps.com/
support/s_gsr2700isx.php)

This section describes data import using the Topcon Link
interface.To import data using Windows® Explorer, see “Using
Windows Explorer to Import Files from a Device” on page 4-17.

1. Connect your receiver and computer according to the receiver’s
documentation.

Bluetooth® connection requires both devices to have Bluetooth
wireless technology capabilities.

2. With Topcon Link open, click File » Import from Device.

3. In the left panel, double-click Sokkia GNSS Receivers. Topcon
Link searches for connected devices.
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Click Stop to quit the search and display detected devices.
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Figure 4-4. Selection Sokkia GNSS Receiver

In the right pane, navigate to the folder on the computer in which
to save data files.

In the left pane, double-click the desired Sokkia GSNSS receiver
to access the device’s data storage module and view the collected
raw files.

The Sokkia GNSS receiver node contains three independent
COM ports. Clicking on a port will display all logged GNSS raw
data files. The user can simultaneously import different raw files
from each COM port to the computer (Figure 4-5 on page 4-7).
In the left pane, select the desired *.pdc / *.sdr file(s) and click
the Move Right button. The file import progress displays.

‘ﬁ Import from Device
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M OURIOPOC A 0003313 ¢ o= 131
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Figure 4-5. Import File from Sokkia GNSS Receiver
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8. If Open File After Import was selected, the import function closes
and the *.pdc / *.sdr file opens in Topcon Link

. D:\1\00032570.PDC <Sokkia PDC - GPS+ Raw Data>

o7 GPs Occupations |

[Tcon | PointName | Orignal Neme | Antenna Type [Arverna Hei... | Ant Height Method | Start Time
8 60sec &0sec SOK_GSR270015% NONE 0.000 Vertical 9/14/2009 4:08:00 PM

Figure 4-6. Display data of the *.pdc file

Importing Files from a Mobile
Device

The Topcon and Sokkia family of controller software (such as
TopSURYV and SSF survey application) run on several Topcon and
third-party mobile devices.

Microsoft® ActiveSync needs to be installed on the computer with
Windows XP. For details on the installation, see “Installing Microsoft
ActiveSync for Use With CE-based Devices” on page 1-11.

If the user’s computer operates under Windows Vista, ActiveSync is
not needed. A connection between the computer and an external
device with Windows CE will be automatically established after
connecting your device to your PC.

Topcon Link supports three formats of the Field Software Job files:

5 sv)
Spectrum Survey Field Job (*.tsj)
TopSURY 7 Job (*.tsf)
TopSURY PC Job {*.tsv)

* Spectrum Survey Field Job (*. tsj). This job is created in SSF
version 7.3 and later.

* TopSURV Job (*. tsj). This job is created in TopSURV version
7.0 and later.
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* TopSURYV PC Job (*.tIsv). This job is created in TopSURV
version 6.11.03 and earlier

There is a difference in formats of these files and a difference in using
these files in the computer’s software.

In TopSURYV version 7.0 and later, and in SSF the *.tsj file is saved on
the controller, this file format can be opened by Topcon Link/Topcon
Link/Topcon Tools/Sokkia Spectrum Office/TopSURV PC. Topcon
Link is used only for transferring the *.tsj file from the controller to
the computer without format changes. Moreover, the user can use a
movable memory card to transfer the *.tsj file from the controller to
the computer.

In TopSURYV version 6.11.03 and earlier, the *.tsv file is saved on the
controller. But Topcon Link/Spectrum Link/Topcon Tools/Sokkia
Spectrum Office/TopSURV PC version can not open this file format.
Topcon Link has to convert mobile device-based formats to computer-
based formats. Topcon Link performs the conversion of the *.tsv file
to the *.tlsv file during the import process. This format (*.tlsv) is
opened by Topcon Link/Spectrum Link/Topcon Tools/Sokkia
Spectrum Office/TopSURV PC.

NOTE
I

This section describes data import using the Topcon Link
interface.To use Windows® Explorer for data importing, see
“Using Windows Explorer to Import Files from a Device” on
page 4-17.

1. Connect your controller and computer according to the
controller’s documentation.

NOTE
I

Bluetooth® connection requires both devices to have Bluetooth
wireless technology capabilities.

With Topcon Link open, click File » Import from Device.

3. In the left panel, double-click Mobile Device. Topcon Link
connects to the internal memory of the controller.
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4. Navigate to the location in TopSURYV / SSF folder and select the
desired job.

5. In the right pane, navigate to the folder on the computer in which
to save data files.

6. In the left pane, select the desired file(s) and click the Move
Right button. The file import progress displays.

7. If Open File After Import was selected, the import function closes
and the file opens in Topcon Link.

& lmport from Deyice

L o stora
| W Topeon Dgtal Levels

: ﬁ Import from Device

Lookire [l Jobs | »@| ] lockne [ TeeSURV e v| 4=| ] ]
S Ocfok ts) 5 J T orrenrsy
= {308 51} Iy T ARPORT Hsv

P et tisy

et Xsv '

W Open Fles after brport
Cleae l

Figure 4-7. Import File from Mobile Device

Importing Files from Total
Station

Conventional and robotic Total Stations of Topcon and Sokkia family
have an internal data storage device to record data in various formats.
Refer to your Total Station operator’s manual for details on setup,
operation, and connection with other devices.

When importing files from a Topcon and Sokkia Total Station,
Topcon Link connects to the device and provides a path for the data
transfer. The actual file transfer is performed at the Total Station.

The connection procedure for Topcon and Sokkia Total Stations is
different, so refer to the device’s documentation for details.
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When connecting to a CE-based device, Microsoft® ActiveSync
automatically starts up and connects with the device. This connection
is required to import files, if your computer operate under Windows
XP. If the computer operates under Windows Vista, ActiveSync is not
needed.

If you need to install ActiveSync, see “Installing Microsoft
ActiveSync for Use With CE-based Devices” on page 1-11 for
details.

NOTE
/"

This section describes data import using the Topcon Link
interface. To use Windows® Explorer for data importing, see
“Using Windows Explorer to Import Files from a Device” on
page 4-17

1. Connect your computer and Total Station according to the
operator’s manual.
With Topcon Link open, click File » Import from Device.

3. In the right pane, navigate to the folder on the computer in which
to save data files.

4. In the left pane, double-click Topcon Total Stations or Sokkia
Total Stations.
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5. Double-click the desired instrument to connect with the Topcon

Link.
For Topcon Total Station
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Figure 4-8. Select Total Station to Import Data From

6. Select the “filel.txt” or “file.sdr” file and click the Move Right
button.

7. Follow all steps listed in the Download file from Total Station
dialog box. These steps may vary depending on the connected
device. Click Start.

8. If Open File After Import was selected, the import function closes

and the file opens in Topcon Link.
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Figure 4-9. Import File from Sokkia Total Station
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Importing Files from a Digital
Level

Digital Levels of the Topcon and Sokkia family have an internal data
storage device to record data. Refer to your Digital Level operator’s
manual for details on setup, operation, and connection with other
devices.

When importing files from a Topcon and Sokkia Digital Level,
Topcon Link simply connects to the device and provides a path for the
data import. The actual file transfer is performed at the Digital Level.

The connection procedure for Topcon and Sokkia Digital Levels
varies, so refer the device operator’s manual for details.

This section describes data import using the Topcon Link
interface. To use Windows® Explorer for data importing, see
“Using Windows Explorer to Import Files from a Device” on
page 4-17.

1. Connect your computer and Digital Level according to the
operator’s manual.
With Topcon Link open, click File » Import from Device.

3. In the right pane, navigate to the folder on the computer in which
to save data files.

4. In the left pane, double-click Topcon Digital Levels or Sokkia
Digital Levels.
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5. Double-click the desired instrument to connect with the Topcon
Link.

For Topcon Digital Level For Sokkia Digital Level
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Figure 4-10. Select Digital Level to Import Data From

6. Select the “file.dl”or file1.sdr*” file and click the Move Right
button.

Follow all steps listed in the Download file from the Digital Level
dialog box (Figure 4-11 on page 4-15) to select a file and begin
the import. These steps may vary depending on the connected
device.

8. If Open File After Import was selected, the import function closes
and the file opens in Topcon Link.
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Figure 4-11. Import File from Sokkia Digital Level

Importing Files from a Memory
Card

Most Topcon devices contain internal memory cards. These movable
memory cards are used to collect raw data and to transfer the
collected data from the device to the computer. The memory cards
can be divided into two different types:

* Memory cards formatted in Topcon receiver’s file system. These
cards are used in a Topcon receiver, such as the GR-3 or NET-G3

* Memory cards formatted using the FAT32 file system. These
cards used in controllers, such as the FC-200 or GMS-2.

To download data from the first type of the memory card, use Topcon
Link/Topcon Tools. Only these software support such cards.

If a memory (SD) card was used in a Topcon receiver, such as the GR-
3 or NET-G3, and contains *.tps files, it has already been formatted.
Topcon Link can read files on a memory card formatted in the Topcon
receiver file system. The device icon for a formatted card is red.

Topcon Link can format a memory card for use in a Topcon receiver,
such as the GR-3 or NET-G3. The device icon for an unformatted
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card is gray. See “Adding Devices” on page 2-1 for details on
formatting cards with a gray device icon.

=]

NOTE

5

This section describes data import using the Topcon Link
interface. To use Windows® Explorer for data importing, see
“Using Windows Explorer to Import Files from a Device” on

page 4-17

Insert the memory card into the card reader.

With Topcon Link open, click File » Import from Device.

In the left panel, double-click Topcon Memory Card.

Click the desired, formatted memory card device icon.

M N

Wait while Topcon Link checks the card’s file system and
displays the card’s data.
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Figure 4-12. Mount Memory Card
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6. In the right pane, navigate to the folder on the computer in which
to save data files.

7. In the left pane, select the desired file(s) and click the Move
Right button. The file import progress displays.

8. If Open File After Import was selected, the import function closes
and the file opens in Topcon Link.
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Figure 4-13. Import File from Memory Card

To download data from the second type of the memory card, one can
use the standard Windows procedure.

Using Windows Explorer to
Import Files from a Device

After installing Topcon Link, the computer’s hard disk contains up to
eight virtual drives for accessing Topcon and Sokkia devices to
import/export data. These virtual drives provide a quick way to
transfer data without opening Topcon Link. Many of the steps are the
same as for importing/exporting data via the Topcon Link interface.
See the corresponding section above for further details on the steps
listed in sections below.

Import from Topcon/Sokkia GPS Receivers using Windows
Explorer

1. Connect the receiver to the computer. Turn on the receiver.

2. Navigate to the Topcon Receivers or Sokkia Receiver directory
and click the device icon.
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3. After discovering devices, click the receiver’s icon.
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Copy or drag-and-drop this file to a directory on the computer.

From Topcon
GNSS Receiver

From Sokkia
GNSS Receiver

Figure 4-14. Import Using Explorer — Receiver

Import from Topcon and Sokkia Mobile Device using Windows

Explorer

1. Connect the controller to the computer. Microsoft® ActiveSync
needs to be installed on the computer with Windows XP.

the device icon.

Navigate to the Topcon Mobile Devices device directory and click

3. Navigate to the job location in TopSURV / SSF folder and select a

desired file.

computer.

4-18

Copy or drag-and-drop the desired files to a directory on the
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for the job created by TopSURV version 7.0 and later,
and the job created by SSF version 7.3 and later
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Figure 4-15. Import Using Explorer — Mobile Device

Import from Topcon and Sokkia Total Station using Windows
Explorer

1. Connect the total station to the computer. If needed, connect to
the total station via ActiveSync.

2. Navigate to the Topcon Total Stations or Sokkia Total Station
directory and click the device icon.

3. Click the icon for the connected total station and select the
“filel.txt” or “filel.sdr” file.

4. Copy or drag-and-drop this file to a directory on the computer.
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5. Follow instructions on the Download from Total Station dialog

box.
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Figure 4-16. Import Using Explorer — Total Station

Import from Topcon and Sokkia Digital Level using Windows

Navigate to the Topcon Digital Levels or Sokkia Digital Levels

Click the icon for the connected digital level and select the

Copy or drag-and-drop this file to a directory on the computer.

Explorer
1. Connect the digital level to the computer.
2.
directory and click the device icon.
3.
“file1.dl” or “filel.sdr” file.
4.
5.

Follow instructions on the Download from Digital Level dialog

box.
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For Topcon Digital Level
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Figure 4-17. Import Using Explorer — Digital Level

Import from Memory Card using Windows Explorer

1. Insert the formatted memory card into the card reader.

2. Navigate to the Topcon Memory Cards directory and click the
device icon.

3. Click the icon for the desired memory card.

Select and copy or drag-and-drop the desired files to a directory
on the computer.

Flo Edt Vew Favoes Toos Heb r

Qe - @ T O seweh |2 roders

nases: | B G v B
Felders x 3 oA
8| L] C
% B Topcon Memary Cards ~ = —
v B21p5 cctps enetps
< > p

Figure 4-18. Import Using Explorer — Memory Card
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Viewing File and Device
Properties

The properties of a data file on a device can be viewed after
connecting to the device. Once set up in Topcon Link, device
properties can be viewed at any time.

To view the properties of a file in a connected Topcon and Sokkia
controller or Topcon memory card, right-click the file and click
Properties. Figure 4-19 gives an example of the Properties dialog
box for a data file in a connected controller and memory card.
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aE3 < [B/x
o >
»
Q"‘ ® O > | e Pedors 0"‘“ i -> > I ) Sewth | [ pokders
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# L simey = B Yo Mewery Cess A - !
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1
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\
’ STET
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Mosted 1122009 2270 AN Crastnd 121112009 115249 AM
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r
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Figure 4-19. Data File Properties

To view the properties of a GNSS Receiver, Total Station or Digital
Level device, right-click the device and click Properties. Table 4-1
gives examples of the Properties dialog box for different devices.

Table 4-1. Device Properties Dialog Boxes

Topcon GNSS Receiver Sokkia GNSS Receiver

4-22 Topcon Link Reference Manual



Viewing File and Device Properties

Table 4-1. Device Properties Dialog Boxes
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For details on editing Digital Level and Total Station device
properties, see “Adding Devices” on page 2-1
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Chapter 5

GConverting Files
Between Formats

One of the primary functions of Topcon Link is to convert files from
one format to another. A file format conversion may be required to
access or work with data from multiple, proprietary, or third-party
software or systems. The Topcon Link conversion function allows
data to be cross-functional and multi-disciplinary. For example, a
survey crew may take point measurements in a field adjacent to a city
park in preparation for a new shopping center. Using Topcon Link,
this data can be converted to a shape file for uploading into the city’s
GIS database, or it can be converted to a Topcon GC3 file for sharing
with the construction crew for three-dimensional grading.

When converting files, a custom projection or custom datum may

need to be created. Topcon Link includes a number of pre-defined
projections and datums from which to base a custom projection or
custom datum.

When applying a projection or datum to a data set, transformation

parameters between the jobsite’s “grid” and the projection’s “ground”
can also be specified.
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Converting A File

To perform a format conversion, Topcon Link checks the data and its
format in the selected file and converts it to the default settings of the
selected format. Topcon Link will offer the user to select the desired
format of the file to be created from those which are allowed for the
data included in the file being converted. If it is desired to change the
coordinate system, coordinate order and/or metric units during the
process of transformation, use the Advanced Conversion options.
These options provide further control over the resulting data format.

1. Click File » Convert Files.

2. To select the file to convert, click Add files in the Convert Files
window.

3. In the Open dialog box select the appropriate format name.
Navigate to and select the desired file, then click Open. Also, the
user can activate the option for automatic recognition of the file
format in the process of opening the file. To do this, check the
“Recognize the file automatically” check box in the Open
window and do not select the desired file format.

4. If the selected file format is correct, the File status field displays
“File format is verified” and you can continue converting.

5. To create the file, select the appropriate format name and desired
folder where this file will be saved.

6. Topcon Link will use the name of the converted file to name of
the created file (except the RINEX file format). The extension for
the created file will be automatically assigned in accordance with
the selected file format. The Destination file name field displays
the name of the created file. To edit the name, click- pause-click
on this field.

7. To remove a file from the Convert Files window, select the
desired file and click Remove files.

8. To remove all files from the Convert Files window, click Clear
all.

9. If needed, click Advanced Conversion options and select the
parameters to apply to data during the conversion. See the
following sections for more details.
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=]
NOTE
-

Available parameters depend on data in the selected file and the
format being converted to.

10. Click Convert.

Topcon Link performs the conversion, saves the file in the
selected directory.
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Figure 5-1. Convert File

If the file conversion is successful, the Convert Files dialog box
displays the following:

‘s Convert Files

Source file path I Source file type | Destination file ... | File status I
°C:\2\New Folder\... TopSURY 7 Job - Field Software Jobs  test_1 File is successfully converted
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Converting Files Between Formats

To automatically overwrite the previously created file check the
CheCkbOXl v Overviite existing

The user can add unlimited number of files to the Convert Files
dialog box, if these files contain compatible data. If the user added the
files which have incompatible data, the conversion of these files is not
performed and the following alarm message displays:

Destination format |&Souree files contain no compatible data J

To perform a conversion, delete file(s) containing data incompatible
with other file(s).

If the user selects other format for the converted file in the Open
widow, he can select the desired file format from the format list of the
Source file type column. To activate this list, double click on the name
of the selected format:

a3 .
‘2 Convert Files

Source file path

C:\Examples_for converting files... |f

Source Me path | Source fe troe | e
B ClEvamples_for comvertng fes Naewe, N8, 2 Code - Coordinates  w | J00
™ -
Codel over LReory
Coordnames
4 BLH_NVEA-|
+ Mg ey ¥ Aemovelies | § Custion Teot Formst
- S —1 - “ustom_FULL_COOES
Destiration dokder PACode Coord UM
KoF
Destiraton bamal
Landdon
¥ Overeete exmtirg Mt GINIO
* Adewcad converson ophors e I N 2. Coce

The Advanced conversion option dialog box contains a group of
fields. They are necessary to input the data used for the coordinate
transformation/metric unit/coordinate order, etc. during the file
conversion. Each converted file should be supplied with information
that is absent in the file but needed for the correct transformation. For
example, the user can set the coordinate system, metric units for the
converted coordinate file, if these data are available. These data are
entered to the From fields. For the created file, one should enter the
parameters that appear in this file after conversion. For example, the
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coordinate system in the file should be NAD 83, metric units - US
Feet, orthometric heights - take into account the usage of Geoid 2003.
These data are entered to the To fields.

In general, the data entered to the Advanced conversion option dialog
box can be divided into following groups:

1. Convert coordinate type and system, including Grid to Ground
conversion

Convert ellipsoidal/orthometric height
Convert coordinate order

Convert metric unit

Convert angular unit

Convert vertical angle

Convert distance format

Change geoid bounds

A P AT LR ol

Filter raw data

Topcon Link analyses the data type of the converted/created file,
automatically selects the needed group parameter(s) used for each
format. Advanced conversion option will display only those
parameters which are needed for given types of input/output data.

The groups are independent in selecting and can be enabled/disabled
independently.

Depending on the data type of the converted/created file some fields
of any group can be disabled or not presented.
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Convert Coordinate Type and System

Using the fields in the Convert coordinate type and system tab the
user can specify a coordinate system for converting and creating file.

Depending on the data type of the converted/created file, the user can
select the following coordinate type in the To/From fields:

Coordinate type: | Grid j

Ground or Localization

Projection:

Grid, EILH

Lat, Lon, EILH
w584 Lat, Lon, EILH
Lat. Lon, Elevation

If the user selected the Ground or Localization coordinate type, the
coordinate system is set to None for the converted/created file:

Coordinate type; ‘ Ground or Localization i

Coordinate system: Mohe

If the user selected the Grid (Grid coordinate system with orthometric
heights) or Grid Ell (Grid coordinate system with ellipsoidal height)
coordinate type, the user can select a desired projection type from the
list of projections available or create a new projection. For details on
how to create a projection, see “Adding a Custom Projection” on
page 5-37:

Coordinate tpe: ‘ Grid j

Prajection: California [£aned) = Custom.. |

= SPCE3

Calfornia (Zone3)

If the user selected the Lat,Lon,EIl.LH (a datum with ellipsoidal
heights) or Lat,Lon,Ellevation (a datum with orthometric heights)
coordinate type, the user can select a desired datum from the list of
datums available, or create a new datum. For details on how to create
a datum, see “Adding a Custom Datum” on page 5-41.

Coordinate type: |Lat, Lon, EILH j

D aturm: | Custom..
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If the user selected the WGS-84 Lat,Lon,Ell.H coordinate type, the
datum will be selected automatically:

Coordinate type: |WGSB4 Lat, Lon, EILH j

Daturn: WESE4

Using this tab the user can perform transformation between Grid and
Ground coordinate systems. The transformation will be enabled if:

* the converted file contains points in the Ground coordinate
system but a created file has to contain points in a Grid or a
Datum coordinate system. In this case Topcon Link performs
Ground to Grid transformation:

Convert coordinate type and system

Fram To
Coordinate type; Ground or Localization j Coordinate type: Grid, EllLH -
Projection: Calitornia [Zoned | Custarn.
v i [Zane3]
o Coordinate system: Mohe Q
Datum; |naDgz =l
(ﬁ Grid to ground |

* the converted file contains points in the Grid coordinate system
but a created file has to contain the point in the Ground coordinate
system. In this case Topcon Link performs Grid to Ground

transformation:
Convert coardinate twpe and system
From To
Coordinate type; ‘ Grid j Coordinate type; Ground or Localization j
Projection: % Blaska [Zone 8] | Custom...
o Q Coordinate system: Mone
Datum [MaDE3 |

@ Grid to ground
For all other combinations of coordinate systems for input/output files
the Grid and Ground is disabled: I

For details on setting these parameters, see “About Grid->Ground
Parameters” on page 5-42
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Convert Height

The conversation of heights is enabled if is needed to obtain
orthometric heights for the points of the created file from the
ellipsoidal heights of the points in the converted file and vise versa.

The transformation will be enabled if:

* the converted file contains points in the Ground or Grid/Datum
coordinate system with orthometric heights, but a created file
must contain points in a Grid/Datum coordinate system with
ellipsoidal heights:

Convert coordinate type and system

From To

Coordinate type: Ground or Localization j Coardinate type: Girid, EILH
Projection, Calitornia (Zore) = Custom...
4 Coordinate system: Mone
Datum: [mape3

* the converted file contains points in the Grid/Datum coordinate
system with ellipsoidal heights, but a created file has to contain
points in a Grid/Datum coordinate system with orthometric
heights:

From Ta
Coordinate type: I1||:I EllH Coordinate type: |Lat Lon, Elesvation J
Projection: Alaska (Zone 8] Custom...

Dalum. NADB3 :I Custam.
Datum: [napez

In these cases Topcon Link offers to select the desired Geoid from the
list of geoids used. The user can add any Geoid file to this list by
clicking the Geoid List button (see “Adding a Geoid” on page 2-14):

From <Elevation: Tao <ENLHt

W Use geoid hd Geoids List..

Field Software Job is the most informative file format. This format
can contain both ellipsoidal and orthometric heights and also the
name of the geoid used for height calculation. If Field Software Job is
converted, Topcon Link automatically uses the height information
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contained in the job. The height conversion will be available if the
geoid used in TopSURV/SSF is presented in the Topcon Link geoid
list. In an example below, the geoid selection from the geoid list is not
available:

Uze geoid

If the geoid used in TopSURV/SSF is not presented in the Topcon
Link geoid list, the following message will appear:

Topcon Link

! E g2003u07 : Geoid model is not in the list. Elevation calculations will work incorrectly if you do not load this geoid

Convert Coordinate Order

This type of conversion allows one to select the order of the
horizontal coordinate (Easting and Northing) for the points of the
created file if Ground/Grid/Grid Ell coordinate system is set for this
file:

Convert coordinate order

3 Ta [MEH ﬂ’

EMH

If the user selected Name,N,E,Z,Code or Name,E,N,Z,Code
coordinate file format, the fields of coordinate order selecting will
display the order which defined by the corresponding file format:

Caonvert coordinate order

v From‘ JTol J

Convert Metric Unit

This type of conversion allows one to select the desired metric unit for
converted and created files:

Carwert metric unit
[#  From |Mele|s j Ta |USFeBt j
Meters
IFeet
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Convert Angular Unit

This type of conversion allows one to select the desired format of
angular values for converted/created Total Station raw files:

Canvert angular unit
3 To |oms =]

Gons
Mils

Convert Vertical Angle

If TS raw data file does not have information about vertical angle
mode, the user can select the mode under Advanced conversion option
when such file is converted/created by Topcon Link:

Convert vertical angle

[ From ‘Auto [Z4 if angle » 45 degress) j e |ZA j

[

* ZA — vertical angles are from zenith

* VA- vertical angles are from horizontal

* Auto — no information available on vertical angle mode. In an
example below, angles from 0 to 45° are considered “vertical”
and angles more than 45° are considered “zenith.”
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W Vel
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NS

\ -
. \
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e -
-
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-

AR Ty - 9Q

v

270 1180
Figure 5-2. Vertical Angle from Horizontal (A) and Zenith (B)
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Convert Distance Format

This type of conversion allows one to select the desired format of
distance values for a created Total Station raw file: the distance
between a station and a measured point can be recorded either as
slope distance and vertical angle or as horizontal and vertical
distances. Selecting Auto records distances into the created file using
the distance format of the converted file:

Corwert distance format
i3 Te [Ho gD |
Auto
5D & Angle

Change Geoid Bounds

This option allows one to define the area of a created geoid file from
any supported geoid model. When converting from a Geoid file, the
following parameters are available in the right pane:

* Minimum / Maximum Latitude — enter the minimum and
maximum latitude of the points that limit the use of this model.
Latitudes are positive for the Northern hemisphere.

Minimum / Maximum Longitude — enter the minimum and maximum
longitude of the points that limit the use of this model. Longitudes are
positive for the Eastern hemisphere.

Filter Raw Data

This option allows one to include:
* GPS or GLONASS satellites

* pseudorange and phase measurements on L1 or L2 frequency
to created RINEX/Compact RINEX/Topcon TPD file formats:

Channels
¥ GPS

| W GLOMASS
b L1
v i3

To remove any item, uncheck a desired checkbox.
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The following sections describe the file format conversions, as well as
list which files can be converted to which format.

“Code Library File Conversion Parameters” on page 5-12
“Coordinate File Conversion Parameters” on page 5-13
“Example of Conversion Coordinates File” on page 5-14
“Geoid File Conversion Parameters” on page 5-20

“GPS+ Raw Data File Conversion Parameters” on page 5-21
“Localization GC3 File Conversion Parameters” on page 5-27
“Road File Conversion Parameters” on page 5-27

“Topcon XML File Conversion Parameters” on page 5-29
“Field Software Job File Conversion Parameters” on page 5-30
“TS Obs File Conversion Parameters” on page 5-35

“X-Section Template File Conversion Parameters” on page 5-36

Code Library File Conversion
Parameters

A code library file contains a description of codes, such as code name,
plotting style, and attribute. Table 5-1 lists the formats that a code
library can be converted to.

Table 5-1. Code Library File Conversion Formats

From a... To a...

Code Library file: Code Library file
DBF Code Library, TDD Code Library, |Field Software Job file

XML Code Library, Autodesk Layer
States Code Library

Field Software Job file Code Library file

When converting from a Code Library file, no further parameters are
required.
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Coordinate File Conversion

Parameters

A coordinate file contains a list of points in some coordinate system.
Table 5-2 lists the formats that a coordinate file can be converted to/

from.

Table 5-2. Coordinate File Conversion Formats

XML; Field Software Jobs;
Name,E,N,Z,Code; Name,N,E,Z,Code;
Name,Lat,L.on,Ht,Code; SBG Geo; SBG
Pxy; TDS; KOF

From a... To a...
Coordinate file: Coordinate file
Custom Text Format; Topcon FC-4; Design
Topcon FC-5; Topcon GTS-210/310-10; | GIS: ESRI Shape
Topcon .GTS 210/310-12; Topcon GTS- Topcon XML file
7; Sokkia SDR;LandXML; Topcon Field Software Job file

Field Software Job file

Coordinate file

Design

Coordinate file

TS Obs (if the format contains point
coordinates)

Coordinate file

GIS: ESRI Shape

Coordinate file

==
NOTE
-

Available parameters depend on the data in the selected file and

the format being created.

When converting from/to a coordinate file the user can select the

following parameters:

1. Convert coordinate type and system (see “Convert Coordinate
Type and System” on page 5-6)

Convert height (see “Convert Height” on page 5-8)

3. Convert coordinate order (see “Convert Coordinate Order” on

page 5-9)

4. Convert metric unit (see “Convert Metric Unit” on page 5-9)

P/N 7010-0522
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These parameters are selected independently and can be enabled/
disabled independently:

for converted coordinate file:
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Figure 5-3. Convert Coordinate File — Example

Example of Conversion Coordinates File

The following pages describe the example of conversion of the
coordinate file (‘lat_lon_ell.txt’), which contains the points in the
datum coordinates (NADS83). This file has Lat, Lon, Ht, Code file
format, and height is ellipsoidal height in meters:

Latituds
-H P4
P lat_lon_elltxt - Notepad
File Edit Format View Help P
BASE2,40 06 07.52051,-82 59 12.47055,208.176,BaSE,
CP2,40 06 11.08726,-82 59 16.18872,247.09%4,
CP4,40 06 13.12269,-82 59 10.68572,246.934,
CPS,40 06 07.23787,-82 50 06.52307, 246.268, P#4d, pasez
CP6,40 06 05.22798,-82 59 12.11935,246.429, 4 & CPS
40°06/05N %‘ &R
— T T
A Z°SO1SW  B2OSOUOW  BZeSI0SW
@ |

The task is to convert this file to other coordinates file, which will
contain the points in Grid coordinates system (SPC83-Ohio (North)),
with orthometric height in US Feet.
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To create such a file, we do the following steps:

1.

Click File->Convert Files and click Add Files in the
window. The Import window appears.

Navigate to the desired file, highlight it and select the
corresponding file format in the Format name field:

Lock n funnnun

) Coluntns RTE Suremy

d Cors Tt Statuin Survey
OMM St Ungroossond

Sl _kon_el

[lat_on_sd te

[ Nave Lot Lonia.Code - Comdnges I o)

¥ Fecograe fle foenst ssomatically
Eo|

3. The converted file appears in the list of the converted
files:

Source file path

| Source file bype

| Diestination file name File status I

CiiRaw Datallat_lon_ell bzt

Mame,Lat,Lon,Ht,Cade - Coor...  lat_lon_ell.csv Mot converted

4. Check the Advanced conversion option checkbox:

i v Advanced conversion options |
..... [‘k 1

5. Select the format name for the grid coordinate system of
the created file in the Destination format field:

Destination format

P/N 7010-0522
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Converting Files Between Formats

6. Select or create the folder where this file will be saved

(by clicking i} ):

Oestination kokd - Browse for | plder r? ﬁ[ J '

Sever fouder

‘J Desitop
| ® L My Doouments

|« 3 CEm

| 5 & My Metswcrh. Maces

[ mdemewrade [ x| caen |

7. Change the name of the created file in the Destination
field name field:

Destination file name
Jat_lon_ell.csv

Destination file name I
' Grid_Ortha csv

8. Select the Grid coordinate system and Ohio (North)
projection in the corresponding fields:

To
Coordinate type: |Gnd j

Projection Ohio [Morth] = Custom...

9. Add the ‘g2003u07.bin’ geoid file to the list of geoids
used. To do this, click the Geoid List button, click Add
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and select the folder where the desired geoid file is
located:

File narve 13200207 tey
Fomatnane | Geodaheod003 Fies (g bn)

Then activate this geoid for conversion of the coordinate file:

Usze geoid e
—} Use geoid 241
Eqmak

10. Select ‘Meters’ for the converted and ‘Us Feet’ for the
created file in the Convert metric unit fields:

"Emvelt metnic it

f From IMelels LI To [UsFest Ll

Meters
IFect

11. Click the Convert button.If the file conversion is
successful, the Convert Files dialog box displays the
following:

Source file path | Source file type | Diestination file name | File status |

.C:\Raw Datallat_lon_ell bxt.csv Mame,Lat,Lon,Ht, Cade - Coor...  Grid_Ortha.csy File is successfully converted

12. The created file has the following coordinates and
heights:
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File Edt Format WYiew Help
BASEZ,159015.452,1832310. 524,794,107

CP2,159382.018,1832023, 596,021, 785,
CP4,159585.613,1852452. 388,021, 270,

CP3,158988.274,1832772.486,919. 090, P#44

CP6,158787.298,1832336.522,919. 609,

Marthing,
USFeet 4P
159500

e
, BasE

4-BASEZ 0
:1 $Fe
T T T T T
= 1832500 1533000

Design and Surface File Conversion

Parameters

A design file contains CAD information (points, linework, surfaces).
Table 5-3 lists the formats that a design file can be converted to/from.

Table 5-3. DWG, DXF, LandXML Design File Conversion Formats

From a...

To a...

Design file: AutoCAD Drawing,
AutoCAD DXF; KOF; LandXML,
Microstation 95/ISFF, MX GENIO Line,
SBG Geo, SBG Pxy, Topcon 3D
Linework, Topcon 3D Surface,

Design file
Coordinate file

Field Software Job file
Surface file

Coordinate file

Design file: AutoCAD Drawing,
AutoCAD DXF; KOF; LandXML,SBG
Geo, SBG Pxy,

TS Obs

Design file: AutoCAD Drawing,
AutoCAD DXF; KOF; LandXML,SBG
Geo, SBG Pxy,

Field Software Job file

Design file: AutoCAD Drawing,
AutoCAD DXF; KOF; LandXML,SBG
Geo, SBG Pxy, Microstation 95/ISFF,
Microstation V8, Topcon 3D Linework

Topcon XML file

Design file: AutoCAD Drawing,
AutoCAD DXF; KOF; LandXML,SBG
Geo, SBG Pxy,

GPS Obs

Design file: LandXML

5-18
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Table 5-3. DWG, DXF, LandXML Design File Conversion Formats (Continued)

From a... To a...

Design file, Topcon 3D Surface Design file: AutoCAD Drawing,
AutoCAD DXF; LandXML

NOTE
I

Available parameters depend on the data in the selected file and
the format being created.

When converting from/to a Design file, the user can enable and select
the following parameters:

1. Convert coordinate type and system (see “Convert Coordinate
Type and System” on page 5-6)
Convert height (see “Convert Height” on page 5-8)

3. Convert coordinate order (see “Convert Coordinate Order” on
page 5-9)

4. Convert metric unit (see “Convert Metric Unit” on page 5-9)

for converted design file:

e e
Comt LB e

cewie e o . — -

&t gt
—_——

< o e (454 D for created design file:
t-vntntn

w b Ta

Ry Cnnedinate byper Gl FEH =]

el T Puiciin: (I ~|  cision

 THa— Doty HADET =
&7 Grid b ground |

To <EL He

Uom g [$£0050T ] o Lt

T =

T2 [UsFe |

Figure 5-4. Convert Design File — Example
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Digital Level File Conversion
Parameters
A digital level file contains level measurements from a station to

points. Table 5-4 lists the formats that a digital level file can be
converted to.

Table 5-4. Topcon Digital Level Conversion Formats

From a... To a...
Topcon Digital Level: Topcon XML file
DL, LEV, TXT, Topcon XML Field Software Job file
Sokkia SDR
DL BlueBook

When converting from Digital Level file the user can select only the
Convert metric unit option (see “Convert Metric Unit” on page 5-9).

Geoid File Conversion Parameters

A geoid file contains data on a physical reference surface. The shape
of the geoid reflects the distribution of mass inside the earth. The rise
and fall of the surface in a geoid is important for converting GPS-
derived ellipsoidal height differences to orthometric height
differences.

Using Topcon Link, you can create a Topcon geoid file (*.gff) for a
defined area from any supported geoid model—creating a sub-section
of the selected geoid file. This file can then be exported into Field
Software Jobs. Table 5-4 lists the formats that a geoid file can be
converted to.

Table 5-5. Geoid Conversion Formats

From a... To a...

Geoid file Topcon Geoid file

When converting from a Geoid file, the user can enable and select
only the Change geoid bounds option (see “Change Geoid Bounds”
on page 5-11)
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GPS+ Raw Data File Conversion
Parameters

GPS+ Raw Data file contains GPS/GLONASS code and carrier phase
measurements collected for point or points where was mounted a GPS
antenna. Topcon Link directly converts (that is using its own
technique) the following GPS+ raw data files:

» TPS/JPS files are the raw data files logged by Topcon receivers.

* TPD files are a Topcon proprietary format for storing GPS raw
data, and can be used to backup raw data or exchange raw data
between different jobs.

» Sokkia PDC files are the new raw data files logged by Sokkia
receivers (GSR2600, GSR2700 and GSR1700).

» Sokkia Stratus files are the raw data files logged by Sokkia
Stratus receiver.

e RINEX 2.11 and RINEX 3.0 is the version of standard format for
exchanging GPS Raw Data. For a static/kinematic observation(s)
(session(s)) 2 or 3 files are created; the first usually having an
extension beginning with the letter ‘O’ and stores the
observations; the second usually has extensions beginning with
the letter ‘N’ or ‘G’, depending on GPS/GLONASS capability,
and stores GPS and GLONASS navigational data (orbits) for
those observations.

» Compact RINEX/Compact Rinex3 file (or a Hatanaka compres-
sed file) is the compression of RINEX 2.11 / RINEX 3.0
observation files. This file type contains a “D” extension.

Also Topcon Link allows the user to convert native binary formats of
GPS receivers manufactured by Ashtech (B*.*, E*.* S*.*) L eica
Geosystems (*.1b2, *.mdb,*.m00), Trimble (*.dat), Septentrio
Satellite Navigation NV (*.sbf) companies. For converting these
formats, Topcon Link applies TEQC software (http://
facility.unavco.org/software/teqc/teqc.html).

When the user converts one of the above formats in Topcon Link, the
following scheme of converting the file starts to work automatically:
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1. TEQC converts the native binary format to RINEX 2.11
file format.

2. Topcon Link will convert the created RINEX file to a
user-selected file format.

NOTE:

1.

The current default setting for the TEQC allows converting only
static occupations (provided there is only one Marker Name in
the file for this occupation). In other words, it is impossible to
convert kinematic and Stop&Go files of native formats of these
companies into Topcon Link.

When converting binary files of third-party companies, Topcon
Link uses default settings of the TEQC program. If a binary file
failed to be converted by Topcon Link, we recommend to repeat
the conversion to the RINEX file using settings of TEQC (out of
the Topcon Link program) for the given binary file. After
obtaining an appropriate RINEX file, this file can be converted by
Topcon Link.

Table 5-6 lists the formats that a GPS+ raw data file can be converted
to/from.

Table 5-6. GPS+ Raw Data File Conversion Formats

From a... To a...

Topcon/JPS file Compact RINEX (ver 2.11)

Compact RINEX3 (ver 3.00)
RINEX (ver 2.11)

RINEX 3 (ver 3.00)

TPD file

Sokkia PDC Compact RINEX (ver 2.11)

Compact RINEX3 (ver 3.00)
RINEX (ver 2.11)

RINEX 3 (ver 3.00)

TPD file
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From a...

To a...

Sokkia Stratus

Compact RINEX (ver 2.11)
Compact RINEX3 (ver 3.00)
RINEX (ver 2.11)

RINEX 3 (ver 3.00)

TPD file

TPD file

Compact RINEX (ver 2.11)
Compact RINEX3 (ver 3.00)
RINEX (ver 2.11)

RINEX 3 (ver 3.00)

Compact RINEX (ver 2.11) file

Compact RINEX3 (ver 3.00)
RINEX (ver 2.11)

RINEX 3 (ver 3.00)

TPD file

Compact RINEX (ver 3.00) file

Compact RINEX3 (ver 2.11)
RINEX (ver 2.11)

RINEX 3 (ver 3.00)

TPD file

RINEX (ver 2.11) file

Compact RINEX (ver 2.11)
Compact RINEX3 (ver 3.00)
RINEX 3 (ver 3.00)

TPD file

RINEX (ver 3.00) file

Compact RINEX (ver 2.11)
Compact RINEX3 (ver 3.00)
RINEX (ver 2.11)

TPD file

Ashtech file by teqc

Compact RINEX (ver 2.11)
Compact RINEX3 (ver 3.00)
RINEX (ver 2.11)

RINEX 3 (ver 3.00)

TPD file
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Table 5-6. GPS+ Raw Data File Conversion Formats (Continued)

From a... To a...

Leica file by teqc Compact RINEX (ver 2.11)
Compact RINEX3 (ver 3.00)
RINEX (ver 2.11)

RINEX 3 (ver 3.00)

TPD file

Septentrio file by teqc Compact RINEX (ver 2.11)
Compact RINEX3 (ver 3.00)
RINEX (ver 2.11)

RINEX 3 (ver 3.00)

TPD file

Trimble file by teqc Compact RINEX (ver 2.11)
Compact RINEX3 (ver 3.00)
RINEX (ver 2.11)

RINEX 3 (ver 3.00)

TPD file

* When converting to a RINEX or Compact RINEX file, the user
can enable and select only the Filter raw data option (see “Filter
Raw Data” on page 5-11).

Example of Conversion Topcon File to RINEX
File

The following pages describe the example of conversion of the
Topcon file (‘DER1-0303b.tps’). This file was collected by dual
frequency GPS/GLONASS Topcon receiver. It needs to create the
RINEX file with GPS L1 raw data only.

To create this file, do the following steps:

1. Click File->Convert Files and click Add Files in the
window. The Import window displays
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2. Navigate to the desired file, highlight it and select the
corresponding file format in the Format name field:

FER G o
[ BPSe R Dl [ tpd* 7207 76570 710" e gl v

3. The converted file appears in the list of the converted
files:

83 5
= Convert Files

ource file path | Source file type [ Destination Folder ... | File status
Ci\Examples_for converting files for TLink\TPS datalDER1-0303b.tps  TPS - GPS+ Raw Data 4 File format is verified

4. Check the Advanced conversion option checkbox:

i v Advanced conversion options |
..... 1

5. Select the RINEX file format for the created file in the
Destination format field:

Diestination format M RINEX - GPS+ Raw Data [* 770" 779G 770] |

6. Type in a name of a new folder in the Destination folder
name field:

Drestination folder |E SRINER_DATA _|

The created files will be stored in the folder.
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7. Uncheck the desired channels:

Channels
v GPS

I GLOMASS
W L1

L2

8. Click the Convert button. The following message
appears:

Topcon Link

] Folder C:\RINEX_Datal not found. Create?
LY

Press Yes to create this folder. If the file conversion is successful,
the Convert Files dialog box displays the following:

4t Convert Files

Source file path [ Source file type [ Destination folde... | File status
@C:\Examples_for converting files for TLiNk\TPS data\DER1-0303b.tps  TPS - GPS+ Raw Data 4 File is successfully converted

9. The created file has the following data:

2.18 OBSERUATION DATA G (GPS) RIMEX UERSIDH / TYPE
Topcon Link 7 21-HOU-87 28:58 PGHM / RUM BY / DATE
build July 25, 2882 {(c) Topcon Positioning Systens GOMMENT
DER1-8383b_JFGG HARKER HNAHE

HARKER HUHMBER
=-Unknown- —Unknown- OBSERVER / AGEHCY
AFFRRRF JFGG —Unknown- ~Unknown- REC # / TYPE / UVERS
-Unknoun- —Unknown- ANT # / TYPE

28508716.2627 21993741797  5247224.3437 APPROX POSITION XYZ
6.08088 a8.80880 6.088088 ANTENNA: DELTA H/E/H
1 a WAUVELENGTH FACT L1/2
20805 3 3 1 a 0.0000008 GP3S TIME OF FIRST OBS
208085 3 3 1 59 50 .0006060 GPS TIME OF LAST OBS
1.008 INTERUAL
13 LEAP SECONDS
13 # OF SATELLITES

4 c1 P1 L1 D1 # / TYPES OF OBSERU

rE @04 70&a  R91 mo4 ooM 7 ® N onoec
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Localization GC3 File Conversion
Parameters

A localization file contains coordinate points in both the local and
global coordinate systems. These systems are used in the calculation
of localization points. Table 5-7 lists the formats that a localization
file can be converted to.

Table 5-7. Localization File Conversion Formats

From a... To a...
Localization file: Topcon 3D Field Software Job file
Field Software Job file Localization file

If the Field Software file contains pairs
of point coordinates in WGS84 and local
system for each Control point.

When converting from a Localization file, no further parameters are
required.

When converting to a Localization file, the user can enable and select
only the Convert metric unit option (see “Convert Metric Unit” on
page 5-9)

Road File Conversion Parameters

A road file contains information about the stations/chainages,
alignments, cross-sections, and grades required for creating a road.
Table 5-8 lists the formats that a road file can be converted to/from.

Table 5-8. Road File Conversion Formats

From a... To a...

Road file: CLIP, ISPOL, LandXML, MX | Road file
GENIO, SBG, SSS, TDS, Tekla, Topcon | Field Software Job file
3D, Topcon XML, Field Software Job Topcon XML

X-Section Templates
Design file: LandXML
Field Software Job file Road file

If the Field Software file contains road
data.
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When converting from a Road file, the user can select:

Convert coordinate type and system (see “Convert Coordinate

page 5-6)

Convert metric unit (see “Convert Metric Unit” on page 5-9.

1.

Type and System” on
3.

page 5-9)
4,

Convert coordinate order (see “Convert Coordinate Order” on

Convert metric unit (see “Convert Metric Unit” on page 5-9 no

further parameters are required.

Conwert coordinate type and systern
From

Coordinate type: ‘Ground or Localization

- Coordinate system:  Mone

Convert metric unit

=1

for created road file:

@ Grid to ground

To

[# Fiom | Meters

BY Convert

for converted road file:

Figure 5-5.

5-28

Coardinate type =
K Frojection Ohia North) < Custam
Datum: [MaDEz ~|
To [NEH ~|
To |UusFest =

Convert Roads File — Example
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Topcon XML File Conversion

Parameters

A Topcon XML file can contains points, roads, TS measurements, DL
measurements, and/or any GPS observations. Table 5-9 lists the
formats that a Topcon XML file can be converted to/from.

Table 5-9. Topcon XML File Conversion Formats

From a... To a...
Topcon XML file Coordinate file
Design (except TN3) file
GIS: ESRI Shape file
Field Software Job file
GPS Obs
DL Obs
TS Obs
Road
X-Section
Topcon XML
Coordinate file Topcon XML file
Design (except TN3and LN3) Topcon XML file
Field Software Job file Topcon XML file
DL obs Topcon XML file
TS Obs Topcon XML file
GPS Obs Topcon XML file
Land XML Topcon XML file
Road Topcon XML file
X-Section Topcon XML file
-

Available parameters depend on the data in the selected file and

the format being created.
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When converting from/to a Design file the user can select the
following options:

1. Convert coordinate type and system (see “Convert Coordinate
Type and System” on page 5-6)
Convert height (see “Convert Height” on page 5-8)

3. Convert coordinate order (see “Convert Coordinate Order” on
page 5-9)
Convert metric unit (see “Convert Metric Unit” on page 5-9)

5. Convert angular unit (see “Convert Angular Unit” on page 5-10)

6. Convert vertical angle (see““Convert Vertical Angle” on page 5-
10)

Field Software Job File Conversion
Parameters

A Field Software Job file can contain the following measurements:

* Total Station measurements (the distance, vertical angle, and
horizontal angle measurements from a station to a point).

* Digital Level measurements (the level measurements from a
station to a point).

¢ GPS Observation (the coordinate increment in the current
projection and solution type for the measurement).
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Table 5-10 lists the formats that a Field Software Job file can be

converted to/from.

Table 5-10. Field Software Job File Conversion Formats

From a... To a...

Spectrum Survey Job: Code/Layer Library
TopSURV 7 Job, Coordinate file
TopSURV PC Job GPS Obs

TS Obs

DL Obs

GIS: ESRI Shape file

Design file

Topcon XML file

Localization file (if the Field Software
file contains pairs of point coordinates in
WGS84 and local system )

Cut Sheet file (if the Field Software file
includes Stakeout points)

Road file (if the Field Software file
includes road data)

X-Section Template file (if the Field
Software file includes an X-section

template)

Field Software Job
Coordinate file Field Software Job file
DL Obs Field Software Job file
TS Obs Field Software Job file
GPS Obs Field Software Job file
Topcon XMLr Field Software Job file
Localization file Field Software Job file
Design file Field Software Job file
Road file Field Software Job file
X-Section Template file Field Software Job file
Code/Layer Library Field Software Job file

Spectrum Survey Job/TopSURV 7 Job/
TopSURYV PC Job

Spectrum Survey Job/TopSURV PC Job/
TopSURYV 7 Job
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NOTE
/"

Available parameters depend on the data in the selected file and
the format being created.

When converting from a Field Software Job file, no further
parameters are required.

When converting to a Field Software Job file the following
parameters are available:

1. Convert coordinate type and system (see “Convert Coordinate
Type and System” on page 5-6)
Convert height (see “Convert Height” on page 5-8)

3. Convert coordinate order (see “Convert Coordinate Order” on
page 5-9)

4. Convert metric unit (see “Convert Metric Unit” on page 5-9)

5. Convert angular unit (see “Convert Angular Unit” on page 5-10)

6. Convert vertical angle (see“Convert Vertical Angle” on page 5-
10)

Example of Conversion Field Software File to
Topcon Vector File

The following pages describe the example of conversion of the
TopSURYV 7 Job file (‘columbus_rtk_ts.tsj’). This file was collected
by Topcon Controller FC -200 with TopSURYV version 7.0 and was
saved on the controller’s removable flash memory card. This job
contains the TS measurements and GPS RTK observations:
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Latitude

40°06'12.5MN  —|

40°06° 10,00 —|

40°06'07.5M  —|

/b PS5

/

e
(T3l
G2°59'15.0W 82°50'12.5 82°53'10, 04 82°59'07.5W a2o59

The task is to create the Topcon Vector file and save this file on the
computer.

To create this file, we do the following steps:
1. Insert the controller’s removable flash memory card into
the computer’s card reader.

2. Click File->Convert Files and click Add Files in the
window. The Import window displays.

3. Navigate to the desired file, highlight it and select the
corresponding file format in the Format name field:

Desirationfokder | Fie name: feokmbun o _tz 1y ]

Desirgionkenat  [Fomstrame |7 gty 7 30b - TogSURV Job 1l -k

o |
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4. The converted file appears in the list of the converted
files:

s -
#s Convert Files

I Source file path ] Source file type ] Destination file name | File status [
| G:itopSURY_Job_7Ycolumbus_rtk_ts.tsj TopSURY 7 Job - TopSURY Job columbus_rtk_ts.xml  File Format is verified

5. Check the Advanced conversion option checkbox:

i v Advanced conversion options

6. Select the Topcon vector file format for the created file in
the Destination format field:

Drestination format ‘ Topeon Wectors - GPS Obs (7 tf] j

7. Type in a name of a new folder in the Destination folder
name field:

Destination folder |C:hraw DataAGPS OF| =] I

The created files will be stored in this folder.

8. Select the desired metric unit for the created file:

Convert metic unit

3 Ta [UsFeet =]

USFect

9. Click the Convert button. The following message
appears:

Topcon Link

! 5 Folder C:\rawData\GPS Obs) not found. Create?

Yes No

10. Press Yes to create this folder. If the file conversion is
successful, the Convert Files dialog box displays the
following:

4 Convert Files

Source file path | Source file type | Destination file name | File status
. GiltopSURY_Job_7\columbus_rtk_ts.tsj TopSURY 7 Job - TopSURY Job columbus_rtk_ts.tvf File is successfully converted
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11. The created file has the following data:

Latitude |

?11

POE'1ZSN —

06100 —

/s

POE'NT.EN —

IPOE'05, 0N —

25920

62°59'15W

¢ 4 Fonts % GPS Obs |2 GPs Occupations |

62°59'10W 62°5905W

Icon | Poink Fromm ‘ Pain... | Stark.., ‘ Dur... | Horizontal Preci. . | Wertical Precis..,

dtd ) [ dE (m;

Base2
Basez

1z
114

BaseZ? 110

pope

0,004
0.005
0.004

0,003
0.007
0.004

10,950
-11.428
127,135

-38.828
-37.221
-57.401

Basez 10z

0.005 0.005 64.022 -a0.15¢

TS Obs File Conversion Parameters

A total station observation file contains the distance and vertical/
horizontal angles measurements from a station to a point. Table 5-11
lists the formats that a total station observation file can be converted

to.
Table 5-11. TS Obs File Conversion Formats
From a... To a...
TS Obs file: Measurement file
Custom Text Format, FC-5 Raw, Coordinate file
GTS-210_310 Raw, GTS-6 Raw, GTS-7 | Design file
g%vsf’ SG(){(]SGZE g;w, Topeon XML'TS | 515. ESRI Shape file
’ Topcon XML file
Field Software Job file
TS Obs file
Field Software Job file TS Obs file
Topcon XML file TS Obs file
TS Obs file TS Obs file
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NOTE
/"

Available parameters depend on the data in the selected file and
the format being created.

When converting from/to a Field Software Job file, the following
parameters are available:

1. Convert coordinate system (see “Convert Coordinate Type and
System” on page 5-6)
Convert height (see “Convert Height” on page 5-8)

3. Convert coordinate order (see “Convert Coordinate Order” on
page 5-9)

4. Convert metric unit (see “Convert Metric Unit” on page 5-9)

5. Convert angular unit (see “Convert Angular Unit” on page 5-10)

6. Convert vertical angle (see““Convert Vertical Angle” on page 5-
10)

7. Convert distance format (see““Convert Distance Format™ on
page 5-11)

X-Section Template File Conversion
Parameters
A cross-section template file contains information used for creating a

road. Table 5-12 lists the formats that a cross-section template file can
be converted to/from.

Table 5-12. X-Section Template File Conversion Formats

From a... To a...
X-Section Template file X-Section Template file
Field Software Job file
Field Software Job file X-Section Template file
If the Field Software file contains cross-
section data.
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When converting from/to X-section Template file, the user can select
only the Convert metric unit option (see “Convert Metric Unit” on
page 5-9).

Adding a Custom Projection

A projection contains pre-defined transformation data that is used for
conversions between local and global positions. While Topcon Link
includes a number of pre-defined projections, a custom projection
may be needed for your job site or geographical area. Custom
projections are included in the projection list.

1. On the Convert Files dialog box, click Custom next to the
Projection selection box.

2. Click Add.

kA Custom Projections List

Figure 5-6. Custom Projections List

3. Enter a name for the new projection.

Select the type of projection and edit the parameters to create a
custom projection. See Table 5-13 on page 5-39 for details and a
description of editable parameters for each projection type.

5. Set remaining information for the custom projection.
6. Enter a region for the projection (for example: USA)

Enter any applicable notes, such as the projection used (for
example: CA, Zone 5)
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8. Select the datum for the projection

kA New Contom Projection : Projection None '7&[
(=
Nave Ny New Proction 4—
Prawcton Tipe :'I.’J»N:OVM'IA’( -l
e Vohe
Cavtr o rrihan 0000000
<. ts
L2 2*0000. 000
Ca3 (m) =
N0 (m)
—
Name | Region | Datum | Note | Projection Type
My NewProje... CA WGSS4  Mynotes  Transverse-Mercator
< > |
Flagow A
My rotad
Nato
Qo [wisas -l
o | I Corcel | PRSI

Figure 5-7. Enter Custom Projection Parameters — Example

9. Click Apply to set the information, then Ok to add the projection
to the list of custom projections.
10. Click Close to exit the custom datum function.

The following table (Table 5-13 on page 5-39) describes projection
types and lists the parameters available for creating a custom
projection. A map projection is a systematic representation of all or
part of the surface of a round body (the Earth) on a plane. Each
projection is specified using a particular set of parameters and can be
used for different territories or customized uses.
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Table 5-13. Projection Types

Projection Type and Editable Settings

Examples (With Defaults)

Transverse-Mercator

A cylindrical projection of the Earth
rotated at 90° relative to the equator.
This projection creates little distortion of
scale where the projected surface is
tangent to the sphere representing the
Earth. This projection is useful in areas
of narrow longitudinal range.

T New Cuntem Prejection : Projectisn None

M5 New Promcton,

('m‘\:\«:nduwirl i

Lambert

A conic conformal projection of the
Earth. This projection is useful in areas
with a predominant east-west expanse.

KA New Centen Prejection : Projection Nepe

Gararal |

Yare My Now Proyacton, <‘
I

Praecton Type
Ko

South Lot
Poorh Lt
Lo QRO000. 000
Latd GO0, 000
Eamd (m) )

| ol () )

{Lanben =l

| Ve
0000000
00000, 0004

Double Stereographic

A spherical projection of the Earth first
on conformal sphere, then on a plane,
from a single point. This projection
provides a perspective view while
conformally mapping a sphere onto a
plane. This projection is useful in single
hemispheres.

L4 New Contem Projection : Projection None

My New Promcton,

| Cotle Srmogaghe |

[vahm
00000 000
000, 000

+

Stereographic

A spherical projection of the Earth on a
plane from a single point. This
projection conformally maps shapes and
angles, but creates areal distortion
farther from the projection point. This
projection is useful in single
hemispheres.

T4 New Centem Prejection ; Projectisn Nene RPX
Ganarad |

Nava W3 New Proyactor, |

Fromcnon Tice [Sursogschc =l
Nove | vohue
Lo 0400700000
Lar0 0400700.000
P [
Eact3 (m)
| N ()
|
e s |
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Table 5-13. Projection Types (Continued)

Projection Type and Editable Settings

Examples (With Defaults)

Oblique Mercator

A cylindrical projection of the Earth
rotated at some angle relative to a central
line. This projection creates little
distortion of scale where the projected
surface is tangent to the sphere
representing the Earth. This projection is
useful in areas that are oblique from a
other Mercator projections, that is an
area predominantly neither east-west nor
north-south.

A New Centeen Projection : Projection Nane  [2 K]
Nave My New Promcton ‘
Prawction Tipe Othue Marcalor =i
— s

0000, 000

Albers Equal Area

A conical, equal area projection of an
area that uses two standard parallels to
minimize distortion. This projection
creates little distortion of angle and scale
between two parallel lines. This
projection is useful in equal-area,
predominantly east-west regions.

[ New Centemn Projection : Projectisn Nane il 3]

Garmral
Nave 5 New Promcton, |
Fraecwn Tipe | Aens € qual Asea -
N | v
South et @000, 000
P Lt

0000, 000N

Cassini-Soldner

A cylindrical, equidistant
projection of the Earth rotated at
90° along the central meridian
with lines plotted along an X,Y
graph. This projection creates
little distortion of scale along the
meridian and lines perpendicular
to the meridian. This projection
is useful in simple mappings.

& New Centem Prejection : Projectisn None

carmcal
Noare My New Promcton |
|
Fraecmn Tipe [ Canzire S cldres =
howie ™
Leto 0000, 000
(B 000, 000

0000 000
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Adding a Custom Datum

While Topcon Link includes a number of pre-defined datums from
around the world, a custom datum may be needed for your particular
jobsite or geographical area. Custom datums are included in the
datum list.

1. On the Convert Files dialog box, click Custom next to the Datum
selection box.

2. Click Add.

%A Custom Datums List

Name | Note | Elpsod DX (m}

A \ R
dd { N emove ’ Close

Figure 5-8. Custom Datums List

3. Set the following information for the new datum:
e enter the new datum name
* select the ellipsoid used for the datum

* enter the DX, DY, DZ values for the ellipsoid’s shift
parameters (the default values are zero)

* enter the RX, RY, RZ values for the ellipsoid’s angle rotation
parameters (the default values are zero)

* enter the Scale by which to adjust the ellipsoid (the default
value is zero)

* enter any identifying notes for the datum

<

The shifts, rotations and scale parameters specify a coordinate
transformation from the newly created reference datum to WGS84
according to the following equation:

X| D P 1 RZ -RY|
Y| = |py|+(1+S8cale-10 )-|_rz 1 RX|'|Yl
ZWGS—84 DZ RY -RX 1 Znew—datum
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Cmrmial i §
Noave CA
14 R WS B4 -
0 i
Y
02 i
B 15
gy 15
en s
Scale lppe 115
[V Now Dot

Noe

¢ I Coedl | Aok (e

ﬁ Custom Datums List

Nave | Note | Elpsod | DX(m)| Dv(m)| 0z(m)| Rx()| RY(D]
® ca myn. WGS84  3.0000 3.0000 3.0000 15.. 1.5.
<

Add Remove J

Figure 5-9. Enter Custom Datum Parameters

4. Click Apply to set the information, then Ok to add the datum to

the list of custom datums.

5. Click Close to exit the custom datum function.

About Grid->Ground

Parameters

A ground projection is a grid mapping projection re-scaled, rotated
and shifted to convert point coordinates to another reference surface
(up to average project elevation) to produce near ground values. To
set a grid-to-ground transformation, Topcon Link rotates the ground
system relative to the origin of the grid coordinate system.

1. To enter grid->ground parameters, enable the corresponding
check box and click the browse button.

Set the scale factor using one of the following methods:

* Select Avg. Job Height. Then enter an average height from all
points in the job and enter the value of the Map Scale Factor.

* Select Scale Factor. Then enter the value of the Map Scale

Factor.
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Enter the northing and easting offsets in meters from the origin of
the grid coordinate system.

4. Enter the azimuth rotation angle in degrees/minutes/seconds
between the grid and ground coordinate systems. This angle
defines the reference direction for ground azimuths.

5. Click Ok.

B Grid-»Ground Parameters 70 : B Grid-»Ground Parameters
Scam Fachex Scam Factoe
20vg b Heght =l S Facce >~
Avg Job Heght I (823 ) 2ovg ob Heght i) [0 —
Scate Fac | Scale Fackr 5]
MuprgSede 1 MaprgSce 1
Moty Ot bng (5 Netheg Dot i) (5
Camrg Ot} [5 (g Ot [5
Aseuh Rotaten 571500 0000 Aswuh Flotston (5701500 0000
[T Cocel | o e Carel

Figure 5-10. Enter Grid->Ground Parameters
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Notes:
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Chapter 6

Editing Data in Topcon
Link

After opening a file in Topcon Link, you may want to edit some data
before saving it for post-processing or exporting it to a device. The
following list describes just some of the edits you can perform to
prepare data for other activities.

* Add a point
Edit/add a GPS antenna

* Assign photo notes

Edit codes/attributes and layers
 Edit lineworks parameters
» Edit total station observation offsets

* Edit horizontal/vertical alignments and X-sections of the opened
road

Because many editing activities are similar, the sections in this
chapter are set up to provide editing details based on data tables.

Editing Points

Among other editing activities, Topcon Link can be used to edit
coordinates or point names, delete a measurement taken for another
point, edit or enter the antenna height.
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Add a Point

1. Open a file (excepting a GPS+ Raw Data file)
2. Click Edit » Add » Point (or click Add Point on the toolbar).
3. Enter a new name for the point.
4. Edit other parameters as needed. See “Edit in the Point Properties

Dialog Box” on page 6-3 for more details.
5. Click Apply to save the new point. Click Ok to exit.

The new point is added to the end of point listing.

Add Point : Pebet Usar1 licdl: ]
Gomaral | Cocrdrwtns | Godes nd e |

Figure 6-1. Edit New Point Parameters

If the user added a point with a code into a Field Software Jobs file,
the CAD View displays this point:

ound Casting

ol 500,000

Devation (m) © Code Phots

1000 ®

Figure 6-2. Points tab and Cad View

Topcon Link Reference Manual

6-2



Editing Points

Edit on the Points Tab

You can edit all fields directly on the Points tab except the Icon and
Photo Notes. Click-pause-click to access editable fields. Figure 6-3
shows an example of editing fields on the Points tab.

I -
MH ] o
|[Basez-rer [eees | L \"CODE
FMETEN T
sRelisun e /[ 5 )-8 Ol |k

il
1
i
|

.....

-
2EEE
~2R233¢

" Wler  OMS Gwud | SODONG P

Figure 6-3. Editable Fields on the Points Tab — Example

Edit in the Point Properties Dialog
Box

The available property tabs depend on the information in the file. For
example, the Offset tab is only available if a point-to-line offset was
measured.

NOTE
-

If the file currently lacks the data being edited in the Properties
dialog box, Topcon Link will ask to save to another format before
continuing.

1. To edit a point’s properties, double-click the desired point.
2. Edit the point’s general properties:

* Name - the name of the point
* Note — any notes associated with the point

* Code — the code of the point
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3. Edit the point’s coordinates (Latitude\Northing,
Longitude\Easting and Elevation).

* Piopesties : Point occ

Ganaral | Cocedeates | Codes and Stre
Noare focc - 3

B —— * Propertses : Point occ
Nre Goverd  Coordinabes | Codes wnd ke

Gourd
Cortol [Poorw Grord Nostwrg i [500
Code | Stanon GondEmtrglal [0
Souce 1 Erevation nf A
o Cancel rgdy
o | Cancel I

Figure 6-4. Edit General and Coordinate Properties

4. Edit the point’s CAD information. The user can edit the data in
the following field: Code, String, Control Code and Control
Code2, Color and Point Symbol.

Properties : Paint 500

Gorwrdl | Coordeates | Photohctes  Codes and Style
Code:

»

Conte bl Srg Tll"-;-le
! } e el
.

v
[
" fiame 0
.

< ? |
Skirg e
Cortvol Code lv-;pir‘ ) .
Cortrol Codle 2 | -

Cok |
Port Symbel A M

I N

Figure 6-5. Edit CAD and Style Properties

The Photo Notes tab is available only for points of Field Software
Jobs. The user can select a desired photo note from the list, or
add/remove a photo note for the point. (The user can add *.jpg or
* bmp files of type).
* To add a photo note, click Add Photo Note. Browse for and
select the desired photo, click Open. The photo is added to

the list, in the order added, and automatically applied to the
point.
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* To delete a photo note, select the photo from the list and click

Remove Photo Note.

& .meqnhmié

Phato Nt Nunber

A1 Pheks Hoks |

oK

Propertses : Point 500

Figure 6-6. Edit Photo Note and Offset Properties

For PTL (point to line) points, edit the point’s offset. To obtain

new coordinates of the point after editing offset parameters, need
click Calculate Coordinates. See (‘“About Editing Offsets in
Topcon Link” on page 6-53) for more details

Properties : Point ptl1

Geverd | Comdoses Offuet | Protonotes |

Ottant Ot j) s

Codes and Sty |

Dftpet M g fi
Offset Acsats bel )
Fram Port [e32
To o
Hepe n
= Relove

=]

Corcad ANew I

Figure 6-7. Edit Offsets for the PTL point

7. Click Apply to save the changes. Click OK to exit.
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Editing GPS Occupations

Among other editing activities, Topcon Link can be used to edit the
height of the antenna and the point name, associated with the
occupation. A custom antenna can also be created and applied to an
occupation.

Edit on the GPS Occupations Tab

You can edit the Point Name, Antenna Type/Height/Height Method,
and Note fields directly on the GPS Occupations tab. Click-pause-
click to access editable fields. Figure 6-8 shows an example of editing
fields on the GPS Occupations tab.

|4,_* HiPer Lite/Lit |

4" Mone
=4 Topcon
~ |
4" Regency-Si [
& TOPFZL10 Test| T |
& Mare...
o -
Fle EM Vew ASS Process Window Melp
FEHd 35U 6 - X “ A A ™ | R
R -
o Ports 02 GPS Occwpations | o Gt | § Codes |

Figure 6-8. Editable Fields on the GPS Occupations Tab — Example
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Editing GPS Occupations

Edit in the GPS Occupations
Properties Dialog Box

The available property tabs depend on the information in the file. For
example, the Offset tab is only available if a line with known azimuth
offset was measured.

NOTE
/"

Note the following restrictions when editing a GPS occupation:

- If making changes to a GPS occupation in a Field Software
Jobs, the file must be saved to the same file format.

- If the RTK base station does not have any information about the
antenna, Topcon Link will recalculate the coordinates of the
rovers points from the phase center of the base antenna. In the
given case, after clicking Compute Coordinate, the following
message appears:

Topcon Link

(] There is no antenna information For some of the RTK Bases
. Phase center coordinates will be used to compute rover positions

1. To edit a GPS occupation’s properties, double-click the desired
occupation.

2. Edit the GPS occupation’s general properties. The Point Name
and Note can be edited.
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3. Edit the GPS occupation’s antenna. To create/edit a custom
antenna type, see “Add a Custom GPS Antenna” on page 6-9.

* Propersties : GPS Occupation Start_Pt * Proporties : GPS Dccupation Stan Pt
Gonmrl | Ocopuon | Atera | Offset | Gerers | Oxougetion  Antaena | Offset |
CoMne fSa POMR ] Boterens Tyoe | ¥ GR3 '| Cuntiom

Dognal N St P
r Avtsrra Meght vl (206

Mate At Maght Nethod  Verscdl A
Metring Togo

St Teve 2200 0T a

S0 T 12122007 W 48

Dursbons TGl

'culc««]m] [ o ] e | s
Figure 6-9. Edit General Coordinate Properties

4. Edit the GPS occupation’s offsets. See (“About Editing Offsets in
Topcon Link” on page 6-53) for more details.

=
* Propesties : GPS Occupation Start_Pt 77X

Geverd | Ocopon | Aewa  Offset |
et Dt 5

Ot Wt h) e

O set Acvons w

[ [« 8 l Carcnl

Figure 6-10. Edit Offset Properties
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5. View information for the occupation (the number of epochs, the
record interval, the GPS week and day of the occupation start

time):
* Properties - GPS Occupation tepo Elg
Sererd  Ocoupation : Aterva | Offset |
NEpoch 10
s oo
GFS weook_day 1457 348
Slacana WL SNAR

Figure 6-11. View Occupation Properties

6. Click Apply to save the changes. Click OK to exit

Add a Custom GPS Antenna

Each antenna type has unique phase center parameters obtained
through factory calibration. These parameters are not viewable nor
editable, but a custom antenna can be added to the Topcon Link list of
antennas. You will need the measurements (calibrations) shown in
Figure 6-12 to properly add a custom antenna and ensure correct
coordinate computations.
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Phase Center (L1/L2) Ny _ Antenna Radius

N

A

<

A A
T Teuez / =
A\ \
L

T
A1/A2

"~ Antenna Reference Point
(ARP, Base of Antenna)

)

%
)
%

Vertical Height

_-Survey Point or Marker

.
.

Figure 6-12. Determining Antenna Parameters

1. Measure or record the antenna’s offset parameters as shown in
Figure 6-12.

To add a custom antenna, double-click a GPS occupation.
3. On the Antenna tab, click Custom. Then click Add.

* Properties : GPS Occopation GKPTY
Gererd  Antmena | Offset
i M - |
Reterea Type :m,’. Coustom. . »
i3

Arterna Heght ISH 5 552

At Hoght Matod  [Vemcal

N
e s |

Figure 6-13. Add Custom Antenna

4. Enter the NGS name for the antenna and the display name for
Topcon Link. NGS (National Geodetic Services) provides a
common database for distributing official antenna designators
and offset measurements.
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5. Enter the measured offsets for the antenna and select the method
used to measure the height.

* New Centomn Antenna r'} ’;

* New Centom Antenna

E R — TR L e
My custom arberra Facdhas (e 0

LY Bae oiegdl)ived (05
L2Bace et mey  [OF
LI Plane ool Jw) [02
L2 Plare st fom)  [05
L2 Eavting ofvetE 1) bww) (02
L2 Easing oot 2} o) |

L1 Noshing aftieth 1) joen) [0

ox I Carcel J L2 Nt ftsetN2) o) [
el

Mot Netod  |Veta <]

ok I | Cace _] ey

Figure 6-14. Enter General and Offset Parameters

6. Enter the PCV values. These values represent the antenna phase
center variations.

7. Click OK to save the custom antenna and exit.

* New Centom Antenna

Gorerdl | Parameters POV
POV.GP5 L1 ey POV, G55 L2 (e
i w | v | o
s T LA ] [ B
w | & [ w | g
| o | & [
w [ w | o o
| A | b3 = [
w | w [ w | ar
» | & [ » | =
o | w | | W
s | [

ok [ Corcel _] Rocky

Figure 6-15. Enter PCV Parameters
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To edit a custom antenna, double-click the antenna on the antenna in
the custom antenna list. The antenna’s properties dialog box displays.

Iﬂi Custom Antennas List

Icon | NG5 Name | Name | Radus (mm) | L1 Base offsat{A1) (mm) | L2 Ba:
Cust_Ant  Ant... 0.4 05

Add | Remove Close

Figure 6-16. Custom Antennas

Editing TS Observations

Among other editing activities, Topcon Link can be used to edit the
height of the reflector, the number of the observation, the point the
observation was made to. You can also apply sting and control code
values to the observation.

Edit on the TS Observations Tab

In the left panel, you can edit all fields except the Icon directly on the
TS Observations tab. In the right panel, you can only edit the
following fields: Point To, Type of measured point (except BKB

points), Azimuth (only for BKB points measured from the point with
unknown coordinates), Reflector Height, Note, String and Control
Code, Offsets, etc.—directly on the TS Observations tab. Click-pause-
click to access editable fields. Figure 6-17 shows an example of
editing fields on the 7'S Observations tab.
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W Topeon Link

Fle Ede Veew ASI) Process Widow Hep
L ) W vias

W D:\CHUS TRAV.0 v = TopSURY PC Job »

Figure 6-17. Editable Fields on the TS Observations Tab — Example

Edit in the TS Observations
Properties Dialog Box

The available property tabs depend on the information in the file and
in the selected observation. For example, the Image tab is only
available if an image is associated with the observation.

Edit Left Panel TS Obs Properties
1. To edit a TS observation’s left panel properties, double-click the
desired observation in the left panel.

2. [Edit the TS observation’s general properties (point name,
instrument height, order number).

+ Properties : TS Occupation 1.27
General |
Poirt Name [

Instrument Height (USH) [5.18
# n

Figure 6-18. Edit General Properties for the Left Panel
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Edit Right Panel TS Obs Properties

1. To edit a TS observation’s right panel properties, select the
observation in the left panel then double-click the desired
measurement in the right panel.

2. Edit the TS observation’s general properties. The following
information can be edited in the General tab: Note, Code, String
and Control Code.

* Propesties - TS Obs 1.0¢c-8,101 id! 3
Chservotin  Gomersd | Cffset | Adustwert | Ieage
Port Froes oos
s 9
o 1203 wed
REL
Owe
Code e vl
Stng 1
Conteol Code | = |
o I Corcel Ak

Figure 6-19. Edit General Properties

3. Edit data in the Observation tab. The following information can
be edited:

¢ Point To,

* Type of measured point for side shot point (SS), backsight
point (the previous occupation point) (BS), foresight point
(the next occupation point) (FS), Horizontal/Vertical
Resection/Resection points,

* Azimuth only for backsight bearing point (BKB)
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« Propesties - TS Obs 1.0cc-8,101

Obrmrvation | Gerers | corset Achstwert | Irage
W

Port Te -
Pafteckx Maght () [1.45

Hudortsl Cocle 1070000, 0000

Shope Datarce bv) ")

Vercal Argle 0000 0000

Huoores Dutnce i) 120
Verical Ontance ju] 10
Exchade
Haorortal Cocle
I~ Vercel Arghe
Skge Datance

o | Gl | oo |

Figure 6-20. Edit Observation Properties

4. Edit the TS observation’s offset properties. See (“About Editing
Offsets in Topcon Link” on page 6-53) for more details.

* Propertios : TS 0bs 1,0cc-8.101

Otserestion | Generdl  Offset | Adpsawert | nage |

Otant Along (w4 &7

Offset Acroia ) 2 1
Otzer 4 (2 o5y

Oftses Tyoe [Faoen Dbeers omin Lre

Fecly

=

Figure 6-21. Edit Offset Properties

5. View the image(s) associated with the observation measurement
in the Image tab.

6. View the residuals for observations after calculating coordinates
in the Adjustment tab. Non-zero values of the residuals will be
presented for repeated or redundant measurements.
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® Properties : TS O%s 1.A-79.17

Otsereston | Gererd | Offset | Adustwert  1mage |

15 Ots 1.A- 2117

Observation | Gerersl | Offset  Adpntmmet | Deage
[oo0
[rooe 000
[
[oom s
it s
[o00

o \
om0

[ x | o~ | |

Figure 6-22. View Image and Adjustment Properties

Editing GPS Observations

Since GPS observations are based on GPS occupation measurements,
the user can select/add antenna parameters for the base and the rover
stations of the observation and can edit notes for the observation. To
edit an occupation, see “Editing GPS Occupations” on page 6-6.

Edit on the GPS Observations Tab

You can only edit the Note field directly on the GPS Observations
tab. All other fields are static in this tab. Click-pause-click to access
editable fields. Figure 6-17 shows an example of editing this field on
the GPS Observations tab.
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A Topeon Link

B View AdS Process Wiedow Help
L 33N S

SPCZ.tky < TopSURY PC Job »

& Fsocomons o sobs | § Codes |

(t[portteom  [porets i T -
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Figure 6-23. Editable Field on the GPS Observations Tab — Example

Edit and View in the GPS
Observations Properties Dialog Box

The antenna parameters for the base and the rover stations and the
notes associated with a GPS observation can be changed; all other
fields are informational.

1. To edit a GPS observation’s properties, double-click the desired
observation.
2. Asneeded, edit the GPS observation’s note in the General tab.

# Propertios : GF'S Obs Basel P12

General | Gualty | Clmerveton | Sase Arterens | hover Acterrs |
Port From T e e
Part To 2
i Powd_A34

Ncke i
S Twe NZ12.207 1090 &3
Dussion jo00es
Sp Tw N2122000 1008 %8
GPS wesk day 1480 385
Mathod ATK Toge

| o I Corcel | Ak |

Figure 6-24. Edit General Properties
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3. Asneeded, edit the antenna parameters for the base/rover stations
in the corresponding tab:

Gererd Qa*_\r__]__(f?f;w Base Antoona | Bover Acterna |

N I 2 Cusom
AmercaMagtind 177 Gorerel | Quaty | Otservation | Base Awewa  Raver Asterna |
AeHeghtNetod  [Vercy MbewaTpe |+ GR3 > Cusom

Vetc s

_lmmuqﬂm 20

At Hoght Metod  [Vercs B

_ow | cwce | sock

Figure 6-25. Edit Antenna Parameters

4. View the quality information about the observation measurement
in the Quality tab (Precision, RTK Solution Type, Number of
epochs, the common number of SV’s observed by the base and
rover in the last common epoch, the horizontal/vertical/total
position dilution of precision in the last common epoch for RTK
observation).

5. View the GPS observations solution components in the
Observation tab.

* Properties - GPS 085 Basel P12 2 %)
Gormeal  Qualty | Ctosrvation | Dae Arterea | Bover Acterna |
Havoores Precesn iwf 10080 3
2 * Propesties - GP'S Obs Basel P12 edle3
Verical Preceion g JO0C3 . s
Schaen Type FondPrace OF Gereral | Quiity Observation | Buse tewis | Rover Arteme |
- = pepes N S
£ Aee & ETTRE)
[ ] - ,”'” v
P B
GLONASS Sobsltes 2 SR
s Azwth N
FOOP [i&s sbeinalenian
e TR
HOOP T T HE':?‘HO
vooP 773 o) i3t
E 35 07
oK I Careed J & =y AsEs
— — i 37
J
[ os Cancet l Aok,

Figure 6-26. View Quality and Observation Properties
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Editing Digital Level
Observations

Among other editing activities, Topcon Link can be used to edit the
level run of an observation, the point, and the vertical offset. Figure 6-
27 shows typical observations taken with a digital level.

M- Traverse point s, N

%, ) f_‘
[] - SideShot . .
\ Wi N
\ -~ -

S oo FS

£
Oy -~
T,
¥ s
g,

Figure 6-27. Example Digital Level Observation

The DL Obs tab displays a table containing two panels. The left panel
displays the start and end level points of a job, and the right panel
displays all level measurements of the selected job.

P/N 7010-0522 6-19



Editing Data in Topcon Link

Edit on the DL Observations Tab

In the left panel, you can directly edit order, note, and level run fields
directly on the DL Observations tab. In the right panel, you can only
edit fields that correspond to available data — such as Point, Vertical
Offset, and Note—directly on the DL Observations tab. Click-pause-
click to access editable fields. Figure 6-28 shows an example of
editing fields on the DL Observations tab.

% 1 X

Fle Edt View AS] Process Widow Help

> o K i® . A& A 9 B R

Figure 6-28. Editable Fields on the DL Observations Tab — Example

Edit in the DL Observations
Properties Dialog Box

The available property tabs depend on the information in the file and
in the selected observation. For example, the Image tab is only
available if an image is associated with the observation

NOTE
-

If making changes to a digital level observation in a Field
Software Jobs, the file may be saved to a *.tlsv / *.tsj and *.dl/
* lev file format.

Topcon Link Reference Manual
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Edit Left Panel DL Obs Properties

1. To edit a DL observation’s left panel properties, double-click the
desired observation in the left panel.

2. Edit the DL observation’s general properties (level run name, note
and level run order).

 Properties : 0L Run 1,00111  [2)R)
Gevoral |
Level Run Lo}
Fooen fedin
o [
Owe [
Mo
s P |
Detwce el  [E0D
Bderco(w  [O05
o Concel ‘

Figure 6-29. Edit General Properties for the Left Panel

Edit Right Panel DL Obs Properties

1. To edit a DL observation’s right panel properties, select the
observation in the left panel then double-click the desired
measurement in the right panel.

2. Edit the DL observation’s general properties.

® Properthes : L Ofa 3 J0111-2.%

Ctoeresion  General | Adpeoment |

Lovel Fln g

)

Noke

Date LGRERIT LI

= |

Figure 6-30. Edit General Properties for the Right Panel
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3. Edit the Vertical offset and the measured point for the DL
observation in the Observation tab.

* Properthes : DL O%s 13011121 dlc3

Cbservation | Generd | Adpsawert |
Twwe |

Fort 1

W Moscaerrt jul  [1.42

Vet D¢see (o 0

Dearce md B3

Sad Dev Il

o I Canced

Figure 6-31. Edit Observation Properties

4. View the calculated elevation for the DL observation.

 Propartses : DL Obs 1. 30111-2.1 dl 3

Clsereston | Generd  Admistment |
Evwvation ind Ay

[ I Cancnd

Figure 6-32. View Elevation Adjustment Properties

Editing Codes

Among other editing activities, Topcon Link can be used to edit codes
and their attributes. New codes can also be created.

Edit on the Codes Tab

In the left panel, you can edit the code name (if this code is not used
for point(s) of the current job) and layer for this code fields directly
on the Codes tab; you can also add new codes and attributes to codes
(if this code is not used for point(s)) using the pop-up menu. In the
right panel, you can only edit the attribute name and default value
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fields directly on the Codes tab. Click-pause-click to access editable
fields. Figure 6-28 shows an example of editing fields on the Codes
tab.

ety [’ | L] Mtrbute ama ) | Otk Ve | Trie J
L Mere
fern Fraver N EAAER — 8 (53 lengh Real Nurber
Fre_tydrart AR I frAaER — 8
fiekd PAER — B
UAAVER ~—— 8

Figure 6-33. Editable Fields on the Codes Tab — Example

Add a Code

1. To add a code, right-click in the left panel and click New Code.
Enter a name and plotting style for the code. Click Ok to save

2. The new code is added to the bottom of the code list. For more
information, see “Edit in the Code or Attribute Properties Dialog
Box” on page 6-25.

W F:\code\Test_code_attribute_1.tsj <TopSURY 7 Job>

o Ports | 7 Lnes | O 15005 & Codes | Properties : Code New Code B]'g

L Nene | Description | Type | & tayer | Line Cokoe | Lne st General | Lre | Port | area |

o aa e o G BN VLAY

N
e T e
Fence, for woo...  Line ﬁ" Cubex . e Descaplion
o feld area PN e | o Tope Line -
® code tree ne ol e -
Layec K s
Propecties....
ased 0K ] Carcel | I
o Pomts | i Lnes | G TSCts § Codes
1 Nare | Description | Type “ Layw | Line Color e Sty v
. AR e 0 frave: B Stk — €
< frebyd Pore  Free tydant GrAvE: I SnAvER — €
o fence_. forwoo.. Lne  ferce saavER I SMAYER — €
* feld Aea  fed srave: B AR ——  E
~T5%0_5 e layer2 p==s] ]
* | New Code Une 0 fAAe: I AR —
Ry
Figure 6-34. Add New Code
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Add an Attribute

As many attributes can be assigned to a code as needed. Attributes
can be an integer, a real number, a text string, or selected from a
menu.

1. To add an attribute, right-click in the left panel, click New
Attribute, then select the type of attribute.

2. Enter a name and default value for the attribute. Click OK to save.

BA Spectoom Liok
Fle Ed Vew AS Process Wiediw Help

FEHS 35U & 0 X LA

W Fo\code\Test_code atiridete _1.15) ~TopSURY 7 Jab»
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1] Properties : Attribute New Attr...

o Ponts |27 Unes | O, 15006 & Codes
£l & N. |Cesopton| Type | Layer | Lire Color 1

G al

Atsbute Name  [Number

. AA Une 0 ENAVER
. T PRATTR
® code e Now Code : et U
. terce_.. o G EETTTE Type [integer
. feld o X Feal Nurder .
i ooy amc | Tet I_Requred

(v ] o ]

Spectrumn Link
Fle ESt Vew Add Process Window Melp

sdd 35N & v & W] 5| aA IR R

o Ports | % tees | O Ts0be 8 Codes |

Bl 4 Mae | Desrpton | fype  [iwve  ‘f1]AttréeNeme  |OWudvee [ Type  |Reqaed
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re lyee 2
Ready Meters | OMS  Ground | None

Figure 6-35. Add New Attribute
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Edit in the Code or Attribute
Properties Dialog Box

The property tabs create or edit a new code and assign plotting styles
to lines and points associated with that code.

Edit Left Panel Code Properties

1. To edit the properties for a code, double-click the desired code in
the left panel.

Edit the Code’s general properties (code name and layer).
3. Edit the Code’s plotting styles for line and points.
Click Ok to save.

Proparties : Code New Code  [2[X] Properties : Code New Code  [2|[X]
General | Plotting styles | General  Plotting styles
Code [NewCTodd J Lire Style [eAVER —————— |
Lager 0 =l Lrewidh  [8VAYER 1 ~
Color [aniaven -
Paint Symbol ;—B"V’U«':‘[R . _vl‘
0K I Cancel J 0K | Cancel

Figure 6-36. Edit Properties for the Code
Edit Right Panel Attribute Properties

1. To edit the attribute properties for a code, select the code in the
left panel then double-click the desired attribute in the right panel.
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2. For Integer, Real Number, Text, Boolean and Date attributes, edit
the name and default value properties.

BA Properties : Attribute Number rzlg

Gomul|

General | General |
Attribute Name [T Amibute Name B9
DefadtVaue |1 Delout Voo | 32172003 23610PM -
Type [irtager ! =
™ Requeed Type [Date
™ Requeed
o || :
S R S | | | ]

# Properties : Attribute age

Amibute Name  [gate

Defauk Voo > [

Type Bodiean O |5 B

 aaded & Properties : Attribute length r’][g] [Tea

e m.|| 4

Concf pmbote Nome [T

- DefoukVaie [ :' ol

Type [Real Number
[ Requred

oxlmal

|

Figure 6-37. Edit General Properties for Integer, Real Number, Text, Boolean and

Date Attributes

To add a value to a Menu attribute, type the value and click Add.
The value is saved in the file and with the attribute to be selected
for other attributes with the same name

All these dialog boxes contain the Required check box. This
parameter is used in the software for surveying. If it is set to
"Yes", the user will be asked to enter the attribute value every
time he (or she) uses the corresponding code. If it is set to "No",
the default attribute value will be used automatically. In Topcon
Link this parameter is used only for displaying attribute status for
the corresponding codes during data collection.
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5. To delete the value, select it and click delete.

Properties : Attribute type of w... EE

Genoral |
Arrbute Name  [RERE R
Defauk Value

Figure 6-38. Edit General Properties for a Menu Attribute

Editing Line

Among other editing activities, Topcon Link can be used to edit layer,
line type (line or area), and line segments.

Edit on the Line Tab

In the left panels, you can edit line type (Line/Area), plotting style for
line (Line Color/Line Style/Line Width/Area Color/Area Fill Style/
Fill Transparency), plotting style for point (Point Type/Point Color)
and select new layer directly on the Lines tab (Figure 6-39 on page 6-
28).

In the right panels, you can edit only the name of the line’s vertex
(Point field). Click-pause-click to access editable fields. Figure 6-39
shows an example of editing fields on the Lines tab.
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1 adeATest code amiiibate §.15) < TogSURY 7 Md
foe 1% e ” e b < CETRIE 2Pt te | Pwri o | Gkt Prrs | s i
- — R - s R rrsar Vo DR o
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v
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i
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The right panel
Icon | Order | Point | Distance from s... | Distance from p... | Entry azimuth | Exit azim
. 1 175°45'94, 12¢
z 114.529 114,829 175°45'44.1248"  314°00°00.000
3 115.248 0,419  314°00'00.0000" 43°00°'00.00(
4 258,243 144,000 43°0000.0000"  220°26'13.58
5 390.045 130,797  220°26'13.5674"

Line segments (in the right panel) can only be edited in the
Tabular view as shown above.

Edit and View in the Line Properties
Dialog Box

Only line information and plotting styles can be changed; all other
fields are informational.

Edit Left Panel Line Properties

1. To edit the properties for line, double-click the desired line in the
left panel.

Edit the line’s general properties and view its length.
3. Edit the line’s plotting styles.
View CoGo information.
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5. View and edit the photonotes of this line.

6. Click OK to save.

Properties - Line O o |
Motorctes  Une | Momegtdes | Codo |
7‘:'7( _';
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Line Wi, |oER e - —_
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Phetonetes | Lne | Plotting vies | Como |
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Figure 6-40. Edit Properties for the Line

Editing Tape Dimensions

Among other editing activities, Topcon Link can be used to edit start
and end points, tape distance, and point to for a tape dimension.

Tape dimensions are measurements of lines perpendicular to a
reference line. The reference line is defined using two points with
known coordinates. Figure 6-41 shows tape dimensions measured
from a reference line (between points 1 and 2).

P/N 7010-0522
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Latitude
1 100 e 2
55242'00,0"N —
55°41'59.0"M —_ 102 101
55°41'58.0"N —
B 103 104
55941'57.0'"N  —| 1105_. 106 , 1
- T T T | T T T T | T T T T | T T
37°33'55.0'E 37°3357.5'E 37°34'00.0'E

Figure 6-41. Example Tape Dimension Measurements — CAD View

Edit on the Tape Dimensions Tab

In the left panel, you can edit all fields, directly on the Tape
Dimensions tab. In the right panel, you can edit all fields, except the
Date, directly on the Tape Dimensions tab. Click-pause-click to
access editable fields. Figure 6-42 shows an example of editing fields
on the Tape Dimensions tab.

1
2

o° Ponts | o2 GPsOccupins N, Tape Obs | & Codes |

1] + Swtpont |endront  \|" _xc_o_n_‘i | gontto |/ Distance (m) | Date [ e |
B m [ | -10,000  3/30/2004 9:20:06 AM

a 20,000 3130{2004 9:20:16 AM

a 3 3 [ 20000 3{30{2004 9:20:23 AM

L) 4 4 20,000 3/30/2004 9:20:32 AM
¢ y ¢ >

Figure 6-42. Editable Fields on the Line Tab — Example

6-30 Topcon Link Reference Manual



Editing Tape Dimensions

Edit in the Tape Dimensions
Properties Dialog Box

Available tabs depend on the selected object, either a tape or a
dimension.

Edit Left Panel Tape Dimension Properties

1. To edit the properties for the tape dimension, double-click the
desired tape in the left panel.
Edit the tape dimension’s start and end point.

3. Click OK to save.

Properties : Tape Dimension Re... @@

General I
Start Point [100 ~|

End Point 2 -l

% | oo | |

Figure 6-43. Edit Properties for the Tape Dimension

Edit Right Panel Dimension Properties
1. To edit the properties for the dimension, double-click the desired
dimension in the right panel.

2. Edit the dimension’s general properties and view the date it was
measured.

3. Click OK to save.

« Properties : Tape Dimension 2 mm

General |
Port To [2 ~
Datancefm) |20 N
Date |3/30/2004 3:20:16 AM

il )2

Figure 6-44. Edit Properties for the Dimension
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Edit Image Properties

The Images tab displays when the file contains data associated with
captured images, such as data obtained using the GPT-70001 total
station.

Adding a photo note to data will also cause the Images tab to display.

=]
NOTE
'

Note the following restrictions when editing Images:

- Topcon Link expects images to reside in a folder with the same

name as the data file. For example, data from the “050119.tlsv”

filewillbeassociatedwithimagesinthe “050119 ”folder.

- The data file and image folder must reside in the same directory
for the images to display.

The Images tab contains thumbnails of images in the file in the left
panel and the selected image, with associated points and line, in the
right panel. Figure 6-42 shows an example of the fields on the Images
tab.

* A red cross indicates the point that the image is associated with.
* The currently selected point(s) is indicated with corner edges.

* The currently selected line(s) is highlighted.
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TPl Tt Vew Process Window b - X
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Figure 6-45. Viewing Images

While photo images cannot be edited, any points or lines associated

and displayed on the image in the right panel can be edited. Double-
clicking the point/line will open the corresponding Properties dialog
box. See the following sections for editing this data:

» “Edit Image Point Properties” on page 6-34
» “Edit Image Line Properties” on page 6-35
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View Image Properties

1. To view the properties for the image, double-click the desired
image in the left panel.

2. View the image’s general properties.
View a larger size of the image without associated points/line.
Click OK to exit.

w.

Noava l"l(l)
Pt o

o

[ o I . Carcel g

Figure 6-46. View Properties for the Image

Edit Image Point Properties

1. To view the properties for a point on an image, double-click the
point on the image in the right panel.

2. Edit desired fields as described in “Edit in the Point Properties
Dialog Box” on page 6-3.
3. View the image associated with the point.
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Edit Image Properties

Click Apply to save the changes. Click OK to exit.

* Properties : Peint 100

Garmeal | Comdrates | CAD | Sowg | Iweges | Pt
Name [id Gererdl | Cooedrates | CAD | Somg  Tmages | Photosetes |
Note
Code
Cormal Worm
e ]
o I Carcel ]
-

Figure 6-47. Edit Properties for Point on Image

Edit Image Line Properties

1.

To view the properties for a line on an image, double-click the
line on the image in the right panel.

Edit the line’s general properties (line or area type, ordered
sequence, layer assigned to). View the line’s code and its from/to
points.

Edit the line’s plotting styles.

Edit the control codes used to for the line View the string
assigned to the code.

Click Apply to save the changes. Click OK to exit.
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Figure 6-48. Edit Properties for Line on Image

Editing X-Section Templates

Among other editing activities, Topcon Link can be used to edit much
of the information associated with cross section template, including
the slopes, distances, and grades of the template items.

Edit on the X-Section Templates Tab

In the left panel, you can edit all fields, except the Icon, directly on
the X-Section Templates tab. In the right panel, you can edit all fields,
except the Icon and Hz/V Offset, directly on the X-Section Templates
tab. Click-pause-click to access editable fields. Figure 6-49 shows an
example of editing fields on the X-Section Templates tab.
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Figure 6-49. Editable Fields on the X-SEction Templates Tab — Example

Edit in the X-Section Templates
Properties Dialog Box

Much of the information associated with cross section templates can
be edited, except segment offsets.

Edit Left Panel X-Section Template Properties

1. To edit the properties for the x-section template, double-click the
desired template in the left panel.
Edit the x-section template’s name and cut/fill slopes.

3. Click Apply to save the changes. Click OK to exit.

Properties : X-Section Templat... @
General \
Narme |
CutSlope (1) [0
Fil Slope (1:n) 10

Figure 6-50. Edit Properties for the X-Section Template
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Edit Right Panel Segment Properties

1. To edit the properties for a segment of the cross section template,
double-click the desired segment in the right panel

You can also double-click the segment in the graph to open the
Properties dialog box.

2. Edit the segment’s order, horizontal/vertical distance, percentage
of grade, and code. View the horizontal/vertical offsets from the
centerline.

3. Click Apply to save the changes. Click OK to exit.

Properties - X-Section Sepment 3 3.3
Ganeral
Oacder [.‘
Mz Dwtimd h Fa k]
V. Dt b e
G (1) [1%%

He Offeet o 0L ) 55706
V. Ofast hore (L o [O101

Code { -
o

Figure 6-51. Edit Properties for a Segment of the X-Section Template

Editing Roads

Among other editing activities, Topcon Link can be used to edit
alignments of center line, cross-section information (for a road with
X-section) and string set that describe the parameters of the surface
road (for a road with String Set).

TopSURY version 8.0 and later allows one to create a road using one
of two following ways:

1. Through horizontal and vertical projections of the center line
(alignments) and lines representing the surface of the road and
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lying in the planes perpendicular to the center line (X-Section)
(see “Road with X-Section” on page A-30).

2. Through a set of several strings (String Set). Every separate
string in the set is defined by one or several pairs of the horizontal
and vertical alignments (see “Road with String Set” on page A-
35).

Using Topcon Link the customer can edit road with X-section and
road with String Set.

Editing Roads with X-Section

A road with X-section as an object can be described through the
horizontal and vertical projections of the center line, called
alignments, and the line describing the surface of the road and lying
in the plane perpendicular to the center line, called a cross section (x-
section). An alignment can be divided into sections, each of which
can be described using algebraic functions.

* The horizontal alignment can be described through lines, spirals,
curves and intersection points.

* The vertical alignment can be described through grade, parabola
and circular arc.

* The cross-section can be described using templates. (To edit the
templates for cross-sections, see “Editing X-Section Templates”
on page 6-36.)

1. To edit the properties for a road, double-click the desired road in

'
o AiH Cut Chrl+n

the left panel of the Roads tab: | o i
Delete Del

Properties...

2. Edit the name of the road, the coordinates of the start point, Start
Sta/Chainage and Stationing Stakeout Interval.
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3. Select a horizontal/vertical alignment and X-section from the list
of the used alignments/ X-sections in the given Field Software
job.

7 Propertses : Road COMVEYANCEZ

General | = 7 Properties : Road HIAA FOG

Name Fooad 50 Gererd  Abgnamct nases |

Stat Coordnates Hescords Algravert Name -1 <
S10n Pt [ T pra——— Nz =l
Nostwg (US) CoE XSeaton Set Name P st ~
Eastrg JUSH %130 -
Eeon 58] o

St Sta/Dnanage 15K o
Stakorng Shahocud ored 1USH) (20
Lapee fi

] o I =
| o I Carcel | s

Figure 6-52. Edit Properties for the Road

Edit on the Roads Tab

In the horizontal alignment panel, you can edit the following fields
directly on the Roads tab. Click-pause-click to access editable fields.

* order * tangential to * tangent
e azimuth previous element e mid ord
« length * spiral direction e external
* turn * delta * start degree chord
* start radius * chord * start degree curve
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Figure 6-53 shows an example of editing fields on the Roads tab,
horizontal alignment panel.

87319

o Points Roads If'\ \Sectmn Templates 1 & Codes ]

=4 £220-A12Grade! * | Icon | dder | Type Azimuth | Length\m) | Turn | Start Rad... ”nd Rad.., | horth, | East.., #
=0, orzortalal | 2y Line 60°57'59.0000 250.9
FE Table 2 Spiral 5 ... 60°57'59.0000 £6.39 Right &73.190
Graphic Curve 63°51'58,9963 624,177 | Right gzago0]  a73.190
2 &E’t‘;‘i‘:“g” e Spiral TS, 104°49'21,9835 88.392 Right 572,190 3
Graphic < ?
= B-Sections
FH Table

Figure 6-53. Editable Fields on the Roads Tab — Horizontal Alignment Example

* In the vertical alignment panel, you can edit only the Sta/
Chainage, Length, and Elevation fields directly on the Roads tab.
Click-pause-click to access editable fields. Figure 6-54 shows an
example of editing fields on the Roads tab, vertical alignment

panel.

| 2977285 ] I|48?.681T |i Izz=71

o FPoints Roads 1«"\ X-Sectio\Temp\ates I i Code\]
= 6220-B12Gradet * | Icon | Type ‘l StafChainage {m) | Ord& | Length {m) | Stark Grade (%) | End Grade (°r‘) ‘ Elewvation {m) | Radiu
L Horzontd A [Ty parab.., 25616949 1 0,000 0,000 0,00 478,866
ﬁ-“b'e_ (T Parab... 23870.168 2 304,801 -3.000 -1,500 351,269
Graphic |7y paggh,, 20772.550 B -1.500 4,500
S Veticaldion | py g 30047171 4 0.000 4,500 4,500 380,074
FH Table
Graphic A L
El u—\ X-Sections
FH Table
4 ?

Figure 6-54. Editable Fields on the Roads Tab — Vertical Alignment Example

In the x-sections panel, you can edit all fields, except the Icon,
directly on the Roads tab. Click-pause-click to access editable fields.
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Figure 6-55 shows an example of editing fields on the Roads tab, X-
Sections panel.

bEaa3.414
+” Paints Roads 1)"\ ¥-Sfction Templates I & Codes ] /
- €220-812Gradet * [ 1con | [tajChainage (m) | Side s
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FH Table
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- 26668,174
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26583.414

26683414

26074.854

Right
Left
Right
Left

Right

SE200L
88500R

Graphic
= i-Sections

FH Table

Hz, Offset from CL, m

Figure 6-55. Editable Fields on the Roads Tab — X-Sections Example

Edit in the Horizontal Alignment Properties
Dialog Box

The user can edit the type of element in the Properties dialog box.
The user can select the following horizontal element:

Type ‘ Line ﬂ

Intersection

If the current type of element is changed, the corresponding
Properties dialog box will be appeared for the selected element.

Edit Line Segment Properties

1. To edit the properties for a line segment, double-click the desired
segment in the horizontal alignment table

In the graph view, double-click the segment to open the
Properties dialog box.

2. View the end position for the line segment.
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3. Edit the general properties for the line segment.

» The tangential to previous element is unavailable if the first
segment is a line.

* Edit the type of element, the azimuth, order, and length as
needed.

4. Click Apply to save the changes. Click OK to exit.

Properties : Horz Element

General | Erd Position |
T [ [ ~]
08 -
Length m] [5a2

™ Tangentiasl to peev element
Gerersl EndPoslhon'

e | Azivsth (a5 2913
End Sta/Chainags (=) [9103

End Necthing (=) [-7.708 Cancal ‘

End Easting [m) 2227
End Aziush [21e2%7 2513

[ ] o] |

Figure 6-56. Edit Properties for a Line Segment in a Horizontal Alignment

Properties : Horz Element

Edit Curve Segment Properties

1. To edit the properties for a curve segment, double-click the
desired segment in the horizontal alignment table.

In the graph view, double-click the segment to open the
Properties dialog box

2. View the end position for the curve segment.
3. Edit the general properties for the curve segment.

* Select whether or not the segment is tangential to the
previous element.

 Edit the type of element.

Edit the azimuth and order of the curve segment.

Edit the length for the curve segment.

Edit the radius of the curve segment.
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4. Click Apply to save the changes. Click OK to exit.
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Figure 6-57. Edit Properties for a Curve Segment in a Horizontal Alignment

Edit Spiral Segment Properties

1.

To edit the properties for a spiral segment, double-click the

desired segment in the horizontal alignment table.

In the graph view, double-click the segment to open the

Properties dialog box

2. View the end position for the spiral alignment.

3. Edit the general properties for the spiral alignment.

* Select whether or not the segment is tangential to the

previous element.

Edit the type of element

Edit the azimuth and order of the spiral segment.

Edit the length and spiral constant for the spiral segment.
Edit the spiral direction.

* Edit the radius of the spiral segment.
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4. Click Apply to save the changes. Click OK to exit.
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Figure 6-58. Edit Properties for a Spiral Segment in a Horizontal Alignment

Edit in the Vertical Alignment Properties
Dialog Box

1. To edit the properties for the vertical alignment, double-click the
desired alignment in the vertical alignment table.

In the graph view, double-click the segment to open the
Properties dialog box

2. Edit the type of the alignment (Parabola Long Section and Arc
Long Section), alignment’s station/chainage, length/radius, and
elevation.
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3. Click Apply to save the changes. Click OK to exit.

Properties ; Vert Element RIX Properties : Vert Element
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Figure 6-59. Edit Properties for the Vertical Alignment

Edit in the X-Section Properties Dialog Box
Edit Template Properties

1. To edit the properties for the x-section template, double-click the
desired template in the X-Section table.
View the name of used x-section template for the road.

3. Click Apply to save the changes. Click OK to exit.

# Properties : X-Section Set C @@

General I

Name e |

oK I Cancel ‘ |

Figure 6-60. Edit Properties for the X-Section

Editing Roads with String Set

For a Field Software Job that contains a road with String Set, the
Roads tab displays two panels:

* the left - the name of every road in the job and the names
of components of the road,

* the right - in table and graphic view, parameters of horizontal and
vertical alignment of the center line, and string sets for the road
selected in the left panel.

The left panel contains a data tree with the following entries for each
road in the job.

» Horizontal alignment of the center line can be described through
lines, spirals, curves and intersection points
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* Vertical alignment of the center line can be described through
grade, parabola and circular arc

* String set can be described through set of the strings. Every road

string is described by the pair or pairs of the horizontal/vertical
alignments (HA-VA)

1. To edit the properties for a road, double-click the desired road in

Roads 1

= omman:

the left panel of the Roads tab: e
+ CEM
+ E/E Croy

Cut Chrl+n
Copy ChrlC
Delete Del

Properties...

2. In the General tab edit a name of the road, the starting station or
chainage for the road, the stationing stakeout interval in current
linear units, the layer in which to store the road, the working
corridor is set to use in the Road Stakeout.

7 Pioperties - Road Cormmon E@

Garmral | Bywert naves

Noave Comomon
St Cocadioaten

Stant Poet

Noateg vl SEEL

£anng () sk e
Ehevation ol 7]

Stat SaChanags () fo
Sistoreng Steheout inderval e [ 100
Lot Camdior Ofset )

Figre Comin Diaet ind e

- 1 :

coe

Figure 6-61. Edit Properties for the Road with String Set: General Tab

Note: Entering the working corridor values in Topcon Link does not
change the view of the road in this software. These values will be
applied only in TopSURV. There is the following rule for creating the
working corridor: the value of the left corridor offset has to be less or
equal to the value of the right corridor offset.

3. In the Alignment names tab select the desired alignment from the
list of pre-defined alignments for horizontal and/or vertical
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alignments, and select a road string set that describes the
parameters of the surface road.

H10
Gerer ol names H11
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Figure 6-62. Edit Properties for the Road with String Set: Alignment Names Tab

Edit horizontal/vertical alignments of center
line

All types of lines, curves, spirals, intersections, grades, parabola and
circular arks used for creating horizontal and vertical alignments of a
road with String set, are the same as used for alignments editing of a
road with X-section. See “Edit on the Roads Tab” on page 6-40 for
details.

Edit in the String Set Properties Dialog Box

The left panel of the Road tab displays the String Set configuration, as
set of the strings. Every road string is described by the pair or pairs of
the horizontal/vertical alignments (HA-VA). And every alignment is
editable:
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=) Common

+-"¢. CENT_Line-1 {Horizontal alignment)

+-[Im CENT_Line-1 (vertical alignment)
A2y G

ad String)
Sl HL - W1 (HA - va)
=-"¢. H1 (Horizontal alignment)
FEH Table
Graphic
=1-[Imy ¥1 {wertical alignment)
FEH Table
Graphic
e HE - Y2 (HA - VA)
e H3 - Y3 (HA - vA)
+ # 5% (Road String)

L. & GE {Daad Shinat

To edit any object of the road string set (road string, pair, alignment)

of the road, highlight this object and select the Properties from the
pop-up menu:

—|- " Comman

+-"¢, CENT_Line-1 (Horizontal alignment)
+- [ CEMT_Line-1 (vertical align
= g-1

= @ 51 (Road Skring)

Cuk Chrl+x
= & HL - %1 {HA - &) Copy Chrl+C
=-"¢., H1 (Horizontal ali  Delets el

FFH Table

Graphic

To delete any object of the road, select Delefe from the pop-up menu.
Each object of the road has different editable parameter(s):

kA Properties : Road String Set Na... @

* The name for the String Set: il

Name

[Clossing-1 l

| 0K I Cancel | [

General |
Name

Order

* The name and order for the string:
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* The horizontal and/or vertical alignment from the predifined list:

Caver ol
Maooreal Algreent Nave ?“‘

Ve ol Algrewend Hawe A1)

-

In the right panel of the Road tab, the user can delete and/or edit the
existing element. To perform any operation, right click the desired
elements and select the corresponding command from the pop-up

menu:

o Ports

T PMe Tt Vew Add Process Widke e
@ @ i u & X B
" Uoes Reods | § Codes |

PO - VIO - VA) ~ "licn | Oder

=4 (Road rng) 1
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Figure 6-63. Operations with Road Element
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When editing the existing element, the user can change any
parameters of this element and as well as type of the element:

' DegCuve [
' 7y ~o1 DeoChesd 1127530

- -
et [0 Deta
[T Tangeossl 1 peev sloment Orond i
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. |

Figure 6-64. Editing the Road Element Parameters

Topcon Link allows to save all changes which were entered in the
road with String Set and export this data to TopSURV and LandXML
file formats.

Editing Layers

Among other editing activities, Topcon Link can be used to edit the
layers in a file, including the layer name, line and point styles, and the
color to use for objects on the layer.

Edit on the Layers Tab

In the Layers screen, you can edit all fields directly on the screen.
Figure 6-65 shows an example of editing fields on the Layers tab.

# Layers : C;\Decuments and Settings\layer_33.1lsv

Powre [vatie [tresthyls |Unewidh | Colr | Port Symbol | Srestine Type | Note | Aveardyie | Pl Teaeparency
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Laverd [yes |l 1o — =l = | s v | for Poad-y ore - % -l
e Pore I”" — ~ 2 l Pocre [ Al
ree 1] PRp— . | — f
Scrr ey | o
—— {3t — o || o
------- {408 e B
St w— 1 I
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Ypr w— 6%
cot m— o
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Figure 6-65. Editable Fields on the Layers — Example
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Edit in the Layer Properties Dialog
Box

1. To edit the properties for the layer, double-click the desired layer

in the Layers screen.
2. Edit the general properties for the layer.
* The notes.
* Whether the layer is visible or not.
* The layer’s breakline type.
3. Edit the plotting styles for the layer.
* The line style and width.
* The color to use for lines and points.
* The point symbol.
4. Edit the following plotting information for the area:
* Select the area fill style in the corresponding field.

* The Fill Transparency field displays the value of an area's
transparency. Changing of this value does not affect

transparency of the area because this option does not work in

graphical mode in Topcon Link ver 7.3.
5. Click Apply to save the changes. Click OK to exit.

=~ Properties : Layer L1
General | Plotting styles

l 0K | Canced

o ] o

Neme
General  Plotting styles | e |
Note Coler | =~ Properties : Layer 0 ﬁ]ﬁ
o Lirm Style = = =4 Gormral | Piottiegstyles  Aroa
Breskine Type | Auto Lire \Wadh [ 2pt JAecaFasye | None L]l
¥ Vbl — r |
Port Symbol | " Fil Tranparercy | oy .]

oK I Canced

Figure 6-66. Edit Properties for the Layer
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About Editing Offsets in
Topcon Link

Using the associated Properties dialog box, you can edit the offsets
for TS or GPS measurements and for PTL (point to line) points.
Topcon Link recognizes offsets from an observation line, point-to-
line offsets, and offsets from a line with a known azimuth.

Offsets from an observation line in Total Station measurements

* Offset Along — the distance from the Prism Point to the projection
of the Offset Point along the line of sight

¢ Offset Across — the distance from the offset Point to the line of
sight, either to the left or to the right of the line

» Offset Height — the height difference from the prism point to the

offset point

* Properties - 15 Obs 1.CP_3.7. TRAVY

Gerwral | Observeton  Offset | Sy
Oftaet Nong Iw) {
O get Acnoat bed 25

Ofzet 3t ju)

Adyatrert. |

i)

o

r

e

Figure 6-67. Measuring/Editing Offsets From Observation Line
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Offsets from the reference line formed by reference points (point-to-
line offsets) in TS and GPS measurements

* From Point — the start point of the reference line (Point 1)
* To Point — the end point of the reference line (Point 2)

* Offset Dist — the distance along the reference line from the prism
or the rover GPS antenna point to the offset point

» Offset Across — the distance perpendicular to the reference line
from the prism or the rover GPS antenna point to the offset point

» Height is relative — the height difference from the prism point to
the offset point

» Height is absolute — the absolute height of the offset point

NOTE
-

Field Software Job sets only absolute elevation for a PTL point

Propesties - Polnt Of_1

Gorerel | Comedeates Offset | MhotoMctes | Codes and Stve |

Otzet Dest (o}
Ofeet Ht b}
Otaet Acroas ()
From Port Port 2 -l
ToPor T - |
Hewght &
* Reative
Abockie
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Figure 6-68. Measuring/Editing Offsets From Point-to-Line
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Offsets from a line with a known azimuth in TS and GPS
measurements

¢ Azimuth — offset line azimuth

» Offset Dist — the distance along the line with known azimuth from
the rover GPS antenna point to the offset point

* Offset Across — the distance perpendicular to the line with known
azimuth from the rover GPS antenna point to the offset point

» Offset Ht — the height difference from the rover GPS antenna to
the offset point

» Height is relative — the height difference from the prism point to
the offset point

» Height is absolute — the absolute height of the offset point
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Figure 6-69. Measuring/Editing Offsets From Observation Line
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Notes:
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Chapter 7

Working with Point
Data in Topcon Link

Topcon Link includes a function for working with point data:
computing coordinates of TS and GPS network.

Computing Point Coordinates
for Raw Data and Field
Software Files

Topcon Link allows computing point coordinates for raw data and
Field Software files.

Compute Coordinates

Note the following restrictions for coordinate computations:

P
=]
NOTE
Y

When editing data, coordinate computations (re-calculation) are
not automatic. You must manually select the Compute Coordinate
function

[WARNING )

If there is no antenna information (‘Antenna Type’ field is
empty) for Base RTK station, the phase center of the Base
station will be used to compute Rover positions.

For details on setting the parameters for computations, see “Set
Process Properties for Computations” on page 7-2.
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1. Open a raw data or Field Software file.
2. Click Process » Compute Coordinates.

Any new point coordinates are added and written to the file.

o Poits | O 15 0ts
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: 2.522 3611 0.731
12.017 3.756 -0.692
— 15,787 1,483 2.218
21.079 2,595 0.443
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Figure 7-1. Coordinate Calculation — Before and After Example

Set Process Properties for
Computations

Typically, the default parameters are sufficient for most coordinate
computations of TS network. In the Process Compute Coordinates
pane, the user can set distance and angle measurement errors to take
them into account when computing the coordinates of the station
using directions observed from the station to points of known
positions (resection method):

%2 Process properties

3= Process EDM 3 -3
E i«
15 Conputations. 1 oo rec) ‘i
VA Sigma. feec) o

Figure 7-2. Apply Coordinate Computation Parameters

1. Click TS Computations in the left pane and select the refraction
coefficient for total station observations.

The refraction coefficient corrects the vertical angle between the
earth’s curvature and refraction in the atmosphere.
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2. Click OK to save the settings.

12 Process properties
=T - Rehacton Coslicert
mpute Cocedne [ ()
= “ 014

€ 02

" Without Curvature

Figure 7-3. Apply Total Station Computation Parameters
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Notes:
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Chapter 8

Exporting Data Files to
a Topcon Device

Topcon Link provides a simple interface for exporting data files
directly to a Topcon device (instrument). Topcon Link exports any file
type to a hand-held controller, coordinate files to a total station.

Before you can export data to a total station, the device must first
be set up. See “Adding Devices” on page 2-1 for details.

This chapter discusses the steps to export data files to a connected
device.
* See “Exporting Files to a Mobile Device” on page 8-1.

» See “Exporting Files to a Total Station” on page 8-3.

Exporting Files to a Mobile
Device

The Topcon and Sokkia family of controller software (such as
TopSURYV and SSF survey application) run on several Topcon and
third-party mobile devices.

Topcon Link supports three formats of the Field Software Job files:

Field Software Jobs (¥ Esj* Hsw)
Spectrum Survey Field Job (*.tsj)
TopSURY 7 Job (*.tsj)

TopSURY PC Job {*.tsv)

» Spectrum Survey Field Job (*. tsj). This job is created in SSF
version 7.3 and later.
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* TopSURV 7 Job (*. tsj). This job is created in TopSURV version
7.0 and later.

* TopSURYV PC Job (*.tIsv). This job is created in TopSURV
version 6.11.03 and earlier

There is a difference in format of these files and a difference in using
these files in the computer’s software.

In TopSURY version 7.0 and later, the *.tsj file is saved on the
controller, that this file format can be opened by Topcon Link/
Spectrum Link/Topcon Tools/Sokkia Spectrum Office/TopSURYV PC.
Topcon Link is used only for transferring the *.tsj file from the
controller to the computer without format changes. Moreover, the
user can use a movable memory card to transfer the *.tsj file from the
controller to the computer.

In TopSURYV version 6.11.03 and earlier, the *.tsv file is saved on the
controller. But Topcon Link/Spectrum Link/Topcon Tools/Sokkia
Spectrum Office/TopSURV PC version can not open this file format.
Topcon Link has to convert mobile device-based formats to computer-
based formats. Topcon Link performs the conversion during the
import process the *.tsv file to the *.tlsv file. This format (*.tlsv) is
opened by Topcon Link/Spectrum Link/Topcon Tools/Sokkia
Spectrum Office/TopSURV PC.

When connecting to a CE-based device, Microsoft® ActiveSync
automatically starts up and connects with the device. This connection
is required to properly export files. If you need to install ActiveSync,
see “Installing Microsoft ActiveSync for Use With CE-based
Devices” on page 1-11 for details.

This section describes data export using the Topcon Link
interface. To use Windows® Explorer for data exporting, see
“Using Windows Explorer to Export Files to a Device” on
page 8-6.

1. Connect your controller and computer according to the
controller’s documentation.
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Note that a Bluetooth® connection requires that both devices
have Bluetooth wireless technology capabilities.

With Topcon Link open, click File » Import from Device.

3. In the right panel, double-click Mobile Device. Topcon Link
connects to the internal memory of the controller.

4. Navigate to the location in the controller’s memory in which data
files are saved. For example, Field Software Jobs are saved to the
TopSURV/SSF folder.

5. In the left pane, navigate to the folder on the computer in which
the file is saved.

6. Select the desired file(s) and click the Move Right button. The
file export progress displays.

Exporting Files to a Total
Station

The Topcon and Sokkia family of conventional and robotic Total
Stations have an internal data storage device to record data to in
various formats. Refer to your Total Station operator’s manual for
details on setup, operation, and connection with other devices.

When exporting files to a Topcon and Sokkia Total Station, Topcon
Link simply connects to the device and provides a path for the data
transfer. The actual file transfer is performed at the Total Station.

The connection procedure for Topcon and Sokkia Total Stations
varies, so refer to the device’s documentation for details.

When connecting to a CE-based device, Microsoft® ActiveSync
automatically starts up and connects with the device. This connection
is required to properly export files. If you need to install ActiveSync,
see “Installing Microsoft ActiveSync for Use With CE-based
Devices” on page 1-11 for details.

2=

NOTE

/"

This section describes data export using the Topcon Link
interface. 1o use Windows® Explorer for data exporting, see
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“Using Windows Explorer to Export Files to a Device” on
page 8-6.

1. Connect your computer and Total Station according to the
operator’s manual.
With Topcon Link open, click File » Export to Device.

3. In the left pane, navigate to the folder on the computer in which
the file is saved.

4. In the right pane, double-click Topcon Total Stations or Sokkia
Total Stations.

5. Double-click the desired device to connect with the Total Station.

6. Select the coordinate file to export and click the Move Right
button.
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For Topcon Total Station
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Figure 8-1. Export File to Topcon and Sokkia Total Station

7. Follow all steps listed in the Upload file(s) to Total Station dialog
box. These steps may vary depending on the connected device.
Click Start in Topcon Link to export the data and save it in the

Total Station.
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Using Windows Explorer to
Export Files to a Device

After installing Topcon Link, the computer’s hard disk contains up to
eight virtual drives for accessing Topcon and Sokkia devices to
import/export data. These virtual drives provide a quick way to
transfer data without opening Topcon Link. Many of the steps are the
same as for importing/exporting data via the Topcon Link interface.
See the corresponding section above for further details on the steps
listed in sections below.

Export to a Topcon and Sokkia Mobile Device using Windows
Explorer

1. Connect the controller to the computer. Connect to the controller
via ActiveSync.

On the computer, navigate to and copy the file(s) to export.

3. Navigate to the Mobile Devices device directory and click the
device icon.

4. Navigate to the TopSURYV or SSF folder and the desired job
file(s).
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5. Copy and paste, or drag-and-drop, the desired file(s) to the

controller.
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Figure 8-2. Export Using Explorer — Mobile Device

Export to a Topcon and Sokkia Total Station using Windows

Explorer

1. Connect the total station to the computer. If needed, connect to

the total station via ActiveSync.

export.

On the computer, navigate to and copy the coordinate file to

3. Navigate to the Topcon Total Stations or Sokkia Total Stations
device directory and click the device icon.

Click the icon for the connected total station.

5. Copy and paste, or drag-and-drop, the file to a directory on the

computer.
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6. Follow all instructions on the Upload file(s) to Total Station
dialog box.
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Figure 8-3. Export Using Windows Explorer — Sokkia Total Station
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Appendix A

Data Views Reference

Topcon Link can open three views to display file data: a tabular view,
CAD view, and layers view. Topcon Link displays CAD view only for
Field Software job file. When opening a coordinate file, or total
station raw data, or GPS + raw data, or digital level, or Field Software
job file, Topcon Link reads the file and displays an appropriate tab or
a set of tabs:

* Coordinate file — Points tab

* Total Station raw data file — Points and TS Obs tabs
* Digital Level file — Points and DL Obs tabs

* GPS+ raw data file - GPS Occupations tab

Field Software job tabs:
— Points tab, if the job contains points
— GPS Occupations, if the job contains GPS occupations
— TS Obs, if the job contains total station observations
— GPS Obs, if the job contains GPS observations
— Codes, if the job contains codes
— Linework, if the job contains linework
— Tap Dimensions, if the job contains tape measurements

— Images, if the job contains images (such as data obtained
using the GPS-7000i total station)

— X-Section Templates, if the job contains road data

— Roads, if the job contains road data

When viewing a Field Software job, the CAD view displays points
and linework, and a Layers view can be displayed if the job file
contains layers.
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Coordinate View

Coordinate files contain data on points taken with total station, digital
levels, or GPS receivers. The coordinate file data table contains only
one tab to display data. Because coordinate files do not store unit and
system information, you can select these settings using the advanced
options while opening or in the status bar.

For details on editing coordinate information, see “Edit in the Point
Properties Dialog Box” on page 6-3 (coordinate data can be contained
in TS, DL, or GPS measurements).

Points Tab

For coordinate files, the Points tab has the following default columns.
* Icon — the symbol used for the point
* Name — the name of the point

 Latitude\Northing — the measured northing coordinate for the
point and coordinate type

* Longitude\Easting — the measured Easting coordinate for the
point and coordinate type

* Elevation — the elevation of the point
* Note — any notes associated with the point

* Code — any codes associated with the point

«” Points l
L | Marme | Latitude | Longitude | Ell.Height: {m) | Code Moke
& BASEZ 4006 07.52051M 82 59 12,47055W 805,095  Base
& Cp2 4006 11.08726M 8259 16, 18572W 510,591
Fo e 4006 13, 122690 82 59 10,68572W 809,265
P 4006 07.23757M 82 59 06,52357W 807,545
& P 4006 05,22796M 5259 12,11935W 505,409 Base For T3
Meters Mone

Figure A-1. Coordinate File Data Table
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Icon Descriptions

Table A-1 lists the icons used to represent different information in the
data table.

Table A-1. Coordinate File Icons

Location Icon Description

Unknown point

Points Tab & Fixed coordinates point

Offset point (only for GTS-7 Points)

TS Observations View

Total Station observation files contain data on points and observations
taken with a total station instrument. The TS observations file data
table contains two tabs to display data. Because total station files do
not store system information, you can select these settings using the
advanced options while opening or in the status bar.

For details on editing total station observation information, see
“Editing TS Observations” on page 6-12.

Points Tab

For files which contain TS observations, the Points tab has the
following default columns:

* Icon — the symbol used for the point
* Name — the name of the point

* Latitude\Northing — the measured northing coordinate for the
point and coordinate type

* Longitude\Easting — the measured easting coordinate for the
point and coordinate type

* Elevation — the elevation of the point

* Code — any codes associated with the point
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Control — the coordinate fix of the point (None, Horizontal,
Vertical, Both)

Note — any notes associated with the point

B DATS Raw.txt «Topcen GTS-6 - TS Obs »

OO

10000000

o Poims | G TS0s |
on Nare v-:’mrd»::fn;n}rk;-: E (x '.“vl v . Code in:zrn:x I'o;rc :m- 1A
7501 0.000
501 40.5%0
3 1.140

o 3

Noew
hoee

oo
o0 12.3%0 heee
o3 0,280 e

o0 14940
o0s 31.8%0

= 2273

herm

Noew

Noew

Figure A-2. TS Obs File Data Table — Points Tab

TS Obs Tab

For raw files, which contain TS observations, the 7'S Obs tab has two
panels, the left for points with known coordinates, the right for points
with unknown coordinates measured from the point selected in the
left panel.

The left panel contains the following default columns:

Icon — the symbol of the point
# — the number of the point
Point Name — the name of the point

Instrument Height — the height of the instrument in the selected
units

Instrument Centering Error/ Reflector Centering Error - centering
error of Total Station/Reflector over the mark. This error will be
take into account when estimating adjustment results.

Instrument Height Error/Reflector Height Error - measurement
error of the Total Station/Reflector height over the mark. This
error will be take into account when estimating adjustment
results.

The right panel contains the following default columns:

Icon — the symbol of the point
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* # — the number of the point

* Point From — the beginning of the vector

* Point To — the end of the vector

» Reflector Height — the height of the reflector

* Azimuth, Horizontal Circle, Zenith Angle, Slope Distance —
angular and linear measurements in the selected units (DMS, qon,
mil, radian, ft, m)

* Note — any notes associated with the point

* Code — any code associated with the point

* Type — the type of point

— §8S: side shot point

— BS: backsight point (the previous occupation point)
— FS: foresight point (the next occupation point)

— BKB: backsight bearing point

— Center and Side: These two types of TS measurements are
created if the user selected Horizontal Angle Offset in the
Total Station or TopSURV/SSF software. The Center
measurement contains only horizontal angle to the target
(offset point), Side measurement contains: horizontal/vertical
angles and distance to the prism (see Figure A-3). Both
measurements (Center and Side) relate to one point. After
clicking Compute Coordinates, Topcon Link calculates the
coordinates of this point using both measurements:

* | 1con | # | Paint From | Paint To | Type | Harizontal Circle | Slope Distance ... | Zenith Angle
<, 83 13 3455 Side 349°59'52,0000" 7.930 §9°46'07,0000"
<, g4 13 3455 Center 345°59'13,0000" §9°46'20,0000"

Top View

Figure A-3. Example of Horizontal Angle Offset in Total Station or TopSURV/SSF
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— Vertical and Horz. Vertical: These two types of TS
measurements are created if the user selected Horizontal/
Vertical Angle Offset in the Total Station or TopSURV/SSF.
The Horz. Vertical measurement contains only angle
(horizontal/vertical) measurements to the target (offset point),
Vertical measurement contains horizontal/vertical angles and
distance to the reflector (see Figure A-4). Both measurements
(Vertical and Horz. Vertical) relate to one point. After clicking
Compute Coordinates, Topcon Link calculates the
coordinates of this point using both measurements

Icon | # | Paint From | Point To | Type | Harizontal Circle | Slope Distance ... | Zenith Angle
<, gz 30 307z Vertical 91°46'36,0000" 58,580 85°22'16,0000"
<, 83 30 307z Harz. Yertical 91°46'36,0000" TR205'25,0000"
o,
Py,

Top View ) prism  Front View Prism

ofset ponre

Figure A-4. Example of Horizontal/Vertical Angle Offset in Total Station or
TopSURV/SSF

— Horizontal Resection/Vertical Resection: plane / vertical
coordinates of station point are computed using
measurements from two (or more) points with known
coordinates
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— Resection: plane and vertical coordinates of station point are
computed using measurements from two (or more) points
with known coordinates

left panel

Ponts | 2" Lnes Q. TSObs | § Codes |

(L1 # | PortNume | inctrumert Heighe (USR) | Instrument Cartering Liree (U.., | inatrumark Mesght Liree (U, | Reflactir Hapt Ervoe (U.,. | Reflacter Centarng Errer (USR) |
AR o 530 0.000 0.007 0.005
& 2 oz 5590 0.000 0.000 0.007 0.008
09 oz 4% 0,000 000 0.007 0.005
Qe o 5.3 0.000 0.000 0.007 0.005
< s ws 564 0.000 0.000 0.007 0.005
right panel
o Ponks | Lnes O T50b¢ | § Codes
"licn |# | FontFrom |PortTo | Type | Mertronkal Crcle | Sope Distarce .. Zerkh hoghe | Reflector Meight (US) Azmugh|Dste | Code Miogle Resd... | A
5 1 = ) oo war Faron .
(0, 2 o1 Bs BP510.00007
L . >1 BIME0S,0000"
i -
< 6 o1 N
[+ » N UL
< L] o1 . NAL OMOUL0. 148

Icon Descriptions

Table A-2 lists the icons that represent different Topcon Link
parameters in the data table.

Table A-2. Total Station Raw Data File Icons

Location Icon Description
{} TS station
{I} TS point
Points Tab A Fixed coordinates point
u Fixed Horizontal control
n Fixed Vertical control
TS Obs Tab, Left {} TS station
Panel 4
{} ForeSight measurement
A
TS Obs Tab, Right {I} SideShot measurement
Panel ~
{} BackSight
A
P/N 7010-0522
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Table A-2. Total Station Raw Data File Icons (Continued)

Location Icon Description

TS Obs Tab, Right E@ BackSightBearing point measurement
Panel (Continued) |-~ A

":’ TS Resection Observation
A

GPS+ Raw Data View

GPS+ Raw Data file contains GPS/GLONASS code and carrier phase
measurements collected for point or points where was mounted a GPS
antenna. Topcon Link directly (that is using its own technique) opens
the following GPS+ raw data files:

e RINEX 2.11 and RINEX 3.0 is the version of standard format for
exchanging GPS Raw Data. For a static/kinematic observation(s)
2 or 3 files are created; the first usually having an extension
beginning with the letter ‘O’ and stores the observations; the
second usually has extensions beginning with the letter ‘N’ or
‘G’, depending on GPS/GLONASS capability, and stores GPS
and GLONASS navigational data (orbits) for those observations.

* Compact RINEX/Compact Rinex3 file (or a Hatanaka
compressed file) is the compression of RINEX 2.11 / RINEX 3.0
observation files. This file type contains a “D’ extension.

» TPS/JPS files are the raw data files logged by Topcon receivers.

* TPD files are a Topcon proprietary format for storing GPS raw
data, and can be used to backup raw data or exchange raw data
between different jobs.

» Sokkia PDC files are the new raw data files logged by Sokkia
receivers (GSR2600, GSR2700 and GSR1700)

» Sokkia Stratus files are the raw data files logged by Sokkia
Stratus receiver

Also Topcon Link allows the user to open native binary formats of
GPS receivers manufactured by Ashtech (B*.*, E*.*, S*.*), Leica
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Geosystems (*.1b2, *.mdb,*.m00), Trimble (*.dat), Septentrio
Satellite Navigation NV (*.sbf) companies. For opening these
formats, Topcon Link applies TEQC software (http://
facility.unavco.org/software/teqc/teqc.html).

When the user opens one of the above formats in Topcon Link, the
following scheme of converting the file begins to work automatically:

1. TEQC converts the native binary format to RINEX 2.11
file format.
2. The created RINEX file is opened by Topcon Link.

NOTE:

1. The current default setting for the TEQC allows opening only
static occupations (provided there is only one Marker Name in
the file for this occupation). In other words, it is impossible to
open kinematic and Stop&Go files of native formats of these
companies into Topcon Link.

2. When opening binary files of third-party companies, Topcon Link
uses default settings of the TEQC program. If a binary file failed
to be opened by Topcon Link, we recommend to repeat the
conversion to the RINEX file using own settings of TEQC (out of
the Topcon Link program) for the given binary file. After
obtaining an appropriate RINEX file, this file can be opened by
Topcon Link.

After opening a raw data file in Topcon Link, the GPS Occupations
tab displays all information about occupation(s), which the raw data
file contain.

GPS Occupations Tab

For a GPS+ raw data file, the GPS Occupations tab has the following
columns:

* Icon — displays a symbol associated with the occupation.
* Point Name — displays the name of the occupation.

* Original Name — displays the original occupation name.
* Antenna Type — the antenna type used on the occupation.
* Antenna Height — the antenna height.
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* Antenna Height Method — the method used to measure the
antenna height, either Vertical or Slant.

* Start Time and Stop Time — displays the beginning and end dates
(day/month/year) and starting and stopping epoch time of the
occupation.

¢ Duration — the duration of time in which the observational data
was acquired (duration = start time/stop time).

* Method — the surveying method used at the occupation; either
Static, Stop-and-Go, Kinematic, RTK (RTK base, RTK Topo, and
RTK Autotopo), or Autonomous.

* Note — displays user comments.

* Source — displays the path of the raw data on the computer disk
drive, local area network, or storage media.

* Interval — displays the occupation logging interval.

» Receiver — displays the TPS receiver serial number used for the
occupation.

* GPS week, day — displays the GPS week and day of the
occupation start time.

* NEpoch — displays the number of epochs for the given GPS
occupation.

* Antenna Centering Error — centering error of Antenna Reference
Point (ARP) position over the mark. This error will be take into
account when estimating adjustment results.

* Antenna Height Error - measurement error of the antenna height
over the mark. This error will be take into account when
estimating adjustment results.

* Azimuth — offset line azimuth.

» Offset Dist — displays the occupation’s distance offset.

» Offset dHt — displays the occupation’s height offset.

» Offset Across — displays the occupation’s across offset.

* H RMS - horizontal position error for the given occupation

* V RMS - vertical position error for the given occupation
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* Receiver vendor - displays the name of the vendor which
developed this GPS receiver. The user can select a desired
company from the list. This selects a vendor of the receiver to
accommodate differences in post - processing GLONASS
measurements by different companies. If the receiver’s class is
not included in the IGS list, select “Unknown’ from the list.

for the file that contains static and kinematic occupations
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Figure A-6. GPS+ Raw Data File — GPS Occupations Tab
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Digital Level Data View

Digital level files contain data on points measured with a digital level
instrument. The DL observations file data table contains two tabs to
display data.

For details on editing level measurements, see “Editing Digital Level
Observations” on page 6-19.

Points Tab

For a Digital Level file, the Points tab has the following default
columns:

* Icon — the symbol used for the point
e Name — the name of the point

* Latitude\Northing — the measured northing coordinate for the
point and coordinate type

* Longitude\Easting — the measured easting coordinate for the
point and coordinate type

* Elevation — the elevation of the point
* Code — any codes associated with the point

 Control — the coordinate fix of the point (None, Horizontal,
Vertical, Both)

* Note — any notes associated with the point

I D:\file1.dl <Topcon - DL Obs>
«° Points | m, pLobs |
Icon ] Name J Ground Northing (m) I Ground Easting (m) ] Elevation ... l Code | Control I Source J Note l

o} BM123 12,354 Vertical
¢} 1 None
a 2 None

Figure A-7. DL Obs File Data Table — Points Tab
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DL Obs Tab

For a Digital Level file, the DL Obs tab has two panels, the left for
start and end points of a job, the right for all level measurements for
the job selected in the left panel.

The left panel contains the following columns:

Icon — the symbol of the leveling job

# — the number of the leveling job

From — the start leveling point of the job
To — the finish leveling point of the job

Level Run — the name of the leveling job created in a Topcon
digital level

Date — the start date (day/month/year) and time of job creation
Note — displays user comments
Distance — the sum of all backsight and foresight distances

Balance — the sum of differences between DL to BS point and DL
to FS point of the job

The right panel contains the following columns:

Icon — displays a symbol associated with turning points
# — the number of the measurement

Point — the name of the turning point

BS - the measurement for backsight point

FS - the measurement for foresight point

Distance — measured distance

Elevation — the orthometric heights of the point (or the height of
the point is calculated from a point with known height)

Vert. Offset — displays the vertical offset from the horizontal
plane for traverse and sideshot points

Note — any comment for the level measurement
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¢ Std Dev — standard deviation for the level measurement. This

value is created in the digital level

¢ Date — the date and time of level measurement

* Level Run — the name of the leveling job created in a Topcon

digital level
left panel
I D:\file1.dl <Topcon - DL Obs>
o Ponts . DLObs |
icon | # | From IATPA]LeveIRm | Date | Note | Distance (m) | Balance (m) |
B 1 Bmzs3 2z TS 10/18/200... 21,404 0732
right panel

M D:\file1.dl <Topcon - DL Obs >

o° Ports %, DLObs |

“lacon [&  [Pont | BS(m)| InstrumeckBlev...| SS(m)| FS(m)|  Bevation(m)|  Distance(m)| Vert.Offset (m) | Note | dDev(m) | Dete
o, 1 BM123 0055 12.449 o 1 2 TS0 ~ o000 0,000 1W!§_m
o, 2 1 12,449 0.099 12.350 6.473 0.000 0.000 10/18/2005
n, 3 ] 1457 13.847 12,350 5.310 0.000 0,000 10/18/2005
Q, 4 13.047 0.107 13.740 4.595 0.000 0.000 10/18/2005
< >

Figure A-8. DL Obs File Data Table — DL Obs Tab

Icon Descriptions

Table A-3 lists the icons that represent different Topcon Link

parameters in the data table.
Table A-3. DL OBS File Icons

Location Icon Description
(o] Traverse Point for digital level observation
o Side Shot
Points Tab A Fixed coordinates point
u Fixed Horizontal control
n Fixed Vertical control
DL Obs Tab, Left = Leveling job
Panel -

A-14
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Table A-3. DL OBS File Icons (Continued)

Location Icon Description
BackSight level measurement
A
DL Obs Tab, a. ForeSight level measurement
Right Panel
o SideShot level measurement

Field Software Job View

A Field Software job contains information on the various GPS, total
station, digital level, tape dimension, and cross-section template data
measured/recorded with an instrument running TopSURV/SSFE. The
type of information in the Field Software job determines the tabs that
will display. Field Software jobs also display linework and points in a
graphical CAD view. If the Field Software job includes layers,
another view is available for managing this data.

If Field Software job contains localization, Topcon Link displays the
point coordinates in the both coordinate systems (WGS-84/Datum
and Ground/Localization). Topcon Link does not recalculate
localization parameters which were created in TopSURV/SSE.

«° Points | Gps ocepations | o Psobs | & codes |

Tcon | Mame | Ground Morthing (1Ft) [ Ground Easting ... | Elevation (Ift) | Code [ hate [

s & 3273761800 4142.383900 100.00000 1

& B 3313.552600 4038.771800 100.00000 1

&  BASEFI 4934.179000 4983.953000 200.00000 13 :

s c 3415.514200 3632426300 toosonon 111 local coordinate system
@ Fl1 4010.038539 4449902470 20000000 2

&  Fl2 4011.286855 4432716598 200.00000 2

<
Ready IFest | M5  Ground | 06_D76STCL_GPS_7.Hsv Localization

+° Points | g G5 Occupations | @2 G obs | & Codes |

Icon | Mame Latitude | Longitude | EllHeight (1ft) | Cade | nate | Phata Motes

A A IaEzAS,.  11EEAL.., 143819224 1

a4 B IIEEII., 111 145317121 1

&  BASEFL 33°3829.8,.,  111°5532..., 144357057 11n Datum coordinate syster
a LIS, 111, 144311179

& Pl 325, 1IEEE.., 1445.00057 2

@ Rz 2L, 111, 143660310 2

<
Ready IFeet | DMS | DatmlatLom ELH | wGsS4

For details on editing Field Software job information, see Chapter 6
(Field Software job can contain TS, DL, or GPS measurements).
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CAD View for Field Software Job

The CAD view is a two-dimensional, graphical representation of
linework road and surface data, with associated points, in a Field
Software Job. To view the CAD graphic, click View » CAD View.
Depending on the file’s data and the filters used, the following
information will be displayed. To set filters, see “Setting CAD View
Options” on page 3-26.

* Points display with the associated symbols. If the point does not

have a symbol assigned, its survey symbol will be used.

* Lines display with the associated code/layer color, style, and
width.

* Control codes (/AS, /AE, /C) display as an arc or closed polyline,
respectively.

* Codes with a polygon entity display as closed and filled (if a fill
color has been set).
» Roads display in the color applied to the corresponding layer(s).
1

In 1 inch - 0.041 mile

Pz m T4

0 0,041
—

5250 — —

5000 —| e

N

4750 S000 5250 5500

&

Figure A-9. Field Software Job CAD View

The Roads tab and X-Section Templates tab have independent
CAD graphical views associated with the selected data element.
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Layers View for Field Software Job

The

Layers view lists all layers in the file with associated properties.

To view the layers, click View » Layers. The following information

will

be displayed for each layer. To edit a layer’s properties, see

“Editing Layers” on page 6-51.

Name — the name of the layer

Visible — if the layer is visible in the CAD view
Line Style — the style used for lines in this layer
Line Width — the width of lines in this layer

Color — the color of points and lines in this layer
Point Symbol — the icon used for points in this layer

Breakline Type — the type of breakline for the layer (Auto,
Breakline, Boundary, or Exclusion)

Note — any notes associated with the layer
Area Fill Style — displays the type of fill.

Fill Transparency - displays the value of an area's transparency.
Changing of this value does not affect transparency of the area
because this option does not work in graphical mode in Topcon
Link ver 7.3.

# Layers : F:\code\Test_code_attribute_1.tsj

Name | Visitde | Line Style | Une wicth | Color | Point Symbel | Note | Area Fll Style | Fl Transparency

=% Yes ipt— . . Neee 0%

= Layer_trees  Yes —_———— Gpt = N * Desc_la.,. EESTEHEEEHE 0%
layer 2 Yes — 2ph — o None 0%

= fervce Yes —_—— pt e N wood fe... Nore: 0%
Fre_hydrant  Yes _ lpt— R for streat Noes 0%

= Field Yes —_— 2pp— R for fiedd. .. SN %

Figure A-10. Field Software Jobs Layers View
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Points Tab

For a Field Software Job, the Points tab has the following default
columns:

* Icon — the symbol of the point
* Name — the name of the point

 Latitude\Northing — the measured northing coordinate for the
point and the coordinate type

* Longitude\Easting — the measured easting coordinate for the
point and the coordinate type

* Elevation — the elevation of the point
* Code — any codes associated with the point

* Control — the coordinate fix of the point (None, Horizontal,
Vertical, Both)

* Note — any notes associated with the point
* Photo Notes - displays the number of a photo note per point.
* Layer - the layer for the point

* Color - the color of points and lines

* Point Symbol - the icon used for point

I rdtobetes [loyer | |
BYCOOEN)  BWOO0E B BYCOCE o
BYCOOE0)

Figure A-11. Field Software Job — Points Tab
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GPS Occupations Tab

For a Field Software Job, the GPS Occupations tab has the following
default columns:

Icon — displays a symbol associated with the occupation.
Point Name — displays the name of the occupation.
Original Name — displays the original occupation name.
Antenna Type — the antenna type used on the occupation.
Antenna Height — the antenna height.

Antenna Height Method — the method used to measure the
antenna height, either Vertical or Slant.

Start Time and Stop Time — displays the beginning and end dates
(day/month/year) and starting and stopping epoch time of the
occupation.

Duration — the duration of time in which the observational data
was acquired (duration = start time/stop time).

Method — the surveying method used at the occupation; either
Static, Stop-and-Go, Kinematic, RTK (RTK base, RTK Topo, and
RTK Autotopo), or Autonomous.

Note — displays user comments.

Source — displays the path of the raw data on the computer disk
drive, local area network, or storage media.

Interval — displays the occupation logging interval.

Receiver — displays the TPS receiver serial number used for the
occupation.

GPS week, day — displays the GPS week and day of the
occupation start time.

NEpoch — displays the number of epochs for the given GPS
occupation.

Antenna Centering Error — centering error of Antenna Reference
Point (ARP) position over the mark. This error will be take into
account when estimating adjustment results.
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Antenna Height Error - measurement error of the antenna height
over the mark. This error will be take into account when
estimating adjustment results.

* Azimuth — offset line azimuth.

 Offset Dist — displays the occupation’s distance offset.

» Offset dHt — displays the occupation’s height offset.

* Offset Across — displays the occupation’s across offset.

* H RMS - horizontal position error for the given occupation

* V RMS - vertical position error for the given occupation

» Receiver vendor - displays the name of the vendor which
developed this GPS receiver. The user can select a desired
company from the list. This selects a vendor of the receiver to
accommodate differences in post - processing GLONASS
measurements by different companies. If the receiver’s class not
included in the IGS list, plase select “Unknown’ from the list

WD 0GR SN2 by ~TapSLRY 1Y Job -

o Pores 7 P Ouenpetion | Picts | & Codm

oo | Fonk e Crgrel e | Aowes g | Accsnon tm
o e Pl 419 2 oy

" g 50 Red
" IS Bed

[
" " )

Figure A-12. Field Software Job — GPS Occupations Tab

TS Obs Tab

For a Field Software Job, the TS Obs tab has two panels, the left for
points with known coordinates, the right for points with unknown
coordinates measured from the point selected in the left panel.

The left panel contains the following default columns:
¢ Icon — the symbol of the point
* # — the number of the point

* Point Name — the name of the point
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* Instrument Height — the height of the instrument in the selected
units (ft, m)

¢ Instrument Centering Error/ Reflector Centering Error - centering
error of Total Station/Reflector over the mark. This error will be
take into account when estimating adjustment results.

* Instrument Height Error/Reflector Height Error - measurement
error of the Total Station/Reflector height over the mark. This
error will be take into account when estimating adjustment
results.

The right panel contains the following default columns:
* Icon — the symbol of the point
* # — the number of the point
* Point From — the beginning of the vector
* Point To — the end of the vector
» Reflector Height — the height of the reflector

* Azimuth, Horizontal Circle, Slope Distance, Vertical Angle,
Zenith Angle — angular and linear measurements in the selected
units (DMS, gon, mil, radian, ft, m)

* Code — any code associated with the point
* Type — the type of point
— SS: side shot point
— BS: backsight point (the previous occupation point)
— FS: foresight point (the next occupation point)
— BKB: backsight bearing point

— Horizontal/Vertical Resection: plane or vertical coordinates of
station point are computed using measurements from two (or
more) points with known coordinates

— Resection: plane and vertical coordinates of station point are
computed using measurements from two (or more) points
with known coordinates

— Note — any notes associated with the point

— Date — date and time of the point measurement
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— Center and Side: These two types of TS measurements are
created if the user selected Horizontal Angle Offset in the
Total Station or TopSURV/SSF. The Center measurement
contains only horizontal angle to the target (offset point), Side
measurement contains: horizontal/vertical angles and
distance to the prism (see Figure A-3 on page A-5). Both
measurements (Center and Side) relate to one point. After
clicking Compute Coordinates, Topcon Link calculates the
coordinates of this point using both measurements

— Vertical and Horz. Vertical: These two types of TS
measurements are created if the user selected Horizontal/
Vertical Angle Offset in the Total Station or TopSURV/SSF.
The Horz. Vertical measurement contains only angle
(horizontal/vertical) measurements to the target (offset point),
Vertical measurement contains horizontal/vertical angles and
distance to the reflector (see Figure A-4). Both measurements
(Vertical and Horz. Vertical) relate to one point. After clicking
Compute Coordinates, Topcon Link calculates the
coordinates of this point using both measurements

left panel
| o Poers | 2 uews < TSObs | § Codes |

t]2 | pontnsme | Instrumens Heght (Ustt) | tnstrumant Centerivg Liree (U... | Inetrument Heght Erree (U... | Reflectoe Hesght Errce (U... | Reflector Centarng Liror (Usft) |
ol o 5.3 [T 0.000 0.007 0.005
%2 o2 5.3 0,000 0.000 0.007 0.005
%3 o2 5450 0.000 0.000 0.007 0.005
Q. 2] 54 0.000 0.000 0007 000
Q% [ S04 0.000 0.000 0.007 000

right panel

of Poete | " lewe O TSOBs | § Codee

Turd hevgy | Pallestor Vgt ITR)

§
N

D LHLDINOY
sEag

7'-’-21_1[{

Figure A-13. Field Software Job — TS Obs Tab
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GPS Obs Tab

For a Field Software Job, the GPS Obs tab has the following default
columns for baseline measurements from the Base station to the
Rover point:

* Icon — the symbol of the point

* Point From — the starting point of the baseline measurement

* Point To — the ending point of the baseline measurement

* Start Time — the date and time of the start of the measurement
* Duration — the time during which the measurement was taken
* Note — any note for the baseline measurement

» Horizontal Precisions, Vertical Precisions — the horizontal and
vertical precisions of the measurement

e dN, dE, dU — the coordinate increments of the measurement in
the current projection

* Method — the measurement method (RTK Topo or RTK
AutoTopo)
* Solution type — the type of solution used for the measurement
— Float,Phase Diff: float phase difference measurement
— FixeMd,Phase Diff: fixed phase difference measurement

— Float,Phase Diff, mm GPS: float phase difference
measurement with mm GPS

— Fixed,Phase Diff, mm GPS: fixed phase difference
measurement with mm GPS

W8 0GR 3 SPCZ.aky = TopSURY PC Job -

Powes potiors @2 % Obs | § Codes

Figure A-14. Field Software Job — GPS Obs Tab
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Codes Tab

For a Field Software Job, the Codes tab has two panels, the left for all
available codes, the right for all attributes associated with the object
(code) selected in the left panel.

The left panel contains the following default columns:
* Icon — the symbol of the object
* Code - the code of the object
* Layer — display the layer in which the code is used
The right panel contains the following default columns:
* Icon — the symbol of the attribute
* Name — a unique name for the attribute
* Default value — the value of the attribute

* Type — the type of attribute (integer, real number, text, menu,
boolean or date)

M D:\codes_for_linework.tlsy <TopSURY PC files>

o° ponts | 177 Unework & Codes |
Icon | Code | Layer | * | 1con | Attribute Name | Default vake | Type
-1 For Line! 5] List for cb18 pipe Mare
(3 for_Points ] exam q Real Number
M 3 For Points 3 1 |8 iz lamp Text
112) test [ Integer

Figure A-15. Field Software Job — Codes Tab

Lines Tab

For aField Software Job, the Lines tab has two panels, the left for all
lines (codes, layers, and strings) in the job, the right for all line
segments associated with the line selected in the left panel.

The left panel contains the following default columns:
* Icon — the symbol associated with the line
* Code — the primary code used for the line
* String — the string for the line

» Layer — the layer for the selected line
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* Color/Line Style/ Point Symbol/Line Width — the plotting style of
the selected line

* Area Fill Style — displays the type of fill.

* Fill Transparency - displays the value of an area's transparency.
Changing of this value does not affect transparency of the area
because this option does not work in graphical mode in Topcon
Link ver 7.3

The right panel contains the following default columns:
* Icon — the symbol associated with the line segment
* Order — the order of points associated with the line segment
* From - the beginning point of the line segment

* To — the end point of the line segment. If the line is closed, the
“To” point for the last segment will be the same as the start point
of the line.

* Control Code — (enable in Tabular view options) the control code
of the point
— Arc Start: the starting point of the arc
— Arc End: the ending point of the arc
— Close: the last point in a closed line
left panel
«© ponts 7] Lines | <, Tsobs | & codes |
lcon | Type | Llayer | Lmecolor | Line Style [ Line width | areacolor | AreaFil stle | Fill Transparency | Poimt Type | Pomt Color | Code | String [ Distance ..
JFH Area fence EYCODE Ml BYCODE BYCODE:. = BYC... WM BYCODE Mome BYLAVER 0% BVC... + BVCODE MMl fen... 1 500.627
e Line layer 2 BYCODE BYCODE BYCODE:.L. = BYC... BYCODE HHFE  BYLAVER 0% EVC.. %  BYCODE cod., 2 36.428
w Area Field eyCooE Ml BYCODE BYCODEZL. —  BYC.. M BYCODE D BYLAYER D% BVC.. = BvCoDE Bl field 1 122,362
right panel
" points <07 Lines | ¢, T50bs | & Codes |
*1con [ order |_Paint | Distance from s... | Distance framp... Entry azimuth Exit azimuth
1 100 175°45'44,1248"
z 101 114.829 114.829 175745'44,1248" 314°00'00.0000"
3 102 115.245 0.419 314°00'00.0000" 43°00'00.0000"
4 104 259.245 144,000 43°00'00.0000" 220°26'13.5674" 3

Figure A-16. Field Software Job — Linework Tab
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Tape Dimensions Tab

For a Field Software Job, the Tape Dimensions tab has two panels, the
left for all tape dimensions in the job, the right for tape measurements
of the tape dimension selected in the left panel.

The left panel contains the following default columns:

* Icon — the symbol associated with the tape dimension

* Start Point — the name of the starting point for the dimension

* End Point — the name of the ending point for the dimension

The right panel contains the following default columns:

* Icon — the symbol of the point

e #— measurement sessions

¢ Point to — measurement direction

* Distance — the length of the line

— the “-” sign stands for a left turn

— the “+” sign stands for a right turn relative to the direction of
the measurement the last line

¢ Date — the date and time of the measurement finished

* Note — any notes associated with the measurement

M D:\tape.tlsy <TopSURV PC Job>

o Pants | g2 GPSOccupmions B, hoeob:l‘ Codes |

8 100

L] Start Pont | End Pont |*|icon | # | PontTo | Distance (m) | Date | mc
o 1 1 -10.000  3/30/2004 9:20:06 AM
a 2 2 20,000 3{30{2004 9:20:16 AM
a 3 3 20,000 3{30{2004 9:20:23 AM
] 4 4 20,000  3/30/2004 9:20:32 AM
<

Figure A-17. Field Software Job — Tape Dimensions Tab
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Images Tab

For a Field Software Job, the Images tab has two panels, the left for a
thumbnail of all images in the job, the right for larger version of the
thumbnail image selected in the left panel.

The left panel contains a thumbnail image of all images in the job,
with the lowest image title (either numerically or alphabetically)
listed first.

The right panel contains the selected image with measured points and
linework associated with the image. The symbols of the points
correspond to the settings selected in the Line and Code properties
dialog boxes. The size of the symbol depends on the distance from the
station.

2=
NOTE
-

Topcon Link expects images to reside in a folder with the same
name as the data file. For example, data from the “050119.tlsv”
file will be associated with images in the “050119” folder. The
data file and image folder must reside in the same directory for
the images to display.

o Ports | @soeopwons | G 150ts | @S0t | § Codes 7 Images |

Figure A-18. Field Software Job — Images Tab
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X-Section Templates Tab

For a Field Software Job, the X-Section Templates tab has two panels,
the left for all cross-section templates in the job, the right for
segments used in the cross-section template selected in the left panel.

The left panel contains the following default columns:
* Icon — the symbol associated with the template
* Name — the name of the template
* Cut Slope (1:n) — the percentage of cut for the slope
* Fill Slope (1:n) — the percentage of fill for the slope

The right panel contains the following default columns and a graph
for the x-section template selected in the left panel:

* Icon — the symbol of the segment
* Order — the sequential order of the segment
* Code - the code used for the segment

¢ Hz. Dist — the horizontal offset from the central line for the
segment

* V.Dist — the vertical offset from the horizontal plane for the
segment. If a value is entered for this parameter, the Grade will be
automatically calculated.

* Grade% - the ratio of Hz. Dist and V.Dist multiplied by 100%. If
a value is entered for this parameter, the V.Dist will be
automatically calculated.

e Hz. Offset from CL (m) — horizontal offset from the central line
for the segment start point. Calculated using the corresponding
values of the previous segment(s).
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* V. offset from CL (m) — vertical offset from the horizontal plane
for the start point of the segment. Calculated using the
corresponding values of the previous segment(s).

W00 et 20 r <TagS 0 P e

Figure A-19. Field Software Job — X-Section Templates Tab

Roads Tab

TopSURYV version 8.0 and later allows one to create a road using one
of two following ways:

1. Through horizontal and vertical projections of the center line
(alignments) and lines representing the surface of the road and
lying in the planes perpendicular to the center line (X-Section).
To use this way in TopSURY, the user has to click X-Sec Set in
the Surface tab of the Edit Road screen and select a pre-defined
X-section set:

winrkinn C1R:2

Figure A-20. TopSURV: Creating Road with X-Section

2. Through a set of several strings (String Set). Every separate
string in the set is defined by one or several pairs of the horizontal
and vertical alignments. To use this way in TopSURY, the user
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has to click String Set in the Surface tab of the Edit Road screen
and select a pre-defined string set:

2 2 rosd

slignment__ Surface I

B8] | string set

[ Irore>

=[]
<none:>
Crossing-2

Figure A-21. TopSURV: Creating Road with String Set

Wrkinm (|

Road with X-Section

For a Field Software Job that contains a road with X-sections, the
Roads tab displays two panels:

* the left - the name of every road in the job and the names
of components of the road,

* the right - in table and graphic view, parameters of horizontal
alignments/vertical alignments/x-section templates for the road
selected in the left panel.

The left panel contains a data tree with the following entries for each
road in the job.

» Horizontal alignment — select to show both table and graph;
expand to select and show just the table or graph

* Vertical alignment — select to show both table and graph; expand
to select and show just the table or graph

» X-Sections — select to show both table and graph; expand to select
and show just the table or graph
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The right panel contains information for the object selected in the left
panel, whether a road or an alignment/x-section.

BB C:MopcomiTopconl inkigradework road thy «TepSURY PC Job»

o Ponts Roads X Seon Templates § Cotes
wdee | Type -
2. Moty shywe 1 Une
Table scasl
3] g
3 oo
22 vyl sgreece Z S
Tabie < >
1] G P ——————————
« X-Sactions LlTpe Safhanage [y
Tabie Paratols Lorg 2530

1) Parabols Lotg
Parabola Lorg
Par asbds Lo WY1
< >

S hanage (w) | Sde ~
2O Pt

DA 1T et -

Figure A-22. Field Software Job — Roads Tab for Road with X-Section

The horizontal alignment table has the following default columns
and/or a graph for the road or horizontal alignment selected in the left
panel.

* Icon — the symbol associated with the element of the alignment
* Order — the order of the element in the horizontal alignment

* Type — the type of element (line, curve, spiral, or intersection)
* Azimuth — the azimuth of the element

* Length — the length of the element; editable for all types of
elements except Intersection, where the length is calculated for
the compound curve consisting of two spirals and one curve

* Turn — the direction of the turn for a curve, a spiral, and
intersection; “Right” is a clockwise direction, “Left” is a counter-
clockwise direction

* Start Radius/End Radius — the radius of the curve or spiral

* Northing/Easting — the grid/ground coordinates of the
intersection point

» Spiral 1 Len/Spiral 2 Len — the length of the spiral at the
intersection point

¢ End Station — the number of the end station for the element
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Intersection Pt — the name of the intersection point

Tangential to prev element — displays “True” if the azimuth for
this element is the end azimuth for the previous element; displays
“False” if the azimuth for this element is arbitrary

End Northing /End Easting — the grid/ground coordinates of the
end station of the element

End Azimuth — the azimuth that sets the tangent to the end station
of the element

Spiral Dir — the spiral direction
Delta — the angle between the radii corresponding to the curve

Chord - the length of the segment joining start and end points of a
curve

Tangent — the length of the segment which touches the given
curve

Mid Ord - the distance from the midpoint of a chord to the
midpoint of the corresponding curve

External — the distance from the midpoint of the curve to the
intersection point of the tangents

Spiral Const — the square root of the product of the length and the
radius of the spiral

Spiral Const 1/Spiral Const 2 — the spiral constants used to define
a compound curve



Field Software Job View

* Start Deg Chord/End Deg Curve — the angle in degrees used to
compute the radius of curve whose chord is 100 units long.

BB C:MopcomiTopconl inkigradework road thy «TepSURY PC Job»

o Ponts Roads | %-Secnon Tewplates § Codes
7 EZX0-AL X adeworh, " L] Cvder Type A
£ Horeunts shyee 1 “
Table weal o
2] o At
s werncl greert
2 + Swal S50

Table
2] Geaghx

« LSactiors =
Tabie L SordTSto5C

Figure A-23. Field Software Job — Roads Tab, Horizontal Alignment Panel

The vertical alignment table has the following default columns and/or
a graph for the road or vertical alignment selected in the left panel.

* Icon — displays an image associated with the elements.
* Type — the type of the element (grade, parabola, or long section)

» Sta/Chainage — the number of the start station or chainage for the
grade, parabola, and long section element

* Order — the order of the element in the vertical alignment

* Length — the length of the vertical element for the grade and
parabola, and the length of the curve of the long section

* Start Grade / End Grade — the starting and ending percentages of
grade of the element. If the grade is rising, the value should be
positive; if the grade is falling, the value should be negative

* Elevation — the elevation value on the end station for the grade
and parabola and the elevation value of the station used for
creating of the long section
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BB C:MopcomiTopconl inkigradewnrk road thy «TepSURY PC Job»

o Ponts Roads |

S BZ20AL M adeweh
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Figure A-24. Field Software Job — Roads Tab, Vertical Alignment Panel

The x-section table has the following default columns and/or a graph
for the road or cross section selected in the left panel.

* Station — the station at which the template is applied

* Side — the left or the right side of the road relative to the central
line where this template is used

» Template — the name of the template (selected from the list of
existing templates in the current job)

BB C:MopconiTopconl inkigradewnrk road thy «TepSURY PC Job»

s ne L

o Ponts Roads X Secton Tewglates § Codes
C220-A1Xradeworh. I L] ZaiChanace (m) | Sde ~
€ Mooty shywe DB 1T Pk

Table NBEATE  Left
2 oo
L) Graoh DR 414 Bt 3
23 werncel sgrenect 2083410 - Lafk o0t
Table =
: ATEIA  Fight 5008
3] Grahe
2 Lol L
Teble K014 Lt

Figure A-25. Field Software Job — Roads Tab, X-Section Template Panel
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Road with String Set

For a Field Software Job that contains a road with String Set, the
Roads tab displays two panels:

* the left - the name of every road in the job and the names
of components of the road,

* the right - in table and graphic view, parameters of horizontal and
vertical alignment of the center line, and string sets for the road
selected in the left panel.

The left panel contains a data tree with the following entries for each
road in the job.

» Horizontal alignment of the center line— select to show both table
and graph; expand to select and show just the table or graph

* Vertical alignment of the center line — select to show both table
and graph; expand to select and show just the table or graph

* String set — select to show the list of strings; expand to show all
strings which are included in the given set

The left panel of the Road tab displays the String Set configuration, as
set of the strings. Every road string is described by the pair or pairs of
the horizontal/vertical alignments (HA-VA).

Roads | Roads I Roads |

- & Common =4 Comman =& Comman
= CENT_Line-1 {Horizontal alignment): =] ?_ CEMT_Line-1 {Horizontal alignment) - 1 CEMT _Line-1 {Horizontal alignment)
FFH Table FFH Tahle FH Table
Graphic Graphic Graphic
=-[m CENT_Line-1 {¥ertical alignment) =-Im CENT_Line-1 {¥ertical alignment) =-[Im €EMT_Line-1 (Vertical alignment)
FFH Table FFH Tahle FH Table
Graphic Graphic

w-# Crossing-1 (Road String Set)

#- # HI - %1 (HA - V&)
#-  HZ - W2 (HA - YA)
Bl HE - V3 (HA - VA)

+- # 54 (Road String)

+- 4 55 (Road String)

+- # 52 {Road String)

& =3 {Dmad Shrinat

iZrossing-1 {Road String Set)

String
- WL (HA - A
- 1 H1 (Horizontal alignment)
FH Table
Graphic
+-[Im W1 {Vertical alignment)
H - # HEZ- Y2 (HA - YA
7 H3- V3 (HA - V)
#- . 34 (Road String)
- # 55 (Road String)

Figure A-26. Roads Tab for road with X-Section: Left Panel

The right panel contains information for the object selected in the left

panel.
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1..[ Order Type Azimuth Lenath (m) [ 1
P Line 61°31'33.0448" 51.898
sz Line 64°4000.5473" 35.863
Graphic A Line 62927'50,0934" 36.047
Iy CENT_Line-1 {Vertical alignment) ar L - 1004
% Crossing-1 (Road String Set)
< >

Roads |
= Common M1] order | Type Azimuth | Length ... & "
= "2, CENT_Line-1 (Horizonkal aligrment) |~ g Curve  178%49... 3.528
Tab'eh 7 Curve  182°51... 3.528
Graphic 8 Curve 191957 2.541
@I CENT_Line-1 (Vertical aligrment) s e 9%z et
=} £ - g
4 C/',D?"?R;::::::""g set) 710 Cuve 189033 2,607
- /’Hl-Vl(Hg-VA) 1 Curve  191°41'... 2,607
=17, H1 (Horizorkal alignment 12 e 199037 225
Table 13 Lne 200°28... 2,256
[2] Graphic A
w-m V1 (Vertical slgrment) 1€ >
] H2 -2 (HA - VA) [ order | Type | Stajchainag... ~
o HI-V3(HA - VA) A Grade 22,673
-7 54 (Road string) Ae Grade 25.347
1 55 Road string) A3 Grade 28.021
@7 52 (Road Shring) e e S
4 2 53 (Road String) rads :
W 56 (Road String) A5 Grade 34,227
7 57 (Road String) “8 Grade 37.755
4 98 (Road String) A7 Grade 41,283
- 510 (Road String) Pl | Grade 43,824
A3 Grade 46,385
A0 Grade 48,972
A1 Grade 51.579
g2 wewem g
< 3 e >

Figure A-27. Roads Tab for road with X-Section: Right Panel

All types of line, curves, spiral, intersection, grade, parabola and
circular ark that are used for creating horizontal and vertical
alignments of a road with String set are the same that are used for
creating alignments of a road with X-section. See “Road with X-
Section” on page A-30 for details.
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Stakeout Report View

The Stakeout Report tab is displayed only if a TopSURYV job that was
opened into Topcon Link, contains a stake report. This stake report
involves information about stake of different objects (point, line/arc,
road, slope, surface). In Topcon Link, the view of this report depends
on components which were included by the user during configuration
of the TopSURY job. All parameters of this report are not editable:

Stakeout Reports |

L. Wame Type ' Design Reference | Design Pt. Design Mote Design Code Design M Design £

@TD-‘-DZ‘DDD 5 5 12 6178507179 415411444
@TEH»U‘LUUU & & I+ 6178505, 486 415412,471
@TD-‘-DE‘DDD 7 7 I+ 6178504471 415414171
@TEH»U&UUU 8 8 I+ 6178504,371 415416,149
@TD-HD‘DDD a a I+ 6178505210 415417.943

<

Figure A-28. Figure A-28. The Stakeout Report Tab

Displaying Check Points in
Points Tab

With repeated measurements of a single point (for both GPS and TS
measurements), the software TopSURYV allows the user to select one
of the following three methods (Figure A-29):

- to write the point with a new name

- to use the new coordinates and raw measurements and remove
previous coordinates of this point

- to save this point as a check point
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for TS measurements for GPS measurements

(& (%] (& %)
A2 Aroady Daits) A1 Alaady Caits)
Oftsets(m) Offsats(m)
[ S 0011 -3 0.000
o 0.0:8 @™ 0001
L 0.000 L) 0.001
™ Ovecwrte? ™ Ovecwrte?

2 .

" hename? I
C Store As Chack Pore? ) (‘ Store As Chick Pore?

I Use in Waightod Asrage
™~ Comect Bxso

Figure A-29. TopSURV: Point Check Screen

When saving repeated measurements as measurements for check
points, TopSURYV shows the coordinates of only the first point in the
Points screen. And the check points with their coordinates and offsets

from the first point will be shown in the Edit Point ->Check Points tab
(Figure A-30).

(& G
[pore T e Northim) " Gantim) Biv(m) T Cortrdd.., N
{ b A 500 000 S00 000 100 000
& az €230 8430 100.000
|

(o L EE3
Pont | Layer/Stvle  Check Ports | proto Note |
[hare [ (& I
[.\: Q074 0094 at
A2 0118 0.000 O«
a2 0005 0110 1]
a2 0277 0.0 ac

Come JL_ e ) aw [ostviom ][ ot ]

Figure A-30. TopSURV: Check Points Tab

TopSURYV does not change the names of the check points: the all have

the name of the first point. The repeated measurements are displayed
in the Raw Data screen.

When you open a job in the Topcon Link, the software will display
ALL control points in the Points tab and ALL repeated measurements
in the TS Obs/GPS Observations tab. The names of these point
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(except the name of the first point) will contain the prefix check n,
where n - number of the check points.

o Points | O, Tsobs |
Icon | Name | Ground ... | GroundEasting... | Elevation (m) | Code | Control In
<l S00.000 S500.000 100,000 None
< 462.349 5$98.430 100.000 None
< 482.274 598.514 9.126 None
¢ 482,467 536,430 99.564 None
< 482,357 538,546 93,821 None
<& 482.626 538.479 93,942 None
< >
¥ &% pores O TS Obs |
L& poreten* (1] 8 |PorkFrom [PoeTo | Asmuth| Horcortal Cede | Sopels... | Zenthange
Q1 A o1 A 45%00/00,0000" 000100, 0000
42 A 45°27'00,0000" 92*10'00.0000"
&3 A A2 S5°10/00,0000" 100,000 90°00'00. 0000
¢4 A S541200,0000" 100,100 SOF3000.0000"
$ S5 A S5406'00, 0000 90,980  9071500.0000"
0_. 6 A 50900, 0000" 100,120 SO0 30, 0000"
Q_ 7 A SS°00°20. 00007 100.000 SOPOZ00.0000"
< > < >
Figure A-31. Points Tab and TS Obs Tab Display Check Points

If the user saved repeated GPS measurements as measurements for
check points, and selected the applying these measurements to
weighted averaging in the TopSURYV job, the software calculates

point coordinates taking into account all repeated measurements for
the point with [l mark

F2os Om EaE3
A1 Akaady Caits) o Ponts: Ground
Offsats(m) B Ot i imas— b F e
& .00 Pont Code Extim) Noethim) Eevim) Contrck . N
i s #a LAtSSMI18.., Lon37 008, he:)62.307
Y 2001 P ot ot [/ %]
™ Ovecwrbe® Pont | Layer/Stylo | Check Paints WA | photo Note |
 porame? [ Name ERoad | Niead A
Store AS Crack P> |
7 Usa In Waighted Average | m 0005 0.003
| - o 01003 0005
™ Comect Bxe At 0.003 0004
. non none v
< >
" Exchade from WA |
< >
e ) ) (wmes)
peete || gt 1 || Pty Gooe || Frd by porm

Figure A-32. TopSURV: Using Weighted Average

After opening this TopSURV job in Topcon Link, the Points tab will
display the weighted averaging for the points and coordinates all
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check points, The GPS Observations tab will display all repeated
measurements of this job. The observations for points with name “A/
check n” were not used in calculation of the weighted averaging for

the point “A1”:

«° Points | ¥ s ocepations | @2 GPsobs | 4 Codes |

Icon | hame ‘ Latitude | Longitude: ‘ Ell.Height ... | Control | Layer Calar -
® Basel 55°43'19.3.., 3739081, 166,985  Mone o BrLAvER I

@ AlcheckZ  55°43'18.7.. 37°39'08.3.. 162,311  Mone o BrLAvER I

@ A1 check 1 55°43'18.7...  37°39'08.3... 162,308 Mone o BrLAvER I

@ Al 55°43'18.7...  37°39'08.3... 162,307 Mone EiCODE(D) BrLAYER [ Y
£ ¥

.° Paints ] o? GPS Qccupations O@; GP5 Obs I 5_1 Codes }

Icon ‘ Paint Fram | Paint Ta | Start Time | Duration | Hotizontal Preci., . | Wertical Precisio... A
=] Basel Al 7122010 3:59:13 PM 00:00:02 0.014 0.017

=] Basel A1 check 1 7f2}2010 3:59:35 PM 00:00:02 0.014 0.015

=] Basel a1 check 2 712]2010 4:00:44 PM 00:00:02 0.015 0.018

@ Basel Al 7/2/2010 4:00:55 PM 00:00:02 0.016 0.017 v
< >

Figure A-33. Points Tab and GPS Obs Tab Displays Weighted Averaging
Coordinates and Measurements
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Displaying Check Points in Points Tab

Icon Descriptions

Table A-4 lists the icons that represent different Topcon Link
parameters in the data table. Note that the icons for codes and
linework are user-selectable, and are not listed below.

Table A-4. Field Software Job Icons

Location

Icon

Description

Points Tab

TS station

TS point

@ |2

TS BackSight point

Point coordinates input manually

Point coordinates calculated by means of COGO

Design point

Stakeout point

Fixed coordinates point

Fixed Horizontal control

Fixed Vertical control

Base station

Topo point®

gl ol® 0B e o % -

Auto Topo pointb

¥

PTL (point to line) offset point

GPS offset point

B ¢

Tape Measurement Point

P/N 7010-0522
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Data Views Reference

Table A-4. Field Software Job Icons (Continued)

Location

Icon

Description

TS Obs Tab, Left
Panel

TS station

TS Obs Tab, Right
Panel

ForeSight measurement

SideShot measurement

BackSight measurement

BackSightBearing point measurement

TS Resection Observation

NMEIEEEEE

TS MLM Observation

Base station occupation

&,
@* Auto Topo occupation®
GPS Occupations
Tab @ Topo occupationcl
+
Baseline from the base station to a Topo point
GPS Obs Tab

Baseline from the base station to an Auto Topo
point

Tape Dimensions
Tab

Left Panel

g 8 e

L)
L)

Start reference line

Tape Dimensions
Tab

Right Panel

0

Tape Measurement Point
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Displaying Check Points in Points Tab

Table A-4. Field Software Job Icons (Continued)

Location Icon Description
2. Horizontal Alignment
Vertical Alignment
M
Roads Tab B X-Section Template
222 View Table
View Graphic
7 Line element
Roads Tab r Curve element
Horizontal Spiral element
Alignment Table (
7 Intersection element
] Grade element
Roads Tab
Vertical ) Parabola element
Alignment Table Ty Long Section element

a. Topo point — the point collected during a static RTK measurement
b. Auto Topo point — the point collected during a kinematic RTK

measurement
c. Auto Topo occupation — the kinematic occupation in the RTK survey
d. Topo occupation — the static occupation in he RTK survey

P/N 7010-0522
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Notes:
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Appendix B

Sample File Formats

Coordinate File Formats

Topcon Link can send, receive, and convert a number of different
coordinate file data types. ASCII file formats are listed below.

KOF Coordinates Format

a5 cP1 HAIL 48450.534 G55B462.743 246368
85 cpP2 HAIL 48579 .742 G5LB401.918 247 067
85 CP3 HAIL 48472 .683 G55B478.853 245 _887
a5 188 BC 48456 .898 G55B451.681 246._684
a5 101 BC 48459 882 G55B456.825 246 468
a5 182 BC 4B8460.338 G5LBU5G7.281 246439
a5 183 BC 4B461.0874 SLBUST 14T 246 408

Name,E,N,Z,Code/Name,N,E,Z,Code
Coordinate Format

This file has the following format:
Name, Easting/Northing, Northing/Easting, Elevation, Code

CP1,1832223.183,158958 128,888 202 NAIL
CP2,1832023.626,159382.035,810.585,HAIL
CP3,1832276.036,159030.533,8086 714, NAIL
1008,1832186.891,158978 979,889 .329,,BC
161,1832203.767,1589088 534,888 .619,BC
1682,1832205.263,158990.294,808.526,BC
103,1832204.823,158992 786,888 423 ,BC
104,18321946 . 907 ,159006 .653 ,887 .951,BC

If the code information is absence in the file:

CP2_NAD83,1832023.616,159382.018,810.587,
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Sample File Formats

Name,Lat,Lon,Ht,Code Coordinate
Format

This file has the following format:
Name, Lat, Lon, Ht, Code

CP1,48 86 06.98974,-82 59 13.59801,888.292,HAIL
CP2,48 86 11.88744,-82 59 16.18833,818.585,HAIL
CP3,48 86 B7.62810,-82 59 12.91513,886 .714,HAIL
160,408 86 O87.11376,-82 59 14.85850,889.329,BC
161,48 86 067.28911,-82 59 13.84203,888.619,BC
162,408 86 O7.22658,-82 59 13.82291,888.526,BC
163,408 86 07.25040,-82 59 13.82875,888_423,BC

If the code information is absence in the file:

CP2_NAD83,40 086 11.08726,-82 59 16.18847,810.587,

FC-4 Coordinate Format

This file has the following format:
Name

Northing

Easting

Elevation

Code

CP1
158958.12838
1832223.18323
8088 .29207
HAIL

CP2
159382.083548
1832823.62629
810.58455
HAIL
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Coordinate File Formats
GTS-210/310-10 Coordinate Format

®_+CP1 ®+001524003_ y+0015240803_ z+000213360_*=HAIL_+CP2
x+ﬂﬂ1666888 y+ﬂﬂ152hﬂﬂ1 Z+BBBZ1HB?9 *NAIL_+CP3 _ G048%
Bx+ﬂﬂ153?189 y+ae1547977_ Z+BBBZ12988 *NRIL +188 ®+001534464
y+@01516782_ Z+BBBZ136?2 *BC_+101 _ x+ﬂﬂ153h988 y+ﬂ1ﬂ?3§
F01522596_ z+000213460_ *BC +102 ®+001535200_ y+ﬂﬂ152323?
Z+BBBZ13H33_*BC_+183 _ x+ﬂﬂ1535922 y+ﬂﬂ1523h29 z+080821320823%
B401_=BC_+104 ®+0015408796_ y+ﬂﬂ1523856 z+008213258_=BC_+185
x+ﬂﬂ15h1?21 y+ﬂﬂ153?31h Z+BBBZ12983 *BC_+106 38575

& _ x+ﬂﬂ15h19?8_ y+ae15481972_ Z+BBBZ128hB *BC_+107 _ ®+0801528084
y+001534145_ 2+000213366_=BC_+108 _ x+ﬂﬂ152?955 y+4839%
001532304 z+000213372_ *BC 109 ®+001527571_ y+ﬂﬂ1531588
Z+BBBZ133??_*BC_+11B _ x+ﬂﬂ1526826 y+ﬂﬂ1531869 z+0808215019%

GTS-7 Coordinate Format

This file has the following format:
Name, Northing, Easting, Elevation, Code

CP1,5000.0000,5000.0000,780.00808,HATIL
CP2,4999.9943,5468 .5206,782.3573 ,HAIL
CP3,5078.6555,5042 9982 ,698 4983 ,HAIL
1080,4976. 0449 ,5034.3210,781.6230,BC
161,4995.3832,50835.7784,780.3283 ,BC
1682,4997 _4859,50836.7339,780.2372 ,BC
163,4998 .11508,5039.10841,780.1345 ,BC
104,4996.8930,5055.8934,699.6638 ,BC
1085,5043.6716,5058.1299,698 . 4984 ,BC

If the code information is absent in the file

CP2_NADB3,4999.9771,5468 _5091,702 3597,

P/N 7010-0522 B-3



Sample File Formats

Field Software Job Coordinate File

This file has the following format:
Name, Northing, Easting, Elevation, Note, Code

CP1,5000.000,5000.080,700.0008,Base St,HAIL

If the note information is absence in the file:

CP3,5042.998,5878.655,698.490, ,HAIL

If the note and code information is absence in the file

CP2_NADB3,5468.509,4999 _977,702.360,,

GPS Vector File Format

GPS Vector files have the following format:

Header(//Topcon Vector Format:v.number of the version,linear units,)
VPP(for vector),Name_Pointl ,Name_Point2,dX,dY,dZ,sigma_dX,sigma_dY,sigma_dZ,cor_XY,cor_XZ,cor_YZ,

P(for point),Nane_Point,Lat(DD MMSS.ss),Lon(DD MMSS.ss),Ell.Height,Code,Note,

s/TopconvectorFormat tv. 1,

VRTK Topo,Basel,154,161. 2419 89 8123, -68.3288,0. 00773025, 0. 01944847, 0. 01418940, 0. 0900, -0. 0300, -0, 2800, LT+T
VRTK Topo,Basel,155,57.3292, *27 0lel,-17.1042, 0 00894811, 0 02141174, 0 00955858, 0 2500, *0 1300,-0.2800, LT+T
VRTK Topo,Basel, 156, 27,2445, -40.4548, 43, 0560, 0. 00796278, 0, 010054 55, 0, 01267762, 0. 2000, —0. 0300, -0, 3500, LT+T
VRTK Topo, Basel, 157, 20,8279, 14,0509, 26. 5551, 0. 00803396, 0, 01335403, 0. 01057974, 0. 4300, -0.1200, ~0.4200, LT+L
p,Basel,30 32 17.80101, 104 54 00.37541,5870.325,CP, LT+T PL COR

Fi154,35 32 16.95613, -104 53 58. 00238, 5470, 788,CP, LT+T

P,153,39 32 17.60009,-104 53 59.3798L,3877.202,CP,LT+T

P 156,30 32 17.27175,-104 53 50.00657, 5876, 602 ,CP, LT+T

P.157,39 32 18.13790, -104 54 0005360, 5870.843,CP) LT+L
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